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Part O: Introduction

Ben Hurwitz, Spring 2024

Hello, and welcome to The Hive’s PCB Design with KiCAD video series. My name is
Ben, and in this fifteen part walkthrough, | will guide you through the basic workflow
of how to design a PCB, from conceptualization, through part selection, schematic
capture, and layout, ending with a final board design that could be fabricated. The
final four videos are not design-focused per-se, but discuss good library management
practices and model creation.

In this video, we'll start with an overview of the series, offer some goals for what |
hope you’ll take away from this, and a short biographical sketch about me, your host.

Let’s get started.



Series Overview

PCB basics and terminology 5. Layout (3 parts)

Electronics design software
concepts

Circuit conceptualization

Schematic (5 parts)

a)
b)
c)
d)
e)

Adding parts
Symbol creation
Wiring
Footprints

ERC

a) Setup
b) Placement and routing
c) Final DFM checks and DRC

Symbollibraries
Footprints (3 parts)
a) Footprintlibraries

b) Custom footprints from scratch
c) Custom footprints with the wizard




) Goals for this tutorial

HOKERSPACE

1. Introduce you to PCB design terminology

+ Understand the jargon, be able to have a conversation, and transfer
knowledge to other PCB design software

2. Demonstrate the PCB design workflow
* Learn how to actually design a circuit board

3. Make custom models, or locate pre-designed ones online.
* Making your own is the very last resort.

4. Provide you with additional resources
« Where to find answers to questions and additional tools/techniques




i1 Who am |7

 As of this writing, I’'m a 7th year PhD
candidate in the Ocean Science and
Engineering program trying
desperately to graduate.

* My work was in developing a novel
ocean sensor and the accompanying
instrument, which turned into a lot of
KiCAD development.

* lam not an expert. | just have
experience with this software.




End of Part O

And with that, we’ll end the introduction to the series. A PDF of this video is available
as well, linked in the description and hosted on The Hive’s Wiki.

In the next video, I'll introduce PCBs and some of the jargon you’ll encounter on your
journey through PCB design and fabrication.



PCB

"““HIVE Design
MAKERSPACE  \p\/ -I t h

KiCAD

Part 1: PCB Basics and Jargon

Ben Hurwitz, Spring 2024

Hi, and welcome to part 1 in The Hive’s PCB Design with KiCAD series. My name is
Ben, and in this video, I'll be covering some PCB basics and terminology. Let’s jump
into it.



Hive Whatisa PCB?

The traditional ways of connecting chips and components together has been through
wire wrapping and breadboarding, but those come with a whole host of non-
idealities and parasitics, are dreadful to debug, and are difficult to safely integrate
into large systems. PCBs, short for “printed circuit boards” eliminate the wires and
plug-in components in favor of metaphorically printing the wiring and connection
points onto a flat, typically rigid, surface, and then soldering the components onto
points for a mechanical and electrical connection. This helps to both alleviate many of
the parasitics (though not eliminating them), as well as making the board much
cleaner for visual acuity and mechanical safety and integration. PCBs are not truly
printed these days, but the name remains.




Hive PCB Structure
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Silkscreen
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PCBs are physically composed of different layers that each fulfill different purposes.
The solid non-conductive portion that forms the backing of the circuit is known as the
substrate, and is typically made of a polymer-resin called FR4 (though there are many
other options these days). PCB stackups (meaning the ordering and structure of the
compositional layers) are generally described by the number of metal layers built in.
It’s most common that this metal is copper, though others are sometimes used. The
thickness of the metal can vary; in the US, it’s generally described by ounces per
square foot, and you’ll most commonly find quarter-ounce, half-ounce, one-ounce,
and two-ounce weights, though others are possible, whereas internationally these
would be described in microns, with half-ounce copper equating to 18 microns and
full-ounce as 35 microns. Over the external copper is a layer of protective paint called
soldermask, which protects the copper from oxidation, physical damage, and
electrical impropriety. Finally, over the soldermask, an ink known as silkscreen may be
applied to add text or graphics to either surface of the board. Additional internal
copper layers may be built into the stack as well to create 4, 8, or even more layers
for additional wiring area and heat conduction.




PCB Structure - Electroplating

Electroplating (or just plating):

Silkscreen

Soldermask The process by which a hole
between two copperlayers will
be internally metalized to
Substrate (FR4) create an electrical connection
between those layers.

Copper

+ “Internally metalized” meansto add a
layer of metal to the interal sidewalls of
the hole.

Must be plated!

| won’t go into much detail about the fabrication process during these videos, but
there is one process that needs to be understood, and that is electroplating.
Electroplating described the electrochemical process by which copper can be grown
onto a variety of surfaces, and is the most common way to add copper onto a
substrate in the PCB world. Electroplating, or just “plating”, is most commonly heard
when referring to vias. Consider a component sitting on the top side of the board. If it
needs to cconnect to something that is also on the top side of the board, no problem
— we just connect with a single trace (which is what we call the printed copped wire)
along the surface. But what if we need to connect it to an object on the bottom side?
A hole can be drilled through the substrate to make a path, but it is still non-
conductive. Vias are electroplated holes that connect traces across different copper
layers. These plated holes are usually quite small. Through-hole components also
typically use plated holes. Some holes, such as mounting holes, may be left as non-
plated through-holes.

If you’d like to know more about the actual fabrication process itself, The Hive has a
basic set of tools with which you can learn a basic method of hobbyist-level
fabrication, or Google to learn the nitty-gritty of production-grade manufacturing
processes.




PCB Terminology
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Let’s go through some PCB terminology. All of this will be in relation to the graphics
on the right.
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PCB Terminology

HOKERSPACE

+ Green is soldermask
» Electrically isolates copper I ot

-
- Mitigates corrosion and other EDE "=’13 l I

physical damage

The green surface coating is the soldermask that, as | mentioned before, acts as a
protective layer over any copper underneath. These days, soldermask comes in a
wide variety of colors, including black, white, red, purple, and yellow.
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PCB Terminology
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* Greenis soldermask

+ In copper (EEIED:
« Surface-mounted (SMD) pads

Connection points for surface-
mounted legs/pins

The gold is copper. All the places at which a component needs to be connected to the
board will be free of soldermask to allow for soldering, but because copper oxidizes
so readily in ambient atmosphere, the copper is nearly always coated in another less-
oxidizable metal, a process known as finishing. Gold is a typical finish, which is why
often the so-called “copper” actually is golden in color. Tin is a less-expensive
common alternative.

Areas of exposed metal include surface mounted pads, where surface mounted
devices connect to...
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PCB Terminology
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* Greenis soldermask

+ In copper (EEIED:
« Surface-mounted (SMD) pads
» Through-holes (TH), with rings
+ Connection points for through-
hole leads, with copper rings for
soldering
« Plated by default (unless no
plating available)

... Annular rings around through-holes...
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PCB Terminology ‘

* Greenis soldermask
« In copper (EEIED:
« Surface-mounted (SMD) pads
» Through-holes (TH), with rings
+ Slots, with rings
Non-circular THs

May or may not be plated,
depending on design

... slots....
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PCB Terminology
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* Greenis soldermask
« In copper (EEIED:
« Surface-mounted (SMD) pads
* Through-holes (TH), with rings
+ Slots, with rings
* Via, with annular ring
Connects traces across copper

... and vias. These rings of copper allow for solder joints to be made between
components and the covered traces; without them, soldering would be much more
challenging. Through-holes describe any circular hole through which a component,

electrical or not, is slotted. As mentioned before, these are typically plated by default.

Slots are non-circular through-holes, and may or may not be plated. Vias are the
inter-layer connection holes that must be plated, and can also be used for heat
conduction and dissipation.
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* Green is soldermask
e In copper(M) =
Surface-mounted (SMD) pads D C3 l I

+ Through-holes (TH), with rings
+ Slots, with rings

* Via, with rings

« Traces/tracks/routes

« Connects pads orrings (i.e.
components)

Finally, in copper, we have traces, also known as tracks or routes, that run between
pads and plated holes to electrically connect components and devices together.
These are usually hidden by the soldermask, but can often be seen as slight ridges
pushing up from underneath.

11
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HI PCB Terminology

+ Green is soldermask \
« In copper (EEIED: :

« Surface-mounted (SMD) pads
* Through-holes (TH), with rings
Slots, with rings

* Via, with rings
Traces/tracks/routes

In silkscreen (EY):

+ Reference designhators
+ Partidentification for assembly

RASPACE

In these graphics, the silkscreen is in white, though modern fabrication houses can
(like with soldermask) print silkscreen in a wide range of colors. Silkscreen is generally
used to print informational text and graphics onto the board with a non-oxidizing ink.

This informational text can include reference designators, which are part identifiers
for assembly...

12
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* Green is soldermask
« In copper (EEIED:
« Surface-mounted (SMD) pads
+ Through-holes (TH), with rings
Slots, with rings
* Via, with rings
Traces/tracks/routes
In silkscreen ()
+ Reference designators
+ Partoutlines

Shape and orientation; “keep-out”
area for avoiding part overlap

.... Part outlines used for orientation and avoiding part overlap....

13



THE.

PCB Terminology
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* Green is soldermask

« In copper (EEIED: \ :
« Surface-mounted (SMD) pads
+ Through-holes (TH), with rings

Slots, with rings

* Via, with rings

Traces/tracks/routes

In silkscreen ()

+ Reference designators

+ Partoutlines

« Pin numbers/indicators
« Pinfunction ID and part orientation

RASPACE

.... And pin numbers or indicators for functional referencing and part orientation. A
common use-case is a small dot indicating pin one of an IC. Silkscreen is also used to
identify the designer, projects, revision, year, company, warnings, and important
information such as input range or mechanical restrictions.

14
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Putting it all together..
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PCBs are commonly filled with these elements as identified here, with reference
designators, through-holes, surface-mounting pads, text, part outlines, pin numbers,
vias, and traces, all being present to enable assembly and use of the board.
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No
connection!

COMPONENT

SOLDER MASK

Single-sided solder Double-sided solder

One last important note about fabrication that you should keep in mind while
designing is the idea of where the component sits relative to where the traces are,
and how the component will connect to the trace. Surface-mounted components, for
example, require vias to connect between layers. Through-hole component have
built-in holes, but if those holes are not plated, you must be aware of where the trace
comes from. Consider the case on the left, a through-hole component with a non-
plated hole. If the trace is on the bottom side of the board, there’s not problem
because the solder joint connects to lead to the annular ring of the hole (and
therefore the trace). However, if the track is on the top side of the board, the
component lead will not be connected to the trace because the hole is non-
conducting, and the lead is not soldered on the top side. This issue can be avoided by
either: 1) placing traces and components properly with non-plated through-holes to
avoid this; 2) using the double-sided solder method shown on the right, if possible; or
3) always plating your component through-holes. Consider your fabrication house,
cost, and time when making these choices.
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End of Part 1

And that ends part 1 of The Hive’s PCB Design Tutorial with KiCAD. Today, we covered
what PCBs are, and a lot of jargon and terminology surrounding their design and
fabrication. A PDF of this video is available as well, linked in the description and
hosted on The Hive’s Wiki.

In part 2, I'll introduce PCB design software with a broad overview of how this family
of software works, bring KiCAD into our lexicon, and end with a generic PCB design

flow that we'll try to follow throughout the subsequent videos.

See you then!
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Part 2: How are PCBs designed?

Ben Hurwitz, Spring 2024

Hi, and welcome to part 2 of The Hive’s PCB Design With KiCAD tutorial series. My
name is Ben, and in this video, I'll be going over how PCB design software is structure,
and describe the basic design flow you might follow to go from an idea to a read-to-
fab board. Let’s get started.



HI PCB Design Software Overview

HOKERSPACE

* PCBs are designed with specially-crafted software
called, among others, “e-CAD”, “PCB CAD?”, or “EDA”

* There are many different such applications with
different strengths and weaknesses

» Understanding layers is key
* Placing traces on a silkscreen layer will cause your circuit not
to work (and you’ll be sad)

PCBs are designed with specially-developed computer-aided design software, known
equivalently as e-CAD, PCB CAD, or EDA for “Electronics design automation”. Many
different software applications and suites exists that can perform the required
functions for this process, and all of them have strengths and weaknesses. However,
the jargon and processes are generally very similar, meaning if you learn one, you
have the tools to learn others with relative ease; it’s often just a matter of discovering
the new locations of the necessary icons and settings.

The understanding of layers and how the layers are represented on screen versus
their physical manifestation is critical. Place your components or object polygons
onto the wrong layer and you’ll be very sad later (and probably a bit less wealthy).
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PCB Design Views
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» All such software involves making a schematic, and then
arranging components on layers in the /ayout/PCB

* The schematicis the circuit diagram - what we might hand-draw
on paper

» The /ayout(which KiCAD calls the “PCB Editor”) is what the circuit
board actually looks like, in /ayers

» These views are inextricably linked together so that changesin
one are appropriately reflected in the other

Note! The layout will often look nothing like the schematic!
And that’s fine — the schematic is for people to read, whereas the
layout is for electrons to read.

PCB CAD software uses two primary views, the schematic and the layout, which can
also be called the PCB view. The schematic is for the circuit diagram, what might be
drawn on paper with symbols and lines for connections. The layout is the physical
design of the board in layers — the size and placement of components, the actual
location of routes, and the mechanical constraints. These views are inextricably linked
so that changes in one will be reflected in the other.

It’s very important to recognize that the layout will often look nothing like the
schematic. And that’s fine, because schematics are for people to read and
understand, whereas the layout is for electrons to travel. These two views do not
have the same goals.
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! Layers
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» PCBs are designed in a stack of metaphysical layers that use
polygons to indicate which objects are filling the physical space
» Similar to Photoshop or lllustrator or other graphics design software

* There are many available layers in EDA software, many of which
you will not need or use

« Here are some important ones (using KiCAD names):
« F.Cu (and B.Cu) - the front/back copper
» F.Silkscreen (and B.Silkscreen) - the front/back silkscreen
« Edge.Cuts -the board’s physical outline/dimensions
« Less used: Adhesive (for solder glue), Paste (solder paste), Mask
(soldermask), and Courtyard (part body outlines)

» Software terminology will vary - Google is your friend!

As | mentioned before, layers are a crucial component to PCB design. Each layer in the
software will either describe a physical layer within the actual manufactured stackup,
such as copper or silkscreen, or an informational layer for the designer to add
information for themselves or the fabrication house, such as dimensions, part names,
project revisions, and more. These layers are similar to other graphic design tools,
such as Photoshop or lllustrator, but they generally don’t have priority; overlapping
polygon on different layers is typically acceptable (though not always).

There are numerous layers that you will need to become familiar with, though there
are often many more within a given software package that are either left unused or
you will not interact with. The most commonly used ones include those for the
copper layers, the silkscreen layers, and the board’s outline layer. Less used layers
include those for solder glue, paste, and mask, as well as part names and outlines.

The layer names given here are for KiCAD, whereas other software will likely use
different naming conventions. Google is your friend here.
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! How do parts work?”?
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+ Virtually all components you add to your design will comprise two
models: a symbol/and a footprint (and maybe a 3D model)

« Symbolsare the schematic representation of a part - e.g. the squiggle
of a resistor, the coil of an inductor
* Symbol connection points are called pins.
» Footprintsare the physical form of the part - through-hole sizes, pitch
(spacing), body shape, etc.
« Footprint connection points are called pads. (Yes, even TH ones.)
» Some software only allow you to place devices, which are a fixed, pre-
defined, symbol/footprint combo
* This means that every different footprint for the same symbol require differeni
devices -> e.g. dozens of different resistors

« Symbols, footprints, devices, and 3D models are stored in /ibraries.

Similar to how there are two views for the entire PCB, each part or component that
are included in the design (even non-electrical ones) have at least two models: a
symbol for the schematic, and a footprint for the layout. They may also have 3D CAD
models as well for a 3D view or for exporting to mechanical design or simulation
software. Symbols are the schematic representation of a part — think the squiggle of a
resistor or the parallel lines of a capacitor — with pins to define the symbolic
connections points. Footprints are the physical shape of the device, including the
body, through-hole, or surface-mounted pads, and are digital representations of the
component’s package. The connection points for footprints are known as pads, even
when they are through-holes. Some software requires you to link a symbol and
footprint together into a single combined model called a device. All models are
stored in libraries.
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! How do parts work?”?
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» KiCAD does not have devices; in KiCAD, any symbol may
be associated to any footprint
» This allows a lot of flexibility, but also requires careful
selection of footprints for every part to match pins and pads.

* Be careful to select the correct footprint

KiCAD does not use devices, meaning that any symbol may be associated with any
footprint. This allows a lot of flexibility — you don’t need to have a thousand different
devices for resistors alone, and you can use the same footprint for many symbols very
easily — but it also opens the door for designers to accidentally select the wrong
package, and requires careful alignment of the symbol’s pins with the footprint’s
pads.
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! How do parts work?
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« Many standard components (e.g. Rs, Cs, Ls, diodes,
transistors) have standardized symbols and footprints
built into KiCAD that you can easily use

* ICs and non-standard components will likely not be

* If the symbol/footprint you need is not in KiCAD:
1. Check theinternet for them (work smarter, not harder)
2. Draw them yourself

* We’ll go through both methods later.

KiCAD, and most software, have many built-in libraries that can (and should) be used
for standard parts, such as passives, diodes, and transistors. ICs and non-standardized
components may not be as generic, and therefore may not be built into the software.
One advantage of separating symbols and footprints is that a part may have a
standard symbol or footprint but maybe not both; in KiCAD, that’s easily handled, but
in device-based software, it would be more challenging, and would generally require
creating the other half of the device model.

In general, you should not be creating your own models; that should be the last
resort because it’s tedious, time-consuming, and prone to errors. There are dedicated
companies out there that will create electrical models for free. Use these services
instead to reduce the amount of busy work you have to do. I'll discuss both methods
later.




HI Design Rules - ERC and DRC
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* Both the schematic and the layout have a set of rules for
allowable designs
« Generally, the schematic rules (“electrical rules”) are fixed
« The layout rules (“design rules”) can be changed depending on
the fabrication house and/or requirements
« All CAD software can check your schematic/layout
against the rule sets -the £FRCand DRC, respectively

It’s critical to run these checks throughout the process to
avoid incompatible or nonfunctional designs!

Lastly, there are two sets of rules that your board must adhere to to be fabricated
successfully. The first are the electrical rules that apply to the schematic, things like
whether wires are connected and if pin types match. These are typically fixed and
don’t need adjusting. The second are design rules that apply to the layout, such as
hole sizes and copper separation distances, and these come from your chosen
fabrication house and design requirements. Any e-CAD software will be able to check
your designs against the electrical rules, calls an ERC, and the specified design rules,
called a DRC. It’s super important to both make sure that your design rules are
correct by reading your fab house’s instructions carefully, and to run these checks
multiple times throughout your design iteratons to avoid error propagation and
incompatible or nonfunctional designs.




HI why KiCAD?
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* Relatively low barrier to entry
» Good for introducing concepts without too much overhead

* Free and open-source
+ Active community of support and developers
+ Cross-platform operation
+ No cloud operation for you to getlocked into
- No big company support
- No fancy integrations with external software
- Alittle more rough at the edges than industry-standards

- Customization with Python scripting. (Not covered here.)

KiCAD, as I've mentioned, it just one such software suite that can make circuit boards.
It has a number of advantages that | think makes it a good tool for learning this
process. There is a relatively low barrier to entry relative to the industry titans,
making it good for introducing concepts without all the extra overhead. It’s free and
open-source, meaning you can use it even if you’re not with a large company, with a
large an active community of support and development for cross-platform operation.
Additionally, there is no cloud storage to lock your designs into. The lack of big
company support may be detrimental for certain reasons, however, such as missing
external integrations and advanced functionality, and it can be a little more rough at
the edges due to the lack of dedicated development engineers. This missing
functionality, and much more, can, however, be added through the use of custom
plugins and modules, written in standard Python.




HOKERSPACE

H KiCAD tips and tricks

* Rolling the scroll-wheel will zoom.
* Clicking-and-dragging with the scroll-wheel will pan.
* The “Insert” key will typically repeat the last command.

» Most text inputs allow for math equations and unit
conversion. Useful between metric and imperial.

* CTRL + F1 shows all the available hotkeys. Pretty nice.

KiCAD has a few program-wide shortcuts that are good to know about before we get
into it. Like more CAD software, a three-button mouse is highly advantageous, with
the scroll-wheel being used to zooming and panning. The insert key will typically
repeat the last command (useful for placing multiple parts), and most text input will
hande math expressions and unit conversions. Finally, there are many shortcuts, most
if not all of which are customizable, and CTRL + F1 will show them all.
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H EDA Design Flow (Broadly)

MOk

Conceptualize the circuit. Breadboard/simulate, perhaps.
Part selection
Generate libraries and determine design rules

poop o

Create your schematic

1. Addsymbols to the schematic

2. Connect symbols with wires

3. Assign footprints to symbols (ERC!)

5. Layoutyour PCB
1.  Arrange footprintsinlayout
2. Connect footprints with traces and planes
3. Add finishing touches (silkscreen, teardrops, etc.) (DRC!)

6. Gerber/assembly files

Lastly, while designing any board has it’s own special requirements and every tool has
its own quirks, PCB design broadly follows the following sequence.

First, you conceptualize and ideate the circuit, with breadboards or simulations.
Second, you select and obtain your key parts, and anything that’s either specific to
the design or hard to get.

Third, create your libraries and setup your project, including determining a fab house
and locating their design rules and requirements.

Fourth, create the schematic with symbols, wires, footprints, and ERC using an
iterative process to finalize your design into something cohesive and coherent.

Fifth, lay it out, spending the majority of your time on placing the components, then
routing, and finally adding any finishing touches, while running your DRC liberally and
frequently to avoid any last-minute major errors.

And finally, sixth, once you’ve iterated enough, satisfied your design requirements,
and get a clean bill of health from your ERC and DRC, plot the required gerber and
assembly files and send to fabrication.

Of course, there’s more after that, like waiting, testing, debugging, more iteration,
and programming, but that’s generally what it takes to go from an idea to a board.

11



End of Part 2

And with that, we close the book on Part 2. We covered EDA software and how it
works with a lot more terminology, introduced KiCAD, and gave a broad PCB design
flow that we’ll look to follow through the coming videos. A PDF of this video is
available as well, linked in the description and hosted on The Hive’s Wiki.

In Part 3, we'll start that process with an introduction to the circuit we’ll be
developing into a PCB, no electrical engineering knowledge required, and going

through the process of part selection.

See you there!
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Ben Hurwitz, Spring 2024

Hi, and welcome to The Hive’s series on PCB Design with KiCAD.

My name is Ben, and in this part 3, I'll be giving an overview of the circuit we’re going
to design a board for, and go through the part selection process.

| don’t think you need any electrical engineering knowledge to understand this
material since I’'m not doing any actual theory; most of it is just why | picked the

various parts, and how you might for your own projects.

Let’s get into it.



H What is the circuit?
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. T .
A battery-powered switched- ®
LED circuit (a flashlight) SRSTH0
* An LED driverisan IC used to (;ioer
supply a stable current to 1-or- L+
more LEDs ——

* Push-button SPST-NO switch
will enable/disable

» Single coin-cell-type battery

So what are we actually designing a board for?

It’s basically a flashlight, or more technically a battery-powered switched LED circuit.
An LED drive is an IC that provides a fixed and stable current and voltage at the
output for driving a number of LEDs. It’s more stable than a battery and a resistor,

and it can boost the input voltage up to drive many LEDs both in series and parallel.

A simple push-button tactile switch in a SPST-NO configuration will turn on and off
the circuit.

The power will be provided by a single coin-cell battery.
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Brief aside: switch terminology

* SPST~—Single Pole Single Throw

-

» Poles: how many separate circuits (i.e.

electronic pathways) are controlled < SODT-SinglePole DoubleThrow /"
« Latching (state is maintained after '
actuation), e.g. light switch + DPST = Double Pole Single Throw
« Momentary (state maintainted while S
activated; often denoted with + DPOT-Double Pole Double Throw

parentheses, e.g. (ON).) e.g. keyboard
* Throws: how many outputs there are
per pole(i.e. per controlled circuit) S s Ak R Rl
« NO (normally open, i.e. disconnected) PSR B N T T e
» NC (normally closed, i.e. connected)

* 3POT~ThreePoleDoubleThrow 07 . .0 e e’ o

» C(common,i.e. always connected) !/ /a3
+ Also many different actuation types, e.g. ! ! ! !
toggles, rockers, buttons, sliders, etc. e~ : o»- o »

Okay, so for those who don’t know (or, like me, always forget) about switch jargon,
here’s a rundown.

The number of poles describes how many circuits the switch controls. This is not how
many outputs, but literally how many circuits, how many electronic pathway
selections. You should be able to see the difference between the first two on the
right, which are both single pole, and the second two, which are double pole. Each
pole can either be latching, where the state is maintained like a light switch, or
momentary, where the state only changes for the duration of the actuation, like a
keyboard key.

The second important term is the number of throws, which described the number of
output per pole. So the first switch, the single pole single throw, controls one circuit
with a single output. The second switch, single pole double throw, has one circuit
with two outputs. The third is double pole single throw, so two circuits each with one
output. And so on. Throws can be normally open, meaning disconnected, like the
button on the lower right, or normally closed, meaning connected, like the button on
the lower left. One of the terminals will be common as well, meaning always
connected, and is mostly relevant for double throw (two output) switches.



https://forum.digikey.com/t/switch-basics-examples-of-pole-and-throw/18150

Switches are typically named by the number of poles then the number of throws,
single pole single throw, with the shorthand SPST. Single throw switches will often
have a notation for whether they’re normally open or normally closed.
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» Before we begin CAD’ing, you want to either have your
parts on hand, or know they’re available.
» Otherwise, you’ll be sad once you’ve spent hours routing only
to find the package you need doesn’t exist.
* By having the parts ready, you are ready to generate or
find the correct footprint as well, saving you future
headaches.

* This is often very time consuming, but also critical to an
operational board!
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 This design was driven by a few factors (in no order):
* | arbitrarily wanted to use a coin cell battery
* Small, available, non-standard footprints for practice
« lwanted to use an IC to demo locating symbol/footprints online
* | wanted alow but varied component count
* Low-cost
» Conceptually easy
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* How did I locate these parts?
* | tried to find parts that are readily available in The Hive
» Theseincluded Rs, Cs, Ls, LEDs, the switch, the battery, and its holder
+ Other components were sourced from Digikey

* I’m familiar with them and navigating their website, but I’m sure | could
have found most of this from Amazon, Mouser, or other supplier
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» Battery: CR2032
« Standard coin cell (lithium-primary, 3V nominal), Hive-available

« Battery holder: MPD BC2032-E2 (Digikey) ‘

 Hive-available (had to hunt a bit for a drawing)

Moes

« Switch: 6mm pushbutton tactile switch (e.g. Digikey)
» Standard, boring oI’ momentary on button, Hive-available

* LEDs: 5mm clear domed through-hole (e.g. Digikey)
» Again, standard, boring, Hive-available through-hole LED

| went with a coin cell because it’s small



https://www.digikey.com/en/products/detail/mpd-memory-protection-devices/bc2032-e2/2077836
https://www.digikey.com/en/products/detail/cui-devices/TS02-66-70-BK-160-LCR-D/15634243
https://www.digikey.com/en/products/detail/creeled-inc/C512A-WNN-CZ0B0151/2809629
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* The LED driver was a bit more involved, as ICs usually are

 Digikey filtered for:
* “in stock” and “active” status (always a good filter set)
« a minimum supply voltage of =3V (so it works with the battery)

» a surface-mounted package (arbitrary) that is hand-solderable
(so no super-tiny or BGA-style packages)
» Boost topoliges only (need to increase the voltage for the LED)

* This resulted in 26 options
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* How to select from these when they are all similar?

» Cheap and available is good
* Read the datasheets for details - supplier can be wrong!

* | chose the Richtek USA Inc. RT4526GJ6 because:
1. It’s on the cheaper and available side
2. It has an “enable” pin (shutting off power is less clean)
3. The datasheet provides recommended components
4. Thereis no available symbol/footprint (good for this tutorial,
not for normal design work)



https://www.digikey.com/en/products/detail/richtek-usa-inc/RT4526GJ6/16376615

i1 Part Selection

HOKERSPACE

L
22K 1o 4TuH
u./W\

Yo

- The “typical application” circuit J : s
L WMT"‘—.I_'—Cn_n -
+ I_LED = 0.3/Rset -> for 10mA, ifom ‘im

%A;E’L‘ RT4826
Rset =30 ohm T
Enable o 2 EN 13 L

« For simplicity, Rset, Cin, Cout, i - J ety

and L will be Hive-available

||H

e 0l 1. Recommended Cauiposants for Typice Aspiication Chelt
» Diode is unavailable on R . T s

| | ENKIOTEIZZRAT | Capectu Canami
| +
| OMCIVBINARA | Cagucter Comme, 1SV XEH | Tasye Yiaken

Digikey; similar selected

Hesaty 1501, 1% piER
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1
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|

| i | MATATIIIM ot 720



https://www.digikey.com/en/products/detail/nexperia-usa-inc/PMEG6030ELPX/5436265

THE.
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* LED driverIC

» Battery + holder

* SPST-NO switch

« Cin, Cout (caps)

L (inductor)

« D (Schottky diode)
 Rset (resistor)

* 4x LEDs

2112

Complete circuit and parts list

L

—l) O

SPST-NO

VIN | ED
. gn Driver

r—4GND

FB

/-
.

Rser =

Here’s the full circuit and parts lists. Don’t worry too much about memorizing this or
anything. I'll bring it back frequently as needed during the upcoming videos (though

feel free to print it or whatever).
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LED drive IC RT4526GJ6 TSOT-23-6 (= 3.1x 1.8 x 1 mm)
Battery holder BC2032-E2 TH Custom

Switch TS02-66-70-BK-160-LCR-D TH 4-TH 6mm x 6mm

Cin, 2.2uF C3216X5R1C225KT SMD 1206/3116 (3.1x 1.6 x 0.55 mm)
Cout, 1uF C3216X7R1C105KT SMD 1206/3116 (3.1x 1.6 x 0.55 mm)
L, 22uH LBR2518T220M (22uH) SMD 1008/2518 (2.5 x 1.8 x 1.8 mm)
D PMEG6030ELPX SMD SOD-128 (4 x 2.7 x 1.1 mm)
Rset, 30 Q Unknown (from kit) SMD 1206/3116 (3.1x 1.6 x 0.55 nitn}
LED C512A-WNN-CZ0B0151 TH 5mm diam, 0.6mm lead holes

And this is a large bill of materials without any of the “bill” portion. We’'ll see this
again later as well.

12


https://www.digikey.com/en/products/detail/richtek-usa-inc/RT4526GJ6/16376615
https://www.digikey.com/en/products/detail/mpd-memory-protection-devices/bc2032-e2/2077836
https://www.digikey.com/en/products/detail/cui-devices/TS02-66-70-BK-160-LCR-D/15634243
https://www.digikey.com/en/products/detail/tdk-corporation/C3216X5R1C225K-1-60/1965637?s=N4IgTCBcDaIMIGYwEYBsANArAJWXMYmA0gCogC6AvkA
https://www.digikey.com/en/products/detail/tdk-corporation/C3216X7R1C105K-1-30/513953
https://www.digikey.com/en/products/detail/taiyo-yuden/lbr2518t220m/1170881
https://www.digikey.com/en/products/detail/nexperia-usa-inc/PMEG6030ELPX/5436265
https://www.analogtechnologies.com/document/Resistor_Kits.pdf
https://www.digikey.com/en/products/detail/creeled-inc/C512A-WNN-CZ0B0151/2809629

End of Part 3

And with that, we’ve reached the end of Part 3, in which | introduced the circuit and
went through the process of part selection. Hopefully this provided some insight on
doing this process on your own. A PDF of this video is available as well, linked in the
description and hosted on The Hive’s Wiki.

In the next video, part 4A, we'll finally get into actual design with an introduction to
KiCAD’s schematic capture view and placing basic symbols.

See you there!

13
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KiCAD

Part 4A: Schematic Symbol Placement

Ben Hurwitz, Spring 2024

Hi, and welcome to part 4a of The Hive’s PCB Design With KiCAD series. My name is
Ben, and I'll be your guide here. Part 4 as a whole will cover the entirety of the
schematic creation. Part 4A will look at the schematic capture window, and detail
how to add built-in symbols to the design.

If you watched part 3, you might remember that in our design flow, there was a
project setup and library creation step. Due to the relatively simplicity of this design,
and that library management was not covered during the original workshop this
tutorial is based off of, we’re going to leave the library creations to parts 6 and 7. |
strongly advise you to watch through those if you’re considering doing design more
seriously.

Anyway, let’s get into KiCAD.
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Circuit Reminder

ASPAD

k|
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L D
LX
* VN LED

¢ —20 L EN Driver

SPST-NO —1aND
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—

Before we get into KiCAD, just a reminder of the flashlight circuit we’re developing.
Note that this image was not take from KiCAD, and therefore the symbols and

graphics are different from those you are about to see.




ik . As an aside, if
!u:mn: O p e N K | C A D you’re using Mac
or Linux, some of

these screens
will look different
since | did this all
on Windows 10,
but the concepts

are the same.

Also, this is for
KiCAD version 7.
I’m sure a lot of
the concepts will
translate to
future versions,
but it may icok
different.

Open KiCAD however you normally open software.

As an aside, | did these slides in Windows 10 using KiCAD 7. If you’re using a different
operating system, or a different version of KiCAD, some of the graphics and visuals
may look different or have slightly different wording from these slides, but the
concepts should still hold.
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This is the first window that opens, called the Project Manager. From here, you, well,
manage your project. It usually opens to some old project you’ve done, so we’ll go
ahead and create a new project under File > New Project.




H| File > New Project (Ctri+N)

HOEERSPAD

B

(D ot oo

Unfortunately,
this name was
picked for a
simpler version
of this circuit.

Name is and save it wherever you’d like. | don’t this name was the best choice, but
whatever. | also always like to check the box at the bottom that says “create a new
folder for the project”. Obviously | could create the folder myself, but it’s easy to do.




HIVve Main Window - Working Project
s
‘. M’z‘:m..un.u..a.. 1 schematic Editor
a8 rRBAALD G Layout (.kicad_pcb) |
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B Schematic (.kicad_sch) I
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-y o et CR e
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directory structure! |

o Image Converter

But it willinclude i e
everything within the I
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S Sorvhe ot M dhock &

ﬁt] Phagin and Content Manager
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Great, so this brings our project into the Project Manager and shows us the project
structure. *This isn’t really a directory structure, though it looks like one. KiCAD will
make backups of your project as pre-defined intervals, which can be set within the
preferences, and are saved in the backups folder. On the right are shortcuts to the
various tools that KiCAD offers. The two keys files are the *schematic, with the
extension .kicad_sch, and the *layout, with the extension .kicad_pcb.
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Let’s open the schematic file by double-clicking to open the Schematic Editor.




Thisisthe
schematic view.

This is the blank schematic view.



Title block defaults to A4.
Size and values are adjustable
under File > Page Settings

The title block defaults to A4. You can change that and adjust the text within it under
the page settings. You can also safely ignore it and place whatever you’d like outside
of it; it’s not a limit at all. There is a way to remove it, but it requires making a custom

drawing sheet. Not hard, just beyond the scope of this video. A link is found in the
PDF:

https://forum.kicad.info/t/hide-title-bar-from-existing-drawings/46213




The mouse is the crosshair icon.
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(Note that thisis
where units are in

virtually every =
KiCAD window.) :

The units and grid settings are located in the upper-left. This is pretty much where
these settings will be in every window in KiCAD.
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! Schematic View

e
-

The schematic
hierarchy shows
all the sheets of
your schematic.

Useful for -
separating :
circuit functions. :

The left-hand side of the editor is the schematic hierarchy. For larger or more
complex designs, it can be useful to separate the schematic into multiple sheets. Each
sheet would then show up here.




Schematic View

0o ™~ - K

i s The right-hand- R .
side toolbar has a [ Add symbol (A) |+
number of

shortcuts I PWR/GND (P) I_'
[ Add wire (W)
All hotkeys are [ Add NC flag (Q) |—|—

customizable
through the [ Add junction (3) —

Prefences | Locallabel (L) :
menu.

<

[ Global label (Ctri+L)

See them all with
CTRL +F1 [ Text (T) and shapes o

The right-hand side of the window has a toolbar that I’ll call the action toolbar, with
shortcuts to many different useful actions. These include *adding symbols, *adding
power symbols, *adding wires, *no connection flags, *junctions, *lables, *global
labels, *text, and shapes. All these actions have hotkeys assigned to them, which can
be adjusted in the preferences menu. Hit CTRL + F1 to get a list of all the currently
available shortcuts.
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We’re going to start by adding all the symbols now. We’'ll start with the generic
symbols, like the resistor, LEDs, battery, and so on, and then do the switch. The IC will

come last.
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Adding components - R

HaEOmn . . LEEFLAMTRBE

I Click the “Add Symbol”
icon (or tap “A”) to open <
the “Add Symbol” )

window.

To add a symbol to the schematic, tap the “A” key, or click the icon identified in the
actions toolbar.

15



The “Add Symbol” window
has all the available
symbols - almost 20k!

How to narrow that down?

This will open up the “Add Symbols” window.

There are nearly 20 thousand symbols built-in to KiCAD!

16



[Filter | s> -

We can use the filter at the top of the window to narrow this down...

17



Adding components - R

Baomn . . S R W N

Filter by “resistor”? “ =

Sometimes, filtering can add

more confusion!

» While KiCAD (or you) may
not care about which
symbol you choose, it’s
critical for readability!

» Ifyou filtered well, e g
sometimes you can scroll aron
to locate the desired wr
symbol

... although that may not be as helpful as we’d like, and can potentially be even more
confusing. Scrolling through the filtered options can help, but only if there aren’t a
thousand of them.
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Alternatively, select from a

knownlibrary. - Either way, locate an
acceptable symbol for
Generic passives (e.g.Rs, Cs, theresistor.

Ls, diodes) are found in the "
“Device”library, among other . T
useful generic symbols. :

Alternatively, if you know the library, you can just open that directly.
Many, even most (though not all, as we’ll see), generic components can be found in
the Device library. You'll still have to scroll, but by filtering and locating that library, it

can help to narrow it down when you don’t know exactly what you’re looking for.

Go ahead and pause the video and locate the resistor symbol.




Adding components - R

l>
[E— — 25a
* <
If you locate the symbol “R”, you’ve If you locate the symbol “R_US”,
foundthe IEC (internation) version you’ve found the ANSI (US) version
Either is fine! ‘ ‘ Click “OK” to select it.

There are two resistor symbols you may have found.

If you just found the one named “R”, you might have noticed that it didn’t look right.

That’s because the box-type symbol is the international version of the resistor
symbol. In the US, this would be seen as an unknown impedance.

If you looked a bit harder, you might have located the US version of the symbol
named “R_US".

Either is totally fine, especially for this tutorial.

Remember that the schematic is for you, your colleagues, your boss, and your future

selves to read, so use whichever symbols you’ll best be able to communicate your
intentions to your boss with.

Click OK to select it.

20



That’s pretty small.
Zoom in with the scroll wheel.

(A three-button mouse makes any =
kind of CAD much, mucheasier.)

The “Add Symbol” window will return you to whatever zoom depth and viewing
location you were at when you opened it. Let’s zoom in here with the scroll-wheel, or
whatever trackpad combination you use for zooming. Note that a three-button
mouse is really nice to have for all CAD software, KiCAD included.

21



0 & ™~ nRaEx aw LN
¥ That’s B
better. RUS

That’s better.




BHaCmn . . NI LI TLAY 0

You may orient the symbol either
by rotating (“R”) or mirroring (“X”
or “Y”, depend on axis of mirror).

R1
Left-click to place it on the ? R_US
schematic.

Anywhereis fine —it doesn’t even
have to be within the title block,
butitlooks nicer.

You can orient the symbol prior to placement by rotating with R or mirroring with X or
Y. Place it with a left-click. Outside the title block is find if you’d like.

23
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After you’ve placed it, there are
three options:

1. A secondclick will openthe Let’s click a second

“Add Symbol” window again. ? time to re-open the
R1

R_US

“Add Symbol” window

2. Aright-click willopena
to choose the next part.

context menu to rotate/mirror.

3. Hitthe “Esc” key to exit out of
this “mode”.

There are three options after you’ve placed it.
*Left-click to open the add symbol window again.
*Right-click to open a context menu for things like rotating, properties, or duplicating.

*Hit “ESC” to exit out of this “add symbol mode”.

*Let’s just click again to add the next symbol, the battery




Hive Adding components - Battery
Filtering by “battery”, we can scroll i v

tolocate two generic devicesin
the “Device” library.

Select the single-cell option, and
add it to the schematic near the
resistor.

(Remember: symbols are just for
people to read, so use whichever
symbol will make that easiest. If it’s
important that it’s multi-cell, use that.)

Like the resistor, the battery is a standard symbol, so there’s a reasonable expectation
that we can find a symbol for it in the Device library,

If we filter by battery, we’ll see there are actually two — “battery” for a multi-cell
battery, and “battery_cell” for single-cell battery.

Remember, since the schematic is for you and your boss to read (and your future
selves), use whichever is most informative. If it’s important that it’s a multi-cell
battery, use that one. Otherwise, use the single-cell symbol.

25



HI Adding components - Battery

BHaCmn . . NI LI TLAY 0

Let’s add the LED next. ‘

Battery cell placed!

Note that | mirroredit
aboutY. Not necessary,
just a preference. _JL

Also not necessary to
placeitas | did-we’ll
connect everythinglater. r

(You can click-and-drag the
scroll wheelto pan the view.) |=

Place the battery symbol on the schematic. It’s not critical where right now since
we’ll move most of this around later. | mirrored by symbol because | preferred the

text to the left.

Left-click again to add an LED.




THE.

HIVvE Adding components - LEDs

How convenient that there’sa
generic LED symbol as well!

Let’s add that to the schematic.

(Most non-IC components have a o s 328 — _{Q__
generic symbol that’s acceptable S SRS N4

to use, but be aware of the number remahie. e g T deuatt 4

of pins - that should match your

actual device.)

10 N e T s

Looking in the Device library again gives us an LED symbol. Add one to the schematic.

27



B aCmn

-

There’s the LED!

But whoops, | clicked
too fast and putit
below the resistor.

5
—

7

Got too excited and place it below the resistor. Whoops.
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Right-click on the diode to get
the context menu, and select a
“Move”. etk

Alternatively, hover over (or -
_ | click on) the part and tap “M>.

Left-click to re-place the 5
objects at their new location. = :

(Left-click-and-drag to select
more than one objects ¥ 01
(symbols, wires, shapes, etc.))

Thankfully it’s easy to move. You can left-click-and-drag to move it, click or hover and
hit “M”, or find move in the right-click context menu. Left-click again to place it at the
new location.




Hive Adding components - LEDs

:::::::::

0 » ™" - ¥ N . PARBEGT XN aTAEN
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Great.
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Now we’re going to employ a time-

saving trick. i

D1
Each symbol needs to have a § LED
footprint assigned.

" | If you have more than one identical < R1
symbol+footprint combo, assigning >R

the footprintand then duplicating G
the symbol is much faster than
assigning each symbol to the same
footprint.

(Note: thisis slightly out of our
design flow order, but that’s okay.)

Now I’'m going to use the duplicate feature to make the other LEDs.

But wait! If we add a footprint to the LED first (and a value if we wanted to), we
wouldn’t have to add footprints (or values) to the other LED symbols later. Adding a
footprint can be a touch of a lengthier process (takes like five clicks and two
windows), so this can be quite time-saving if you have many duplicate components.




D1
To assign a footprint, we iﬁ LED
need the “Symbol
properties” window.

Right-click on the diode s

and click “Properties” (or €
hover over/select it and :
click “E”). .

To assing a footprint (and a value), we’ll open the symbol’s properties window.

Select/hover over the symbol and press “E”, or select “properties” from the context
menu (right-click).



THE.
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Adding components - LEDs

There’salot goingonin this esersl Adpareah
window.

Most of this we don’t care . a1, Cantee
about right now. Foore Corow  Contee

This window has a lot of options.

You can adjust the symbol’s “value” here by adjusting the “value” field’s value (this is
confusing, but it’s where it currently says “LED”). For an LED, you might put “green”
or “red” in here; for a resistor, maybe 1k; for a capacitor, maybe 1u. Units are never
included in the symbol value; this is a historical artifact, | think, coupled with the fact
that you can’t add symbols like omega into this field.

Most of this window isn’t relevant right now.
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Clicking into the “value” box o o
for the “Footprint” field, a > I
littleicon pops up on the

right (sort of looks like three ol
books).Clickittoopenthe | @ ==

footprint browser.

EO Ltwary Syreecl

To assign or change a footprint, click the footprint box and then the little three book
icon on the right.




This window shows all the
footprintsin all the libraries
that are available to this
project.

(Recall: footprints are the
physical layout of the device.)

Filter by LED to see what
thereis.

This will open up the Footprint browser, which shows all the available footprints.

Filter on the top left by “LED” to see what’s available.
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Adding components - LEDs

HOKERSPACE

Wow, a lot of LEDs. g 2

Picking the correct footprint
is critical! Otherwise the part
may not fit.

(Note that there may be
multiple footprints that can
work for a part.)

We need the 5mm through-
hole LED...let’s find itin the
“LED_THT” library.

A lot of footprints here still.

It’s critical to make sure the footprint selected will actually fit the part you’re using,
though there may be multiple options that will work.

Since we’re using a through-hole LED, let’s select the “LED_THT” library.
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Adding components - LEDs

HOKERSPACE

Lots of options here.

The “D” indicated the diameter,
with additionalinformation
provided after that.

| don’t care about any special
or specificadditionalinfo, so -
justthe boring 5mm LED it is. Y

. L. ‘| You can check the 3D view of
Double click to assign it. the part (if it exists) to confirm

it’s what you want.

There are still a lot of options here, but here’s the trick: the “D” in the footprint name
generally means “diameter”. Since we know we’re looking for a 5mm diameter 2-lead
LED, that narrows down our search.

Some of these have additional information in the name, such as the -3 for three pins,
or “clear” for a clear dome. We could also select a horizontally-oriented model here if
we knew it needs to be horizontal.

*You can also check the 3D model of the part by clicking this icon here.

Since we’re just using a standard 5mm LED, I'll just double-click that one to assign it.
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HIVvE Adding components - LEDs
The footprint has T “
been assigned! e Velae
Click OK. . =

Great, the footprint is in the “footprint” value box. Click OK.
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It’s not obvious what’s
different, so with D1 selected,
look all the way to the bottom.

. | Seethe footprintassignment? im
k LED
s L
Tt _L+ < R1 e
] 5" 1

You can check the bottom to see that the footprint has been assigned. See it?

*It’s not super obvious.
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Now that the diode is fully
identified*, we’ll duplicate it.

hovering overit, press CTRL + D (or
find “Duplicate” in the context
menu).

Either with D1 selected (like here) or i

Make three additional copies of D1. <R

* We ignored the “value” for this
because the LED color doesn’t matter
for our circuit, but you could also set
that prior to duplicating. L)

Now that we’ve assigned a footprint (and a value), we can duplicate it.

Select the part and press CTRL+D to duplicate, or find duplicate in the context menu.
Make three copies.

Note that copy and paste will also work, and I’'m not sure what the difference is
between those methods.




I
(Hint: click-and-drag the scroll v
wheel on your mouse to pan S
around the schematic.) ]

.‘P:J

Might look like this.

Note that your schematic will almost certainly look different than mine and that’s
okay! There are many different ways to put a schematic together. As long as things
are connected, which we’ll do later, it’s minimally functional.
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* Take a few minutes
to add these parts.

e TheLand Cs are
just like the R we
did before.

* The diode might =

require a bit more
searching...

Adding components -L,Cs, D

L
L

p——o0

+
po—

. VIN
T LED

en Driver
SPST-NO GND .
3

Cix T

At this point, I'll suggest pausing this video and placing the inductor, capacitors, and

the diode (L, C, and D, respectively).

All three can be found in the Device library, but be careful about the diode...

42



THE.

Adding components -L,Cs, D

HOKERSPACE

* Hint: the diode is a N—s p—
Schottky diode ‘
(with the weird . W e
backwards integral 3 en Driver
symbol), not a R '
regular diode,and | . T
yes, it’s a standard i
component. A

GND

Cin

... because the diode is a Schottky diode, meaning the symbol is slightly different than
a regular diode.

Anyway, take a minute or two to find and add these four parts.




1 §

bt

Hopefully you didn’t struggle too much with that, but you should now have ten
symbols.




Adding components - Switch

Thelast non-IC part is the switch.

Filtering by “switch” gives us a huge
number of options again. Too many.

Back into the “Add Symbol” window, we’ll look for the switch next.

Lots of switches available...
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Adding components - Switch

The “Device” library doesn’t have T A A
any switch symbols! Just a rotary - it v e .
encoder (i.e. a dial).

.... And none in the Device library, outside of a single rotary encoder.
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HI Adding components - Switch

For switches, we will actually use
the well-named “Switch” library
instead.

But which one?

Switches are actually in their own library called, cleverly, Switches.
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The switch we’reinterestedinisa
SPST NO switch, the most basic

switch type.

(Recall: this is a single controlled circuit Sw

with just a single output that is normally )
open (i.e. normally disconnected)) T.O/: 2

Because we know the specific type,
we can actually directly filter by
“SW_SPST”.

Add it to the schematic.

IN_SPST
3w ok Sanghn Devay (56

Recall the switch is a single pole single throw, normally-open, switch. Which we can
filter for directly to find the right symbol. Add it to the schematic.
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:::::::::

" a - . W . P A RBEGE XL aTREN
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¥ L
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Great.




End of Part 4A

And with that, we’re done with part 4A of this tutorial series. Here we took our first
look at the schematic capture videw, and added the basic components to our

schematic. A PDF of this video is available as well, linked in the description and
hosted on The Hive’s Wiki.

Please join us for the next video, part 4B, in which we’ll cover how to handle the IC,
which (spoiler alert) doesn’t have a standard symbol. See you there.
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KiCAD

Part 4B: Symbol Location and Creation

Ben Hurwitz, Spring 2024

Hi, and welcome to part 4B of The Hive’s PCB Design With KiCAD series. My name is
Ben, and I'll be walking with you through this process. Part 4 as a whole will cover the
entirety of the schematic creation. In this section, we’ll cover how to locate device
models online, and how to create symbols in KiCAD.

If you watched part 3, you might remember that in our design flow, there was a
project setup and library creation step. Due to the relatively simplicity of this design,
and that library management was not covered during the original workshop this
tutorial is based off of, we’re going to leave the library creations to parts 6 and 7. |
strongly advise you to watch through those if you’re considering doing design more
seriously.

Anyway, let’s get into KiCAD.



7

Circuit Reminder

ASPAD

k|

2118
L D
LX VOuT
* VIN LED
—1 Driver
—=C EN
SPST.NO GND B
Cin—=—=
S B, 4
E—

*

Before we get into KiCAD, just a reminder of the flashlight circuit we’re developing
Note that this image was not take from KiCAD, and therefore the symbols and

graphics are different from those you are about to see.



And this is a reminder of the schematic as it stood at the end of part 4A. We had
added all the standard components, and were about to add the IC. If you’ve forgotten
anything, | suggest you at least skim through that video (or the associated PDF).
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Adding components - IC

HOKERSPACE

* The last component toadd isthe IC

* The IC is slightly different than the other components
we have put down, for two reasons:

1. The symbolis “unique”, or at least, a symbol with the same
pinout would be difficult to locate in the built-in libraries

2. The footprint may or may not be in the libraries (although it is
a standard package, so it likely is... but we’ll pretend.)

Adding the IC is the last step.
*It’s different than the previous symbols for two big reasons.

*First, the symbol itself is unique, or if it’s not unique, locating an IC with the same
symbol that is already in KiCAD will likely be as much work as making a new symbol.

*Second, the footprint may or may not be in KiCAD either. It’s a standard package, so
maybe, but we’d have to see.
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Adding components - IC

HOKERSPACE

* The first thing to do with ICs or other non-standard
componentsis to see if they’re already in the Symbol
Libraries.

* Click “A” to add a symbol and filter for the RT4526.
» Did you find it?

It’s always a good idea to check if they happen to be in one of the built in libraries
though, so *go ahead and open the “Add Symbol” window and filter for the RT4526.

*|s it there?
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! Locating a model for the IC
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* You shouldn’t have actually found anything, which is
pretty normal for most ICs and non-standard parts.
» That’s okay!

* We’re now going to look to see if someone else has
already done the work of generating a symbol and
footprint.

Totally okay that it’s not.

The next check is to see if the models have been professionally generated already.
Always try to work smarter, not harder.




RASPACE

Cut Tape 10T) & Do Pents

S

*® S | | St Sometimes, the supplier will
St AL M link to the models (i.e. the
symbol/footprints).
Predust Alirtvates s

Tape & Aul (11

Sometimes, the suppliers will link to models.




Prodect Aty ibeten

Sometimes not.
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Locating a model for the IC

« There are plenty of places online who can generate (or may
already have) these files.

* Thetwo | use are Ultralibrarian and SaapEBA SnapMagic.

* UL does not require an account to download models, but
does require one to request new models.

* SnapMagic SnrapEBA requires an account to download or
request, but you can also generate symbolsin-browser.

* Both accounts are free to open.

If the supplier doesn’t link, we can go look for them manually.

*The two places | have had good results with are Ultra Librarian and SnapMagic,
which used to be called SnapEDA.

*Both require free accounts to request new models, but Ultra Librarian allows you to
download pre-made ones without one.

*SnapMagic has a few additional tools that are available for registered accounts as
well, like in-browser symbol and footprint generation.

* ¥
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HOKERSPACE

@ . T—

UltraLibrarian’s homepage. |

BUILD BETTER PRODUCTS FASTER

Access FREE spmboks. foompriets, and 30 models hom the Wodd's Lasgest CAD Library

| Nl et e+ by

Featured Products From Our Partners

We'll start arbitrarily with Ultra Librarian. Search for the symbol you’d like a model for.
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<

Unfortunately, the partis

e & m
LAra
Lib¥anan ]

greyed out, so none of the
models exist.

Sometimes, they’ll have
just the symbol or
footprint, and that will
bein red over here.

Unfortunately, the part is grayed, so no models exist.

*Sometimes, the icons on the right will be filled in, indicating that they have a
footprint or a symbol, but not today.
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HIvE Locating a model for thelC
L, o] -

No 3D Model Available

Clicking on the part allows
us torequest the models.

Request either symbol or
asanea e | fOOtprintand get both.

=y P » = itra

Clicking the part gets us to the part page, where we can ask them to create a model
for us. Request either to get both.




IME Locating a model for the IC

Part Request

Afterloggingin, we can request the part.

Looks like this




IME Locating a model for the IC

Reguest Received

et i
o e e P FTR0M

48 hour standard (free) turnaround ::.. ke
time might be too long for you...

Standard turnaround guarantee is 48 hours, which may or may not be too long for
you.
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IME Locating a model for the IC

ISnapMagic

Let’s check SnapMagic next.

@9 o @

Let's make your d nasnap

InstaBuild is there symbol
and standard footprint
generator. The symbol
portionis only available for
certain footprints, but the
footprint generatoris
pretty nice.

Let’s check our other source, SnapMagic.

*SnapMagic’s in-browser model generator is linked on their homepage, but while
most standard IC footprints can be generated, the symbols are limited to select
footprints only.
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H Locating a model for the IC

HOEERSPAD

B

5 Seaphtagic =S - &

P Ao

asadl

RCEER —— But still nope - unfilled
icons mean the model
- isn’tavailable.
Careful! The first partisn’t
the right one. The filled icon here is for
the datasheet.

Searching for our part brings us to this page, *but be careful! Sometimes they
recommend a part at the top that isn’t right.

*Still, no models available — we can see this with the empty icons on the right.
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Locating a model for the IC

HOEERSPAD

r— . -

Similar to UL, we can
request the part from the
’ part’s page.

Sometimes, they have a browser-
based symbol maker called

InstaBuild. The link would be here.

I R O

We can request the models from the parts page. *There would also be a link here if
the in-brower symbol generator was available for this part, but it’s not. Sad.




HOKERSPACE

No guarantee on

turnaround time,
however.

Unfortunately, SnapMagic doesn’t have a guarantee on turnaround time.
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Locating a model for the IC

5 SnapMagic
e
‘e

L

Requested!

-

But you get a cool ghost when you request the part.
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=== |C

» Struck out thrice. What to do?

» Can keep searching (someone musthave made this
before, right?), but returns may be diminishing.

MOk

» Because KiCAD stores symbols and footprintsin
separate libraries, we’ll just go ahead and create our
own symbol directly in KiCAD.

* No need to create our own footprint (yet)

So three strikes. Are we out?

*We can keep searching randomly on the internet, but the returns will likely be
diminishing, and the quality might be degraded.

*Instead, we can just go ahead and make the symbol in KiCAD directly.
Symbols are relatively easy to make, and are less prone to errors than a custom

footprint, though they can be tedious with many pins, so it’s totally doable to make
them without waiting for Ultra Librarian or Snap Magic to be done.
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In the schematic, locate the
Symbol Editoricon.

_i.‘ -

To make a symbol, we need to go into the Symbol Editor, which can be access from
the project window or directly from the schematic using this icon.
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Creating a symbol for the IC

This is the “Symbol
Editor” window.

This is the blank symbol editor window.
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Creating a symbol for the IC

B

HOEERSPAD

Here are all the available libraries.

From the main project window, you can
manage the available libraries, which affects
what’s here. Otherwise, it’s all the built-in
ones plus the project-specific one. We'll talk
about scopein a section.

On the left are all the available libraries. You can manage which are available through
the project window under preferences.

Note that all the built in libraries are read-only, so we’ll need to make a new library
for our new footprints.




Hive Creating asymbol for thelC

:::::::::

<@mmmm |Units are here, again.

Units in the top left again.
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Creating a symbol for the IC

Text and drawing
elements are here.

Text and drawing actions on the right.

25
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HOEERSPAD

And importantly, here’s
the “New Pin” button.

Pins are the connection
points for your device.

Creating a symbol for the IC

> '

Top right has the new pin button, which will be the most used button here, likely,

since pins are the connection points.
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Hl Symbol Library - Creating Models

HOKERSPACE

‘;f - < —
——)

Let’s make a new symbollibrary.

=

“File” > “New Library”

z

Note: You can create a new symboland add ittoa
library you’ve already made using the “New
Symbol” dialog. However, the built-in libraries are
“read-only”.

As mentioned, we need to make a new library to add our symbol into, since all the
built-in libraries are read-only, and we don’t have any writeable libraries of our own.
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Creating a symbol for the IC

HOEERSPAD

Libraries can have one of two scopes:
1. global (available to all projects) or
2. local (available to just this project)

New libraries can be set to have one of two scopes: they can be set to available for all
projects, called global scope, or only be available for this project, called project or
local. Project libraries can actually be made available in other projects by adding
them in manually though the main project window, under preferences.
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IME Aside: Library Management

MOk

 Library management is a whole topic, especially with
larger teams with different backgrounds integrating
automated backups or version control

« For KiCAD, itis strongly preferable to uselocal (i.e.
project-specific) libraries for all projects.
+ Library objects can easily be copied into new libraries, making

global libraries mostly a liability (e.g. external updates
breaking your design)

Library management is an important but under-appreciated aspect of PCB design
work. Or, at least, under-appreciated by beginning designers. There’s a world of
discussion out there about the best methods, especially when considering backups,
version control, and cloud connectivity, but for KiCAD, it’s nearly always better to use
project-scope libraries rather than global ones. Why? Global libraries are not under
your control, can change or fluctuate between revisions, and make transferring an
entire project more difficult. Thus, it’s strongly preferred to create a single project
library and copy global parts into it.

We’ve obviously not done that with this tutorial for a few reasons, primarily because
it adds a lot of tutorial time and that it’s a very simple design. If you’d like to
understand how this process would work in a real design, we go through them from
the beginning in parts 6 and 7.
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Creating a symbol for the IC

HOEERSPAD

Libraries can have one of two scopes:
1. global (available to all projects) or
2. local (available to just this project.

Pick “Project” and click “OK?”.

Based on the principles of good KiCAD library management, make the new library a
project-level library.
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Creating a symbol for the IC

HOEERSPAD

I like to name the project-
specific libraries with the
same name as the project.

Save the library. Typically, you would save it as the same name as the project itself,
and in the project directory, so that everything related to the project is nicely
packaged together.
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Creating a symbol for the IC

HOKERSPACE

| Great! An empty new library.

We can see the new library on the left here.
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Creating a symbol for the IC

To create a new symbol:

1. Select thelibrary tousein
the “Libraries” pane,

2. Click the “New symbol” icon
in the upperleft
a) Ortap “N”.
b) Or “File” > “New Symbol”

Next, we can create a new symbol just hitting the “N” key, the icon in the upper-left,
or under the “File” menu.




Hive Creating asymbol for thelC

:::::::::

| Fill in the pop-up window here. |

Let’s fill in the window here.




il Creating a symbol for the IC

HOKERSPACE

Fill in the pop-up window here.

* ForICs, | used the full part
number for the name.

-

Generally, good policy is to name the symbol with the part number, which in this case
would be RT4526. You can leave off the GJ6 in this case because, if you read the
datasheet, those are the only options for the final three digits.
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il Creating a symbol for the IC

HOKERSPACE

Fill in the pop-up window here.

* ForICs, | used the full part
number for the name.

+ “Derive” if you’re just adjusting — 1
a known symbol.

“Derive” refers to if you’re adjusting a known symbol, like creating a polarized
capacitor by copying the basic capacitor.
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il Creating a symbol for the IC

HOKERSPACE

Fill in the pop-up window here.

* ForICs, | used the full part
number for the name.

+ “Derive” if you’re just adjusting — 1
a known symbol.

+ Eachinstance of this symbolin
a schematic will be identified
by <Reference i
Designator><Number=,e.g.R5 | |
for the fifth resistor. “U” is !
typical for ICs, but you can T -
choose something else.

The reference designator is the letter that KiCAD uses to identify all instances of this
symbol. Each instance will also get a number, so a resistor might be designated R5 for
the fifth resistor of the schematic. “U” is very common for ICs, though you could
choose something else if you'd like. It’s fine for multiple symbols to have the same
designator character, like U or R; it just means they’re of the same type, so to speak.
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il Creating a symbol for the IC

HOKERSPACE

Fill in the pop-up window here.

* ForICs, | used the full part
number for the name.

+ “Derive” if you’re just adjusting — 1
a known symbol.

+ Eachinstance of this symbolin
a schematic will be identified
by <Reference i
Designator><Number=,e.g.R5 | |
for the fifth resistor. “U” is !
typical for ICs, but you can T -
choose something else.

The rest is not relevant now. Click
OKto continue.

The rest doesn’t matter to us, so click “OK”.
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Creating a symbol for the IC

n . : AW . e

Uhhh.... Zoom out.
(Scroll wheel) o

Since there’s nothing on the editor now, it will zoom automatically in to the reference
designator.
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Creating a symbol for the IC
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o - | L B

That’s better. :

The “U” here will be the reference
designator you defined previously. Un-
numbered untilit’s in a schematic.

Something like this is better. The “U” is currently placed at the anchor point, which is
the point at which the symbol will be attached to the mouse. We’ll move those both
later.
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n L B

2 Grid spacing units are defined here.
_ Right-click on the canvas to see the grid
spacing itself - it mustbe 50 mil/1.27mm

. or else KiCAD will be sad later.
I usually select

“mil”, whichis
pretty common

in PCB designin 2
the US.
Note! “mil” I= “mm?. “mil”, or “thou”, are 0.001 inches.

“mm?” are the metric millimeter, 0.001 meters. 1 mil =
0.0254 mm (or 1 mm = 39.37 mil = 40 mil).

As usual, grid spacing and units are defined on the left. Check the grid by right-
clicking. It should read 50 mil or 1.27 mm, or else KiCAD will not be able to attach
wires to it and you’ll be sad later.

| usually select mils for my units because I’'m used to thinking of hole sizes and trace
widths in mils, and because I’'m used to imperial units. But you can readily use metric
units as well. KiCAD is based on metric values, after all.

Note that mils and millimeters are not the same. Mils, which are also known as
thous, are a thousandth of an inch, or 0.001 inches. Millimeters are, of course, a
thousandth of a meter. One millimeter is about forty mils.
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B

o - |

First thing | like to dois
make all my pins.

How many pins do we
o need, and what are they
called?

To the datasheet!



https://www.richtek.com/SaveDownload.aspx?specid=RT4526

THE.

HOKERSPACE

Datasheet, page 1.

We’re looking for
anything that ties the
pin numberto a
function. Usually it’s a
table.

So not here.

RICHTEK

iwe Creating asymbol forthelC

RT4526

Small Package, High Performance, Asynchronous Boost

LED Driver
General Dascription
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cuttet The denct dparides wth WIHE fod swiciwy
Pageercy &z sdow el aeecrel coTponeh ad &
Wity ool ENI (rotheris For T prodesson. T
WAL perdon STV OWF 1 slow Fesporrvive el sl
g capactan Wit bwer volage ceirgs Tha LED
UM 8 Ry el W) I £a00Y Tl BT 0e ISP Ry
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Features
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o bt Power NMOEFET Swich

« Wigie Rangs for MM Direreng (10002 52880 Me)
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« UndarVoitage Protection
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Conveniently, it’s right
at the top of page 2.

The physical location

isn’t relevant yet. We

only want the number
and name.

RT4526

Hive Creating asymbolforthelC

RICHTEK

Marking Information

WoOeh
U

Functional Pin Description

e Pt G
DAY Dite Cote

i N P Woeve | o Farmtsen

- = T Badzh Noce Cpencram ouges of fm stamd N-WOSFET. Comesc ths
48 1 Al OCRY B0 S0

3 GND Goane

5 ) St Vilage VoL Conrddl O sessioe 10 OND 00 s ouns Curvend

4 EN Erutie Contast yesd (ALl Mfo

3 VOuT Outas Vol (For ¥ 0oneet hewan)

" N 1‘5‘“‘1,!‘7-:'

_Function Block Diagram
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o - |

Back to KiCAD, add a
new pin (the icon on the
right, or hit “A”).

Bunch of optionsin
here.

Start with the name and
number.

What were those again?

Creating a symbol for the IC

Having two screens is
quite helpful at this
stage, or being a wizard
with Alt+Tab.
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Start with pin 1.

By default, it’s set
as an “input”. But
isit?

Back to the pinout
tablel

e pare X
P rwuselor 1
fhecines fype 4 pie

Graght sty

X postion

siate
H Passive

¥ positon

Crientaton Free

¥ Unigeciing

i engtht “» Powe ingut
P Posver cutpet

Ng=e fext 522 * Open coliector

Number test sige | 4. Open emitter
# Liconnected

Altemnate pn detnitons

iwe Creating asymbol forthelC

] Commaon to 8l body gtytes (De Morgan)
i Ywbie

Frovew

A x

-

Functional Pin Descripti

PiaNo. | Pin N

1 X

GND

FB

)
4 EN
§ YouT

€ VIN
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If you’re not sure
what itis, you can
either setitto
“Bidirectional” or
“Unspecified” or
“Passive”.

The type won’t
cause the design
to fail, but it might
cause you
headaches later
with the ERC.

An Progeies

e sare LX
P ruste o 1
Eecines fype 4 mpue

Graght sty

X postion

1 positon | Passine

Crientaton free

¥ Unigeciing
“& Powey ingut
P Posver cutpet

i wngtn

Na™e et ve

Number test s

Allemate pn detnions

Creating a symbol for the IC

Functlo_nal Pin Dl_ncnntum

o Na P Name |

Pin Funssen

Ly T Pnty Dpaerdims Seyas of the rawvil NMOGEET Conrec the |
- .o kTl v v e
G0 vl
3 " ¥ aacteck Volage Inpel Correc 3 remmne 4o GND &0 st 10250t SrTend
. [ Erntn Comol gt | Action Mgt
VOUI | 0e ga (Far DA detmet Aassan |
o w lemkwet -
1 Technically, each pin
— | typeis “allowed”
connected to only a
subset of other pin-
types; otherwise, the ;
ERC will throw an error. |
ox A
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The rest of these
are graphical
choices, so we’ll
adjust them as
needed later.

Click OK.

An Properties
e pare X
P rwuselor 1

Lecines fype

Graght sty = Lise

X postion 0o mids
¥ positon 400 mels
COvientaton o Rught

I wngth 100 mh
Nometextsze | %) mely
Number teat 52 | %0 mels

Altemate pn detnions

iwe Creating asymbol forthelC

Functional Pin Description
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HOEERSPAD

B

- | A . i»
o Left-click to place this
: anywhere on the sheet.

We can (and will) move
itaround later.

U

Bidirectional L LX

The pin type is in blue there.
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Creating a symbol for the IC

L 3

i

Bidirectional =— X

| Now add the other five.

Functional Pin D

s N P Name i Funcsen
™ Bk Mods Dpeo-dams seyad of the ranvil NNOGERT Correc tha

Ao ek Tl F e nw) e

2 GHD | Oha 1

3 u ¥ aactec Vokage Inpel CLTrec 3 e i GAL B s (8456t SETRAL

. 1= Ernotny Conyol Fgut | Action Wity

B VOouT | Oexas vatags (Fer AP dwmes Aasaan]

) Vi B

-4 -
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Creating a symbol for the IC

HOEERSPAD

Bidirectional LX

. Power inpu't-;-GND
FB

Input

EN )| Your’s hopefully look
something like this.

input:

Power output 2D VOUT

Power inpute—— V[N If you left the types
“Unspecified” or
“Bidirectional”, totally
okay.
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Creating a symbol for the IC

L X

= Power input -Z—-GND
FB
EN-U
Power output iVOUT

Power inpute—— V[N

Bidirectional

Input

inputs

Next, we’re
going to make a
box to identify
the symbol’s
outline.
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HOEERSPAD

H Creating a symbol for the IC

L\ x
. Power inpu't-;-GND

Input

Bidirectional

FB Make it big enough that
all six pins can sit nicely
EN |jaroundit.

inputs

Use the “rectangle” tool.

Power output 2D VOUT

Power inpute—— V[N
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Creating a symbol for the IC

HOKERSPACE

Mine looks like this.

For height, | conceptually split
the pinsin half and make the box
tall enough for half the pins
spaced two grids apart plus two
grids above and below. In this
case, that’s 3 pins x 2 grids per
pin + 2 extra top grids + 2 extra
bottom grids =10 grids.

x

a2 18 72 M
o

G & W=

oo
==

[ Jon = [t oo ]

< <m
=

For width, | count the grides for Not always the best way!
the widest label, double it, and But it’s a good start.

add two. “VOUT” is the widest at
4 grids, so that’s 10 grids wide.

This is the algorithm by which | spec’d my box’s size, but | abandoned that size
basically in the next few slides, so you’re safe to ignore that.




MOk

B

o - |

. -

If you don’tlike how
your’s looks, hit the “Esc”
key, and then click-and-
drag on the sides or
corners of the box to
adjust.

But seriously, aslong as
all the pins fit, it’ll be fine.

Creating a symbol for the IC
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Creating a symbol for the IC

LX
. Power input -A GND
1 FB

Bidirectional

Input

Next, we’re going to B
move all the pins around
the outline such that the
line touches the edge of
the box with the pin
name inside the box and
the little circle outside.

— |
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H| Creating a symbol for the IC

HOEERSPAD

B

o - |

A1y Like this.

Now move all the other pins
around the box.

VIR Another method to move
objects is just click and drag.

While selected, hit “R” to rotate.

This can all be adjusted later!

You might consider pausing the video here while you place your pins before seeing
what | did.

57



THE.

HOKERSPACE

Creating a symbol for the IC

[
. fal = LX EN -
. VINEE. ¢
u

Like so, perhaps.

Totally fine and
nothing wrong
with this.
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HI Creating a symbol for the IC

HOKERSPACE

GND Or this.

LN[ d Also okay.
VIN

loe bl
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Creating a symbol for the IC

HOKERSPACE

Totally changeditup there. |« »=

Looked at the circuit - T
drawing and visualized it [ c

better this way. KEY POINT:

Functionally identical to the
previous two, but perhaps
will look a bit cleaner later.

Whichever way you have it
is fine aslong as all six pins
are along the edges of the

This can all be adjusted ,‘?”ft“”?'.‘ - —
once the symbolin the =1 < ;
schematic as well by just o

going back into the Symbol
Editor window!

Additionally, when we learn about nets in the next video, you might understand why
it doesn’t matter how the symbol is laid out so much — pins can connect anywhere
without a direct line.




HOKERSPACE

o - |

Next, move the reference
designator (the “U”) to
somewhere that makes
sense and won’t be
obstructed.

Often, this is outside one of
the four corners of the box,
but it doesn’t have to be.

The reference number will
later appear to the right of
the “U”.

ol

il Creating a symbol for the IC
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RASPACE

Creating a symbol for the IC

Great.

Next, change the anchor

point.

This will be where the ‘ v vouT [ . <

symbolis “attached” to

your mouse pointer at. W

Usually the corner or the —
middle is a good choice.
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Creating a symbol for the IC

PECE

=

Lastly, double click in the
canvas (anywhere) or go to
“File” > “Symbol Properties”.
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MOk

These windows often have
alot more options than we
need right now, but they
do offer a lot of flexibility.

For now, just add the part
number (RT4526GJ6) to
the “Value” field’s value.

Adding a footprint here
can be doneif there’sa
single footprint for this
part. We don’t have a
footprint yet, so we won’t
add it, but later maybe.

ve CreatingasymbolforthelC
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Click OK once your done. EHET ®

........

iwe Creating asymbol forthelC

Bhow DowNars 1 Algn

a2t Smautem Nodw

VASse halc  Rod

o Lol
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Creating a symbol for the IC

o - |

Now move the part’s value
(the part number, in this case)
to somewhere else that it can
be read.

Typically this is the middie or
outside a corner again.
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ve CreatingasymbolforthelC

Congrats! That’s the
completed symbol.

If it turns out not to fit or you
want to change it for
whatever reason later, just
come back to the “Symbol
Editor”, and edit away.

3

.

Don’t forget to save!

Then add the symbol
directly to the schematic
with thisicon.

(Or just close the window
to not do that.)
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Aside: Importing a model

If you did find the model
online, downloadit. Then, in
the Symbol Editor, right-click
thelibrary and click “Import
Symbol”. Navigate to and
open the kicad_symfile.
Confirmthe pins, and then
save it. Super easy.
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THE
m!um“ Take a few minutes to arrange your schematic to
something like this (minus all the lines).
2112 R
L D
LX VOUT
Select a part: . VIN LED
M"-Move 0—6“1_64—‘ gn Driver
“R” - Rotate SPST-NO
“X*’Y” = Mirror B —GND FB
Civn ==
—_—l
 C——

Again, pause the video here and take a few minutes to arrange your schematic. You
can arrange it like this if you’d like to, but you don’t have to — connections between
components can be made without actual lines, as we’ll cover in the next video.



— . .
HIVE Schematic with all the parts
If you notice that my LEDs all
- »» wnz xeearqofasudden became filled,
You schematic should ook that’s because | changed the
something like this. symbol at some point and
‘ forgot to adjust back. Sorry.
Don’t forget to save! “ Functionally identical though!

v <<mmm
A 4
h 4 -

) 4

Now we’ll move onto wires
and nets and labels! =




End of Part 4B

And that ends part 4B of this video series in which we covered locating device models
online, and making a symbol for our integrated circuit component. A PDF of this video
is available as well, linked in the description and hosted on The Hive’s Wiki.

In the next video of this series, part 4C, I'll teach you how to connect components
together.

See you then.
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KiCAD

Part 4C: Schematic Wiring

Ben Hurwitz, Spring 2024

Hi, and welcome to part 4a of The Hive’s PCB Design With KiCAD series. My name is
Ben, and I'll be your guide today. Part 4 as a whole will cover the entirety of the
schematic creation. The segment, part 4C, will cover wiring the symbols together.

As with previous videos, it’s recommended that you follow along and pause the
playback frequently.
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Circuit Reminder

ASPAD

k|

4y M
L D
LX
* VN LED

¢ —20 L EN Driver

SPST-NO —1aND

(:“"\'
e [T, -

—

Before we get into KiCAD, just a reminder of the flashlight circuit we’re developing.
Note that this image was not take from KiCAD, and therefore the symbols and

graphics are different from those you are about to see.




And this is a reminder of the schematic as it stood at the end of part 4B. All the
components were down and arranged to look like the schematic in the previous slide
(and like the one in the datasheet). If you’ve forgotten anything, | suggest you at least
skim through that video (or the associated PDF).




H Wires and Labels and Nets - Oh My!

HOKERSPACE

Componentsin a schematic can be
connected either directly or
indirectly.

Directly means connecting two pins
with a wire. : — 4

Indirectly means using /abelsto S 1 I h 4
name the nodes. '

Any pin attached to nodes that have
the name labeled name are
electrically connected through a net
of that name.
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IVE Wires and Labels and Nets - Oh Myl

MOk

We'll start with wires. “ . > ANRTEIR.

Wires are created in one of four ways: L
1. Click (and release) on a symbol’s pin

2. Tap “W” to start a wire at the cursor’s
currentlocation.

3. Click the “Wire” icon on the right
(fifth from the top) to enter “Wiring”
mode, then click to start a wire.

4. Click “Wire” in the “Place” menu.

Let’s connect the right terminal of the
switch (pin 2) to the IC’s EN pin (pin 4).

You might pause the video before continuing.




That was pretty easy.

How about UT’s pin 6 (VIN) to C1?




HIVE Wires and Labels and Nets - 0Oh My!

:::::::::

naComn ~_ . PAREGTELAATA RN
¥,
!A,
h
!.

Not quite.

How’s this look?

*Not quite.




Two issues, one
visualand one
electrical.

First, the wire
coming off the pin
atan anglelooks
funny. Betterto
have a bit straight

off before bending.
‘ v

Click wire segments and “Delete” to
remove them. Or CTRL+Z to undo
the segment. Then re-makeiit.

Second, this dot here,
called a junction,
means the crossed
wires are electrically
connected. No good
for this.




naCmn » LGz ATAEE
»
h 4
: — Y
:
= —— X '
Look how much cleaner thatlooks.
And no green dot means the wires "
are just crossing, not connected.




THE
| Take a few minutes to wire the passives to the IC. |
HOKEASPALE
\ =
T & )
v Q.
LX VOUT f——1 fZ
Hint: You can VIN | ep B L |©
connect pins to 51 £n Driver _]— Cor 57
other wires, no SPST-NO |
just other pins. GND Fa AV
Cin=——
—_—
Rspy

-

We’re going to wire the FB pin, ground (GND), and
the battery afterwards, so ignore those
connections for now.

| suggest pausing the video here to try this on our own before continuing.

10



" & -~ nEx L LN
Your’s should . ﬂ,
look something v
like this. 3ok
— Y
4
= - h 4 1

Again, it doesn’t /have/ to look like this at all. But as long as the components are
connected, you're fine.

11



Maomn LG x ATAEE
| 25 -
s : . : : 4
This is a simple schematic, so connecting g
these componentsis easy.

But what if we had to connect two
components on opposite sides of the 1 P v
diagram? Or sixteen components across : p.
the sheet? Or across different sheets? 0

The answer is labels.

12



H Wires and Labels and Nets - Oh My!

HOKERSPACE

HaCmn . P A REGE ELsaTAnE

Labels allow us to name

wires and nodes. ; ¥
Netsare nodes and wires !: ‘
that share a name.
— 4
Any pins connected to ‘
the same net are o 0y : H v
considered electrically ! x : =
connected. t "
- et h 4 T

Let’slabel the FB node,
and then connectit (with =
alabel) to the R1/D2 node. ™




0 & o B ~ . ARG

| start by drawing a wire stub from
each of those terminals but leaving
them unconnected.

(To end a wire stub, start the wire
as normal and then double-click
where you’d like the stub to end.)

14



HOKERSPACE

Next, | add alabel to the stubs. This > A
will define the net’s name.

Tap “L” (or click the “net label” icon
(the “A” over aline) on the right) to

open the “Label properties” ‘
window.

le 8
—— -
—— —_

Note: “L” describes a local label, meaning only on
this sheet. If you’re connecting to a net that exists
on another sheet, you need a global label (Ctrl+L);

theiconis the “A” within a pennant-looking shape.

v

H Wires and Labels and Nets - Oh My!

- - < —

]
L)
1

15



HOKERSPACE

Type the name of the connecting
netinto the “Label” field and click
“OK”.

The restrictions on names center
around some symbols, and some
globally-defined nameslike “gnd”.

(You can get fancy if you want here,
but boringlabels are fing, too.)

H Wires and Labels and Nets - Oh My!

Label Properties

Labet

Flesas

Name)
The dropdown menu here shows

you all the currently-available
labels. Very helpfulwhen there are
S many similar ones.

+ 1 ]

Formatting

Font Default Font

R ! e
Click OKwhen you’re dor‘.ej

Tent size; | 127

mm

QK Cancel

16
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k|

" » -~
v - »
-

I named my net “FB” for “feedback?,
whichis fine for this contrived
situation, but pretty bad for alarger
schematic where there might be
many feedback signals.

Anyway, left-click on the wire stub
you’re naming to assing the name to
the wire. Anywhere on the wire is
fine, no need to putit at the end.

Then click “Esc” to exit “label”-mode.

Wires and Labels and Nets - Oh My!

17



HIVE Wires and Labels and Nets - 0Oh My!
:-:.....-.:. ~ . A REET XS aTAEN

Great! '
L

Now do the same thing (wire stub, \ 4

label) on its partner node. : | b b
=¢ X
!A
- L 4

‘ (Here, foamose who forgot.) ‘ ‘




Notice |l rotated this one as well so it
was more clear which wire it was
referring to. Not necessary, just nice.
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BaCmn
T
o

Labels are also helpful
just for understanding
the function of various

traces.

This willcome back in
thelayout section.

I won’tlabel anything
here, butit’s good
policy to do so anyway.

il

Wires and Labels and Nets - Oh My!
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L

" os Omes

There are special nets for
power and ground
connections as well.

These come with theirown
symbols, meaning anything
the symbolis connected to
is automatically connected
to the net of that name.

Exercise caution here!l There
is some subtelty with these
that I’m not covering that
can cause ERC failures or
mistakes.

Il

H Wires and Labels and Nets - Oh My!
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-

Let’s try this out with our
“ground” connection.

Tap “P” (or click the ground
symbol on the right, fourth
from the top) to see the
“Power Symbols” window.

-
—




HIVE Wires and Labels and Nets - 0Oh My!

:::::::::

Basically the same as the
“Add Symbol” window.

23



H Wires and Labels and Nets - Oh My!

HOKERSPACE

Openingthe “power”library
shows a bunch of different
symbols for different voltages.
Most look like this. b

Note that these will also = 3 * 1\/2
create a g/lobal netwith the e ,T\
same name as the symbol, e.g. Hrron:

“+1V27.

This is one of those label
naming restrictions — errors
will be thrown if you use these
names for your other nets, or
confusion will reign.




)

B

Wires and Labels and Nets - Oh My!

If we filter by “gnd” or
“ground”, we’ll see a number
of different ground

net/symbol options.
ST AL TS v'\‘|7
For this schematic, with only . sy askin s glata et

a single commonreturn path, : AR YR
the regular GND is what we o A ST 0 RSl G N D
want.

Place it below (but not
connected to) the battery’s
negative pin.




ik
il

Similar to the wires before,
you want to leave a small
distance between the actual
terminal you’re grounding
and the actual ground
symbol, which can then be
connected by a net.




THE.

IVE Wires and Labels and Nets - Oh Myl

MOk

0 & ™" L . P A RBEET XTLWhAATAEDN
Then, without exiting “Symbol”

mode (i.e. don’t hit “Esc”), left- ' | '
click and add another GND \ 4
below the battery { T -
' =F %
17D !-

- ot .{, h 4 1

7
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HOKERSPACE

BHaCmn

Now add three more GND
symbols, either though “Add
Power Symbol”, duplicate, or
copy/paste. Place them:

+ Bottom of theinput cap C1
- Bottom of the output cap C2 |

* Bottom of the set resistor R1

-
—

H Wires and Labels and Nets - Oh My!
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H Wires and Labels and Nets - Oh My!

HOKERSPACE

" » R ~ . PAREG XLt AaTAEN

e

‘ Great! Now wire them. ‘ . =

Fun fact: If you place symbols y
such that their pins are o ' p LG - . \ 4
touching, and then move one ' &
of the symbols, a wire will .
automatically be created B !
between those pins. .

;
<

Not necessary to

29
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1 Beautiful.

Everything that’s tied
toa GND symbol (ora
labeled wire with the
name “GND?”) is
connected because
they’re all connected
to the GND net.

il

]

30



-~

Now let’s do the
power.

Open the power
symbols again and find
an appropriate positive

voltage symbol.

Place itonto the
schematic above the
battery cell’s positive
terminal, and wire it.

il
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H Wires and Labels and Nets - Oh My!

Boacen . ' Excellent! AL
If you used a different
power symbol, that’s '
totally fine (aslong as '
| it’s not a ground). -~ . 4
r Again, symbols are for | - \ 4
human readability, so > =
i aslongasit’s v )
understood, it’ll k- 3
probably be okay.




HIVE Wires and Labels and Nets - 0Oh My!

:::::::::

‘Nowlet’slabeltheVINnode. ‘ P A REEELAATR RN

>




7

HIVE Wires and Labels and Nets - 0Oh My!
Label Properties X
Labet [ I 1
> i )
Flesas
Why .isn:t “GN D” or “y Batt” Vane Show Show Name H Align  V Align  Halic 8ok
listed here?
It’s because those are global
< net names, but this is the /oca/
+i 1! B label properties window.

Enrmattine

Generally, it’s not good practice to use local labels for
global nets because 1) it causes confusion as to
where the rest of the net is, and 2) KiCAD might get
confused. But it’s okay for a single-sheet schematic.

Cancel

You might notice in the label properties window that GND and your power net name
aren’t listed in the drop down. Why?
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H Wires and Labels and Nets - Oh My!

HOKERSPACE

Great! Now that node is PARREELAaTS

TSRS
connected to the +Batt »
terminal of the battery, too. v




H Wires and Labels and Nets - Oh My!

HOKERSPACE

Last thing here: connecting sABRGE LAy N

the switch to the +BATT net. e

Do it however you’d like (i.e. b &
either a wire or alabel or a BT 1
symbol). . e ¥.

Take a second here to make this connection before continuing.
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Hive A fully connected schematic!
Cong}ats! We now have a sAamREEesans RS
fully connected schematic. »
¥
AR
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End of Part 4C

And with that, we end part 4C of this video series on KiCAD and PCB design in which |
covered wiring and nets. A PDF of this video is available as well, linked in the
description and hosted on The Hive’s Wiki.

In the next part, 4D, we’ll look at assigning footprints to the various symbols.

See you there.
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Part 4D: Schematic Footprint Import and
Assignment
Ben Hurwitz, Spring 2024

Hi, and welcome to part 4D of The Hive’s PCB Design With KiCAD series. My name is
Ben, and I'll be walking you through this section. Part 4 as a whole will cover the
entirety of the schematic creation. In this part 4D, I'll cover assigning footprints to
symbols and how to import footprints that you download from the internet. Creation
of footprints won’t be covered because you should almost never have to do that, and
it’s far more error-prone than custom symbol creation, though | will point you
towards how to do it if necessary. More details about footprint creation can be found
in parts 7B and 7C.

Anyway, onto footprints!
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Circuit Reminder

ASPAD

k|

4y M
L D
LX
* VN LED

¢ —20 L EN Driver

SPST-NO —1aND

(:“"\'
e [T, -

—

Before we get into KiCAD, just a reminder of the flashlight circuit we’re developing.
Note that this image was not take from KiCAD, and therefore the symbols and

graphics are different from those you are about to see.




naomn LG e AT EE
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BATT :
I
= y
A -
.
= ' a
= — 4

And a reminder of the schematic that we ended part 4C with, fully populated and
connected.




HI Assigning Footprints

HOKERSPACE

So we have a fully connected PABEGETeAsTS RN
schematic.

L »
Next, we need to add !, :
footprints to everything. 1

k ' Click thisicon (orgo to
. \ 5. | “Tools” > “Assign Footprints”).

== — - h 4

0 L%




Assigning Footprints

wttvee 5 3

rre s bt s

This is the footprint
assignment window.




HIVE Assigning Footprints

:::::::::

S50
N e

Here are all the footprint
libraries.




Assigning Footprints

B A e~ » it B B )
s rre s bt s

There are some filters up
here to help reduce this

list.
“Pin count” (middle
option) and “Library” And here are all the
(right option) are helpful. footprints within the

selected library.




o ——

The middie section is
all the componentsin
the schematic, and any
already-assigned
footprints.

The columns are a bit
confusing -the
symbols are listed
alphabetically by
reference designatorin
the second column,
with the left-most
column just being the
numberinthelist. The
third column is the
symbol name, and the
fourth columnis the
assigned footprint.




Assigning Footprints

ttvee 5 G

rre s bt s

We’ll start from the top
and go down.




)

B

Assigning Footprints

TR R B

Without clicking a library
on the left, filter for the
battery holder part name,
BC2032.




Assigning Footprints

TR R B~ |
ety dn B e e~ —

>

Welp.

We’ll come back to the
battery then.

So what packages are we
using for everything else?

Not necessary to

11
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LED drive IC
Battery holder
Switch

Cin, 2.2uF
Cout, TuF

L, 22uH

D

Rset, 30 Q
LED

RT4526GJ6
BC2032-E2
TS02-66-70-BK-160-LCR-D

C3216X5R1C225KT
C3216X7R1C105KT
LBR2518T220M (22uH)
PMEG6030ELPX

Unknown (from kit)
C512A-WNN-CZ0B0151

TH
TH

SMD
SMD
SMD
SMD
SMD
TH

Ive | didn't remember, either.

TSOT-23-6 (3.1x 1.8 x 1 mm)
Custom

4-TH 6mm x 6mm

1206/3116 (3.1x 1.6 x 0.55 mm)
1206/3116 (3.1x 1.6 x 0.55 mm)
1008/2518 (2.5 x 1.8 x 1.8 mm)
SOD-128 (4 x 2.7 x 1.1 mm)
1206/3116 (3.1x 1.6 x 0.55 nitn}

5mm diam, 0.6mm lead holes

Don’t worry, no need to remember these. I'll remind you of them as we need them.

12


https://www.digikey.com/en/products/detail/richtek-usa-inc/RT4526GJ6/16376615
https://www.digikey.com/en/products/detail/mpd-memory-protection-devices/bc2032-e2/2077836
https://www.digikey.com/en/products/detail/cui-devices/TS02-66-70-BK-160-LCR-D/15634243
https://www.digikey.com/en/products/detail/tdk-corporation/C3216X5R1C225K-1-60/1965637?s=N4IgTCBcDaIMIGYwEYBsANArAJWXMYmA0gCogC6AvkA
https://www.digikey.com/en/products/detail/tdk-corporation/C3216X7R1C105K-1-30/513953
https://www.digikey.com/en/products/detail/taiyo-yuden/lbr2518t220m/1170881
https://www.digikey.com/en/products/detail/nexperia-usa-inc/PMEG6030ELPX/5436265
https://www.analogtechnologies.com/document/Resistor_Kits.pdf
https://www.digikey.com/en/products/detail/creeled-inc/C512A-WNN-CZ0B0151/2809629

T Note! Blindly using global footprints can
AXE leave you exposed to potential issues!

Parts or suppliers may say it’s a standard
footprint, but only the datasheet is truth.

It’s up to you as the designer to confirm the
dimensions of your parts and footprints.

Failure to do so is at your own risk.

Assume, and make an ass out of you and me.

13
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Aside: Package nomenclature

IC Package - Surface Mount Types

- Package nomenclature is the = s
worst, and it’s something you’ll P ’, .
get familiar with as you design * ’
boards. oost o
» There are so many standards, and .
the variation between some are M’ "(
so tiny. It can be really painful. M .

* The datasheet’s mechanical (@ rrnme

drawings are the one and only ?
truth for package sizes. " .D 5

e Use caution!

This is a very (very) small subset of package families.

14



The Csand R are 1206
packages.

Filter for “1206”, making
sure the pin-number-
filter is on.

Back to assigning footprints.

If you’re unsure about which library to find footprints, or you know exactly the
footprint you need, the filter box is the best way to limit your options.

The leftmost filter option uses some keywords in the symbol to narrow down the
options. The middle option filters by number of pins in the symbol. The right one
shows you only footprints in the libraries you’ve selected on the left, if any. | find the
middle one most useful when | don’t know which library to look in, and the right one
only when | know the library. I've selected those two in this screen here.

Then we can filter by the 1206 package size that the capacitors and the resistor are to
find those.

15
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Assigning Footprints
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Nice selection here.

Select one of the Cs in the parts
list in the middle, and then
double-click an appropriate
package on the right.

Then repeat for the other C and
the R.

There are a number of options on the right here. Each footprint is labeled with it’s
library on the left of the colon, and the footprint name on the right of the colon.

For the capacitors, we want to find something that says “capacitor” or “C” and

“1206”. Similarly, for the resistor, something that says “resistor” or “R” and “1206”.

Pick the component in the middle pane to assign a footprint to, then double-click the

footprint on the right to assign it.

*You can view the footprints themselves through this icon here to access the
footprint viewer, from which you can also view its 3D model.

16



Great.

The “HandSolder” options make
the pads a bitlarger for
marginally easier soldering.

Marginally. th

Hopefully you found the C_1206 and R_1206 footprints in the Capacitor SMD and
Resistor SMD libraries, respectively, and assigned them like so.

Note that the “HandSolder” version of the footprints uses a slightly larger footprint
that supposedly makes them easier to hand solder. It’s a pretty marginal change
though.

17



Now do:

» Schottky: SOD128
- L:1008
+ RT4526: TSOT-23-6

Go ahead and add these three footprints to their schematic components. You can
filter directly by the package name, given here. Make an educated guess as to the
correct option if you’re unsure. Pause the video for a minute to do this on your own
before continuing.

18



Great.

« Schottky: Diode_SMD:D_SOD-128
* L:Inductor_SMD:L_1008_2520Metric
« Hand-solder version ends with:
_Padl.43x2.20mm_HandSolder
* RT4526: Package_TO_SOT_SMD:TSOT-23-6
* Hand-solder version ends with:
_HandSoldering

Great, hopefully you found those models okay. They’re listed here if not.




Assigning Footprints

— L v ——

The switch is a bit more complex.

There are two switch-specific libraries
(Button_Switch_SMD and _THT) that we can
hunt through, but the filters actually make this
much easier.

The switch is slightly more complex because there’s no standardize packages for
switches. Or, at least, not in the same way as there are for passives and ICs.

20



Click the switch part in the middle
(5W1), and then the
Button_Switch_THT library.

We’re looking for a 6mm
pushbutton switch.

There seem to be a couple
possibilities on the right. Click the
“Footprint viewer” icon to look.




HIvE Assigning Footprints

:::::::

Well that’s not right.

Remember, this is the part:

W&




Hmm, that could be it, but
I’m a bit worried picking
something with a part
number when that’s not the
part | have....

Notice that the part number is given at the end, the BF3-10xx bit. Omron is the
manufacturer, but you probably wouldn’t know that beforehand.

23



Especially since if we click
this button...

I’m more comfortable with
the generic one.

24
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Assigning Footprints

il TR A MANEF TN Dot el

... we get something that
looks physically right.

the footprint view and get
back to the assignment
window.

Later, we’ll go over a method to physically verify the footprint, and this selection can

be changed later, as well. *

25



Great.

Might be asking what the
other 6mm push
footprints are.

“H”is for vertical height,
which may be important
to the mechanical layout.

26
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For the battery cell, we’ll have
to make that one separately.

Click “OK”.
I think “Apply, Save

Schematic, & Continue”is
fine to click, as well.

Not necessary to

27



Creating a Footprint

—

Okay, back home.

We need to give the battery | +%"+
a footprint, but goinginto

“Properties” > “Footprint ”
Browser” like we did with Click here. J=-
the LED won’t work '

because the footprint e
doesn’t exist.

We need to open the
footprint editor to make or
add it.




)

k|

B

Footprint Library

This is the Footprint Editor.

Note: a lot of this will be
similar to the Symbol Editor.

29



)

B

k|

Footprint Library

ormEremmERw
0000500006060

Same as the Symbol Editor, the currently
available footprintlibraries are all on the left.

We’ll continue to put off the discussion about

library availability until later.

30



]

Like with the symbols, because
the built-inlibraries are read-only,
we need to make a new library for
the battery holder footprint to
reside in under “File” > “New
Library”.
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Footprint Library

Select “Project” for the scope here.

Remember, we want to minimize useage
of global libraries within our projects.

32



Footprint Library

Again, saved with the
project name.




Hive Footprint Library

:::::::

Great! An empty new library.




7

HIvE Footprint Library
]
There are two options for making
footprints in KiCAD.
Completely from Using the wizard. i
scratch, a blank sheet | |
of paper. ' Much better, assuming
your footprintis
Good for distinctly standard (or near-
non-standard parts. standard), but will
Like most battery require some thought
holders. and some math.
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Footprint Library

OEEASRAL

Normally, | would just go 1ook for the footprint
on Ultralibrarian or SnapMagic first.

But for this tutorial, we’ll go 1ook for the
datasheet first to see what the footprint looks
like, and then check online.
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Footprint Library

| had to hunt down the technical drawing for
the battery holder on the manufacturer’s
website because the datasheet link on Digikey
gave me their catalogue.

Not helpful.
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Footprint Library

| Here’s the technical drawing (the top half, at least). |

POGITE CONTACT
et =
I I =
J | “

Y nDA2)

~ MDGATIVE CONTACT

Sl | W | WEVOOON MRTURD | AeTH (DM en
t =% - -

=}

\ | } . | | l i
And here’s the suggested footprint (“PCB Layout”). |

. |

N I
- ) S
1 S

So we could manually draw this,
totally fine, no issues with that.

But we don’t have to! (And we
shouldn’t - too error-prone.)

i

4.10 10.18]

- o 000 [0.03)

0.80 (0.05)—wiie

= 27.20 [1.07)—=

POE LAYOUT

250 tuu»;
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Footprint Library

OEEASRAL

$SI0902 Foampvon nd bnseh Clicking thatlink brings us to the
s “Footprints and Models” page.

i Manufacturer models are first.
Narafacterw [OA s3d CAD Modeis

e Q| 3D STEP file at the top for

this one.

Scrolling down.... |

Syrrbad Fortored 30 Neodel
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... There’s a set of models from Ultralibrarian...
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B

Footprint Library

OEEASRAL

| ...and then some from SnapMagic.

Srapdage:

fevos Tarrer 1D Mode

Which to use?
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Footprint Library

OEEASRAL

There is no right or wrong answer here
generally. Both models are extremely likely to
be sufficient.

It’s on you to confirm that though!

I’m going to use SnapMagic here because | like
the footprint better (and there’s a 3D model).
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Ive Footprint Library

Click “Select Download Format”
and select “KiCAD (V6 or later)”.

(Obviously select a different format

if you’re using different software.)

| also selected the 3D CAD model
because a 3D view of the desiq@d

PCB is useful.
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Unzip the download somewhere accessible.

There will be five five files:

* a.kicad_symsymbollibrary

* a.kicad_modfootprint model library

* a.step 3D model

* a.htmlinkto a “How to import” webpage
+ alicense textfile

45



Footprint Library

Backin the Footprint Editor,

right-click the new library and
select “Import Footprint...”.

Navigate to the unzipped
i .kicad_modfile and open it.
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Footprint Library

Here’s your chance to double
check it! The “Measure” tool is
under the “Inspect” menu.

Good opportunity also to check the pin orientation with the datasheet. Is the positive
pin actually the left one?

*Once you’re confirmed, save it

47
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Footprint Library

Re-name it if you’d like (the
default <MFG>_<PartNo>is
pretty effective, though).

Then locate (via filter) and click
onthelibrary to save to, hit
“Save”, and close the editor.
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Manual Footprint Assignment

" " ~ . A REG XLS S "B N

| Back in the schematic
window, we can how manually
assign the footprintlike we
did with the LEDs.

-

4

: __ | Open the battery symbol’s
y |- e = | properties.

Remember, that’s right-click
> “Properties”, or left-click
and “E”.




RASPACE

anersl Anatrets I Aligrenens

Go into the footprint browser.

Locate the footprint we just
imported (on the left), and
double-click it to select it.

LD L)

Smuaron Mo

From Linray.
ol
e
ToE Ssyminol
[ Lance!
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Manual Footprint Assignment

fpmbol Sogernm

Gamersd | Anatrass P Asigrimens
i

Name

Vake

Folerence 4TV

Vaue Rattery Lol

oot ESST

Durtairent

Shom Srow Name HA

Gerers

Great! Click OK.
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RASPACE

We probably should have
tackled this earlied, but parts
can also have values.

This is especially relevant for
Rs, Cs, Ls, and LEDs of different
colors.

.
—

To give a part a value, click a
part and hit the “V” key (or go
through the part’s “Properties”
window like we just did).

il
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I’ve giving the resistor
a value of 30 for 30
ohms.

Historically, no units
are provided. Dunno
why, maybe it’s just
because it’s obvious?

Repeat this for the L (22u) and
the caps (1u input, 4.7u output).

ahdy
»
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BHaCmn

—

» 8 Great!

| also gave the battery
a value of “3V_2032”.

Hopefully this will
make the schematic
easier toread and
understand.

Y

54



End of Part 4D

And that ends part 4D of our video series on KiCAD, in which | covered assigning

footprints, footprint libraries, importing pre-designed modles, and adding part values.

A PDF of this video is available as well, linked in the
description and hosted on The Hive’s Wiki.
In the next segment, part 4E, we’ll wrap up the schematic drawing portion of the

series with a discussion of ERC and some miscellaneous schematic tools you might
want to be vaguely aware of. See you there.
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KiCAD

Part 4E: Schematic - ERC

Ben Hurwitz, Spring 2024

Hi, and welcome to part 4E of The Hive’s PCB Design With KiCAD series. My name is
Ben, and I’'m your host today. Part 4 as a whole has been covering the entirety of the
schematic creation, and we’ll wrap this portion up with a discussion of the ERC,
understanding and dealing with warnings and errors, and some miscellaneous
schematic tools you might be interested in being vaguely aware of. Let’s get into it.



7

Circuit Reminder

ASPAD

k|

4y M
L D
LX
* VN LED

¢ —20 L EN Driver

SPST-NO —1aND

(:“"\'
e [T, -

—

Before we get into KiCAD, just a reminder of the flashlight circuit we’re developing.
Note that this image was not take from KiCAD, and therefore the symbols and

graphics are different from those you are about to see.




Hi ERC

HOKERSPACE

Omg everyone, we’re almost
finished with the schematic!

Thelast thing is the ERC, or the
electrical rules check.

This basically verifies the
electrical connections within
the schematic.

“Inspect” > “Electrical Rules
Checker?, or click thisicon.




Hi ERC

HOKERSPACE

| Erectricat Rules Checkes X

|
Viclations (0) | Ignored Tests (1)

The ERC checks your
schematic against a whole
bunch of rules.

The defaults are usually okay,
so just click “Run ERC?”.

The rules can be customized
through the schematic under
“File” > “Schematic Setup” >
“Electrical Rules”.

Show: [T] As Meros @  [“Wemings @ [ Exclusions Save

Delete Marker Dedete All Markers Run ERC Cloge

The ERC should, ideally, have been run a few times throughout the schematic design
process because it can be lengthy and iterative, so it’s valuable to see if you’ve made
errors early before they pile up and start building on each other.




Hi ERC

HOKERSPACE

i Electrical Rules Chacker
‘ Oh no! Two errors??
|

Viclations (2) Ignored Tests (1)
v Error: Input Power pin not driven by any Output Power pins
Symbaod Ut Pin 2 [GND, Power input, Line]
v Error: Input Power pin not driven by any Output Power pins

Symbol U1 Pin § [VIN, Power inpat, Lime]

Clicking on them will highlight them in the schematic,
which will give you insight into what this might mean.

Show: "] As HErrors @  [“Wamings @ [ Exclusions Save.

Delete Marker Delete All Markers

e




.| The markers are
these arrows. The
*| pink one is the

But what do they mean?? r

| highlighted one.

= A 5

Y
!4

B
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i : _ So they’re pointing at pins, and say that
| Bectricat Rules Checker the the input power pins aren’t driven by
output power pins.

| Viclations (2) Ignored Tests (1)

v Error: Input Power pin not driven by any Output Power pins
Symbaod U1 Pin 2 [GND, Power input, Line]

v Error: Input Power pin not driven by any Output Power pins

Symbol U1 Pin & [VIN, Power inpat, Lime]

Frankly, like alot of PCB CAD errors, this is pretty inscrutable
until you have some experience with it and with the jargon.
Google and the forums can be helpful here.

Show: [ | A HErrors @  [“Wamings @ [ Exclusions Save.

Delete Marker Deiete All Markers Run ERC Cloge




Hi ERC

HOKERSPACE

What this is saying is that thereis a
mismatch in pin types.

| Electrical Rules Checker

I Viclations (2) Ignored Tests (1)

v Error: Input Power pin not driven by any Output Power pins
Symbaol U1 Pin 2 [GND, Power input, Line)
v Error: Input Power pin not driven by any Output Power pins

Symbol U1 Pin & [VIN, Power inpat, Lime]

Remember way back when we were making the symbol for the
LED driver IC in video 4B? When we were creating the pins?

Show: [ A HErrors @  [“Wamings @ [ Exclusions Save.

Delete Marker Deiete All Markers Run ERC Cloge
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If you’re not sure
what itis, you can
either setitto
“Bidirectional” or
“Unspecified” or
“Passive”.

The type won’t
cause the design
to fail, but it might
cause you
headaches later
with the ERC.

(For those who don't remember)

Common to il body gtytes (De Morgan

Remember
this
warning?

And this
explanation?

Technically, each pin
type is “allowed”
connected to only a
subset of other pin-
types; otherwise, the

ERC will throw an error.

| ox TAE

*Remember this warning?
*And this explanation? This probably didn’t make any sense back then, but this is
exactly what we’re seeing.




Hi ERC

MiikERSRECE So | set the GND and VIN pins of the
' i IC to “Power input” types because,
EBectricat Rules Checkes well, they take in power, right?

| Viclations (2) lgnored Tests (1)
v Error: Input Power pin not driven by any Output Power pins
Symbod U1 Pin 2 [GND, Power input, Line]

v Error: Input Power pin not driven by any Output Power pins

Symbol U1 Pin & [VIN, Power input, Line]

Unfortunately, the battery symbol’s _J: BT4
pins are actually set to “Passive”. Battery Ce
Which is not an allowable pin type to T
connect with a “Power input”.
She [Exct
d Oops.

How would you have known this? You wouldn’t, necessarily, and | certainly didn’t, but
the error suggests that whatever is on the other side of the problematic VIN and GND
pins (which is what the markers point at) is not correct. So | went and looked at the
battery symbol and at it’s pin types to discover this mismatch.
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Hi ERC

| Okay, so what do we do?

| Blectrical Rules Checker

| Viclations (2) Ignored Tests (1)

“

We could choose to do nothing because the it’s not
actually a functionality issue. We know that the battery is
¥ providing power, and that the IC is taking that in, so
there’s no actual issue. This error is more of a warning.

But we’re going to fix it because it’s easy to do by
changing the projectbattery symbol’s pin types.

Start by closing the ERC window.

Show: | |A [(AErrors @ (] Wamings (0] || Exclusions Save

Delete Marker Deiete All Markers Close

By “project” here, | mean that we’re just editing the project’s version of the footprint,
not the global part model. Therefore, we’re not interfering with any other battery
symbols in other schematics, though it will update other batteries within this
schematic.
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BATT 1P i >
— o
P —— v ~ y
et Right-click on the

+

T Gusi e s | battery and go to “Edit
with Symbol Editor”.

an




You can see the
informational banner at

the top reminding us that : Move the package name
this is a project-only edit. (in light grey) out of the
t+ @11 | way (click-and-drag),
:i.': 541124 @nd then edit the pins

(click-and-"E”).

They should be set to
“Power output”.




‘ Great. Save it, and exit.

Not necessary to




MNarher Baw Narve Alveviaie Accganest Peciresl Type Gaaphec Style

You can check that it
updated by going to the
symbol’s properties within
the schematic, and look
under the “Alternate Pin
Assignments” tab at the top.

Jo Sanranan Shooe X Cavens




HI ERC

HOKERSPACE

»

" » ™~

Now re-run the ERC.

You might still notice
the markers. You can
manually delete them
(click and “Delete”), or
do so from within the
ERC window in the
lower-left.

sBATT ¢
.

1l

i

-».\“ 'I.“ ~\.“

E<20
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| Elecincal Rules Checker

\
Violatons (1) Ignored Tests (1

v Warning: Symbol ‘Battery Coll has been modified in library ‘switchodLED vO

Symbol 811 [Satsery Cell]

Hilarious - now it’s
warning us that the
battery symbolis
modified.

Which we know.

Delete the markers and

But no more errors!

close out.

[l wamings 1 "] &xciusions Save..

Delete Macker Dedete AN Markers
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Congrats! We now have a PABEGETeAaTs RN
completed schematic.

The last part of this video will
just be a few miscellaneous
things that you can doin the
schematic, but do not haveto
do; just options to be aware of.

il




If your parts all have
simulation models, you can
run simulations directly
through KiCAD with this
button.

I’ve never actually done this

though.
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Final schematic and misc.
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If for whatever reason not all
of your parts are annotated

. (i.e. their names are, like, R?
o[ or C? instead of R3 or C2), or
you don’tlike the number
order, or whatever reason,
you can re-annotate your
schematics with this button.

20
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Final schematic and misc.

BHaCmn

[Sp—

il

This button will generate |,

a basic bill of materials

| automatically!

It’s not great, butit’sa
start.

21
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. : e ‘| Finally, a very

useful button, this

A 7 will switch you to
; the layout view.




End of Part 4E

And with that, we’ve completed part 4E, in which we covered ERC and some
additional miscellany. A PDF of this video is available as well, linked in the description
and hosted on The Hive’s Wiki.

This also brings us to the end of the schematic capture portion of the design.
Congratulations!

In the next video in our PCB Design with KiCAD series, part 5A, we’ll move over the
the layout, known in KiCAD as the PCB view, and begin with setting up some defaults
and the design rules.
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Part 5A: Layout - Board Setup

Ben Hurwitz, Spring 2024

Hi all, welcome to The Hive’s series on PCB Design with KiCAD. My name is Ben
Hurwitz, and in this series, we’ve been walking through the PCB design process using
KiCAD as our electronics design software.

In the last video, part 4E, we finished off the schematic capture with a look at the
ERC, or the electrical rules check, and a few bits of schematic miscellany.

In these next few videos, we’ll shift focus to the layout portion of the design process,
which KiCAD calls the PCB view, in which we’ll actually physically align and orient the
actual components on the board and connect them with traces.

This section, part 5A, will introduce the board editor and look at setting up the
board’s defaults and design rules. Let’s get started.
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If you’re just opening KiCAD for this video, go ahead and *load the project via the
“File” menu, and open the PCB editor by ether *double clicking on the layout file with
extension .kicad_pcb, or by *clicking on the PCB editor icon on the right, which will
open the current project’s board view by default.
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If you’re coming from the previous video, part 4E, or you have the schematic editor
up for whatever reason, you can also use the icon highlighted here to open the PCB
view.
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A bunch of other
display related
things, including:

Zone filling
Outline modes




Routing and
zone tools




Layout
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Layer and object
selection and
viewing




You might notice
the title block

here again.
| hate the title block

here, so | always
hide it.

Go to the objects
panel and click the
“eye”icon next
“Drawing Sheet” (at
the bottom).

Similar to the Schematic editor, removing the title block requires making a new
drawing sheet, which is beyond the scope of this tutorial.
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Next, | want to
. . set the unitsand
‘1 Milunits grid.

Grid
spacing

Personally, | prefer a 50
mil grid to start.

You can always change it
later as needed.

Unlike the schematic in which the grid is really important to KiCAD’s functionality, the
grid is highly flexible in the layout editor, and can (and often will) be changed
frequently.




Openthe
“Board Setup”
either via this
icon or “File” >

“Board Setup”.

Okay, next we’re
goingto go
adjust/look at
some design rules
and settings.
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The “Board setup”
window offers you
many settings to
adjust for your
design.

There is a similar
window for the
schematic, but it’s
much more
importantto
understand some
of these settingsin
the layout view.

H Layout - Board Setup

e
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OF-00Md Manlactrg
O com, Wnting
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Asd Liver Detianc Lvywr
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The first section
allows you to select
the layers available

to your design.

You can Yot Varati
select/deselect yabvad
these as you see hit Pre-defined Sice:
in your design. -

I believe they will 7 [37ue
not be used at all if L/chuive On-tarare re
they’re deselected, By SHSRRRA

versus just not e == )
being visible.

This can be useful if it’s important that you don’t put silkscreen or copper on the
backside of the board, for example. By removing them from the layers entirely, you
minimize changes of error. You can also add user-defined layers here if you want or

need, perhaps for a custom assembly process, required by your fab house, or for
specific additional information.
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“Physical stackup”
refers to the the

physical (rather Ly ' Mater tones ) Lom T
than digital) layers g oiise B ot o
of the boards. v I D . ot [
This is where you % — e ye | W g =]1e8
would set your . s o
board to be 4 : - LA
layers, or 8 or e

whatever, using the
“Copper layers”
drop down.

ezt tcksem hom swacksgs | BLTAT2A0E miv  Adint Dedectec TOnes Expoa 03 Chpacond

PIOO SEttags o Another 20000 %

You can do some really advanced setup in here, though I’'m honestly not sure how
much of it is used in other parts of the software versus just being for your (and you
boss’s) knowledge.

The units in this pane and in all other panes are derived from the units specified in
the main layout editor window. KiCAD is a metric-based design tool, which is why the
values are so wonky in mils.

15



THE.

HOKERSPACE
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Here you can set
some defaults for
text and graphics.

The defaults are
normally okay, but
it can be hard to
gauge what size
you need.

Good rule of thumb
isthat height =
width =
6*thickness.

It can be a useful exercise to make a dummy layout only with text on it at various
height/width and thickness ratios for your reference. If you print that board (CTRL + P,
or “File” > “Print”), it can be handy to keep nearby for scale.
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HIVE Layout - Board Setup

The “Constraints”
pane is where all
our design rules go
thingslike
minimum spacings
and sizes.

1

These are defined
by your chosen

o oy g
. X - Ia0uchs ThChipt vl I 1B Mgt LCCalat o
fabrication house gecaiead 1
(i.e. where you’re PSS AR | o oet
getting the board ¢ Urietpnpiain’ (| Neions
made). Read their
instructions PR M- T
closely. | =

Wt Setiags bom Another 300

o Lot

Many fab houses have software-specific instructions these days. Read them carefully!

This is an easy way to make your design un-fabricatable, and require re-doing the
layout.
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I’'m not going to
adjust any of this
now because I’'m
not getting this
fabbed, but do not
forget to set this.

If you setitat the
end, that’s okay,
but be prepared for
a bunch of DRC
errors and
potentially
significant re-
design.

Ninimaem ceerence

MARATIATY IO AT

Manrreen arvudar wamn

i miem wa saeveter

Copmeric hole chestenoe

MY XEE %]

Copoer 10 008 Ceamuox

Naneraem rheugh veie

X

Pt Lo bebe deararce.

v
D A TV —

YO0 Settgs bam Another 200

Layout - Board Setup

Miaimum connection widtts | 3

T ETAITY AR

i

ArUcrcle asoruemated by segrests

W e it Ot | (L Y98E50500 reen

Pade 3eme Vg e by thom e o 011 SSI0EIIIT elh

Lrzw 1) eranngy

L AR Ahets outioe 2one Outhne
@ M eyl rebef Jpoke count | 2 o
Loyt ey

7 hauche Shachigt gl I 11BCK Heagth LaCCababn

Lot
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You can adjust the
severity of the DRC
rules (warning,
error, orignore)
under the
“Violation Severity”
tab.

Don’t do this unless
you’re confident of
the result, or you
may end up with a
bad board.

rrg
Tt Vanaties

ol Severny

T INeeog Twd sets
Tricks Criniengg

Ouatarce velaron

VW4 13 8t connecied te connectid 0n vy Sne beyer
Trawh Nk e osreried anct

Phartnal 1edaf Correction S some incormprte

Design for Masutacturing
S04 008 Ceetence volation
e Sestarse wilalae
Driled Scben 00 tiow oriver
Tk weatts
Aerile man
Dt 1nat il rerge
Moo »a ot ast el rege
Courtpanty Swnrias

fottznrt has f0 Lourtyard Svfisedt

IVE Layout - Board Setup

Hrow
Vs
Konoe
Vroe
Kyrare

Virua

kros
[P
rue
o
O igras
[P
byrorw
Igruw
® ow
) igrom

L2

Lot
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Layout - Board Setup

In “Pre-defined
Sizes”, we can set
some pre-defined

sizes for traces and
holes.

MTereriial fars

W ) s =" Widte

This will make your
lives easier later by
allowing hot-
changing of sizes.

+ 3% = % » + ¥ 8

WIOO Sertgs o Another 2000

Y Qe
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Use the “+” button

to add: .
Track widths of sowarnn -
10 mil, 12 mil, 16 lzlan : =
mil, and 25 mil. —
Via diam/holes Teox Vet
of 32/16 miland :
80/40 mil

The parameter “diameter” for holes and vias refers to both the drill hole diameter
itself plus the annular ring. It’s generally a good starting point to have the ring
diameter to be twice the hole diameter, and larger can make soldering easier.

These default values are not required by anything.

| like to keep my traces above the minimum allowable if possible, which is normally
around 6 mils, to reduce the possibility of broken or damaged minimum-width traces
that are more likely to have issues. For signals, | try to use 12 mils generally and neck-
down, meaning shrink briefly, to 10 mils. Power traces should have the largest
reasonable width possible. 25 mils is a good balance, and according to the trace-
width calculator at Advanced Circuits, can be used to pass 1A on external 0.5 oz
copper with just a 10 degree Celsius rise in temperature. 16 mils is a good necking
size for brief lengths over which 25 mils can’t fit.

For the vias, the 16 mil diameter hole for vias is a classic default, and is good for small
currents and signals. The 40 mil hole is about 1mm, and will fit a standard pin header
if you need a via but do not have electroplating. It’s also good for a lot more current.
Not necessary typically, since you can use multiple small vias instead of one large

21
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You can group nets
togetherinto
netclassesto give
them all the same
default settings.

Marte Cles e Track \Walt

This is very useful if
you want all your
power traces to be Gorcn ey

wide, or some ST Mesctass amgunen
traces to be very
narrow.

YO0 Settegs Yo Ancther 2004
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Let’s define a BRI )
“Power” netclass, R e s
and adjust “Default™ Boor

Parameter Power Default [

Clearence 16 8

Track Width 25 12 .

Via Size 80 32 & in ——
ViaHole 40 16 feeen G

Mete NI

“Clearance” defines the space from other
copper to the net. Like trace widths, the
minimum allowable setting increasesthe
chance of a failed board, so better to be a
bitlarger.

*Clearance... blah blah blah....
For The Hive’s tool, because we don’t offer a protective soldermask layer, it’s
important that this clearance is set quite large, 30-50 mils, to reduce the chances of

accidentally jumping traces or a plane when soldering.

The uVia, or microvias, are extra-tiny vias that are typically used with BGA-style

components with high-density ball-style pads underneath the package. These will add

to your board cost, and are usually not needed unless you really can’t find an
alternative package.

DP stands for differential pairs, which are used when impedance matching is
important, like for USB data or antennas.
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Layout - Board Setup

Assign your power
net (the one out of
your battery) and
the ground net to
the “Power” class.

Must be one
pattern per
assignmentline.

ALT+Tabinto the
schematic to
double-check the
names.

Wildcards * (any
number of chars) and
? (one char) and
regular expressions

Patterns will only
match to explicitly
named nets, so * will

only match all named [

Netclass
assignments
are listed in

priority order,

are valid. nets. top down.
.
2anens Poee Class Nets matching +BATT
T T—
Click OK when
- 4 — you’re done.

YO ST g om Anoter Boand.

Netclass assignments can actually also be defined in the schematic by right-clicking a

node or net.
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End of Part 5A

And that ends part 5A of the KiCAD design tutorial series in which we introduced the
layout editor and a number of pre-layout board setup settings. A PDF of this video is
available as well, linked in the description and hosted on The Hive’s Wiki.

In the next video, part 5B, we’ll go through placement of the components and
routing. See you then.
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KiCAD

Part 5B: Layout Placement and Routing

Ben Hurwitz, Spring 2024

Hi all, welcome to The Hive’s series on PCB Design with KiCAD. My name is Ben, and
in this series, we’ve been walking through the PCB design process using KiCAD as our
electronics design software. Part 5, where we are, is focused on the layout portion of
the design process.

In the last video, part 5A, we introduced the layout editor, also called the PCB editor,
and how to setup your design constraints and sizings.

In part 5B, | will take you through the basics of placing your compoentns, called
placement, and connecting them together, called routing. This video will primarily be
focused on showing you the gist and then having you do most of these processes, so
definitely follow along and pause to do the work.

Let’s get started.



Now that the
setupis done, we
can lay everything

out.

But where are all
the components?

We need to update
this view from the
schematic.

Press “F8” or this icon.

|
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It’ll take a second, but you’ll get
this window.

It will list the changes
to be applied, which
you can read through.

Click “Update PCB” to
bring the footprints
into the layout view.

Update FCE from Schematc x

Options

[C]Re-link footpeints to schematic syentols based on ther feference designators
[] Detete footprints with no symboks

[ Reotsce foctorints with those specified in the schematic

Changes To Be Applied

Asd 05 (Tootprint “switched LED_v LED_DS Dmen') a
Add L1 (footprint ‘Inductor_SMD L _1008_2520Matric_Padt 43x2 20mm_HandSoldes’)
Add R1 (footprnt ‘Resistor_SMD R _17 3216Metnc_Pad1 30t 75mm_HandSaokdar’)
Agd SW1 (footprint ‘Bution_Settch_THT SW_PUSH_Gmm'’)

Add U1 (footprint ‘Packaga_TO_SOT_SMD TSOT-23-6_HandSoldarng’)

Total warnings 0, seroes O

< x

1
show: {an Hemos @ Flwamings @ [Hacions A meos Save

Upttate PCB Chxe
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Well phooey. We got some
warning and errors.

What are they?

The warnings say that the
battery symbol (BT1) has
no nets connected to its

pins Pand N.

The errors say that the BT1
footprint does not have a
padlorapad?2.

Like the ERC errors, errors
and warnings in KiCAD can
Optrans be a bit jargon-heavy. Let’s
!TF; link footprints 1o schematic syenbols i read these ca refu"y.

Upcate FLS from Sohenatc

Detete footprints with no symboik

tepiace footorints with those specified in the schematic

Changes Appiied 0 PCD
Connocled U1 pin 6 1o +8ATT
Wammng. No nel found for symbat BT1 pin P
Waming No nel found for symbal BT1 pin N
Erroe. BT1 pad 1 not found in switchedLED vOMPO_BC2032-E2
Erroe. BT1 pad 2 not found in swichedLED vO.MPD_BC2032-E2

Total warnings. 2, efrors. 2

show: ] an Flemos @ Flwamings 2 [Hacions A meas Save.
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3 BT1

When you assign a footprint to _; B a tt e ry_C e l l
™N

a symbol, KiCAD attempts to |
match the symbol pins to the
footprint’s pads.

In this case, the symbol, which

we got from the global built-in

library, has pins 1and 2, which

KiCAD attempted to match to

the footprint’s pads, which are
names Pand N.

Let’s take a quick look at the
warnings and errors again.
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Afterlinking pins 1and 2 with
pads P and N, KiCAD was
looking in the schematic’s
battery symbol for two pins
called P and N because that’s
what the footprint says they
should be called.

Obviously, it didn’t find them,
and thus there are no nets
associated with those pin

(because those pins don’t exist).

That’s the warning - no nets.

Upcate LS from Schenatc

Options
!‘: Relink footprinty 10 schematic syenbols Based an thesr reference designaton
[] Detete footprints with na symbok

Yeptace foctorints with those specified i the schematic

Changes Applied 50 PCB

Connocled U1 pin 6 1o +8ATT

Wammng. No nel found for symbat BT1 pin P

Waming No nel found for symbal BT1 pin N

Erroe. BT1 pad 1 not found in switchedLED vOMPO_BC2032-E2
Erroe. BT1 pad 2 not found in swichedLED vO.MPD_BC2032-E2

Total wamings. 2, efroes: 2

show: { A Flemos @ Flwamings 2 [Hacions 4 meas
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Similarly, KiCAD went looking
for pads 1and 2 in the footprint
because the symbol said those

should exist.

Of course, the pads are actually
called Pand N, so pads Tand 2
weren’t found in the footprint.

Hence, the errors - no pads.

| Upciate BCS from Schematc

Optians

(] Re-link foatprints to schematic syenbols based an ther reference designatarns
[] Detete tootprints with no symbois

[ Reptace toctorints with those specified i the schematic

Changes Appied %o PCB
Connocled U1 pin 8 1o vBATT
Wammng. No nel found for symbol BT1 pin P
Waming No nel found for symbal BT1 pin N
Erroe. BT1 pad 1 not found in switchedLED vOMPD_BC2032-E2
Erroe. BT1 ped 2 not found in swichedLED vO.MPD_BC2032-E2

Total wamings. 2, efrors 2

_——
show (Jan  [Flemonx @ [Flwamings 2 [Hacons  [Fmees

Ui FCH

b=
L. &
Save.
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1 This can be avoid in the
! I—a y ou t future by downloading the
symbol along with the
footprint, and then using
the specific symbolinstead.
Then they’ll be designed to

match.

NEEASPACE

| +
[+
o O
p— |

ns

1

2

Recall that | brought this |
concern up waaaaaay back

when | said that KiCAD not
having devices improved
flexibility, but meant you have
to be careful about pins.

This is easily resolved in the
layout, so just click “Close”
for now and drop the
footprints wherever you’d
like with a left-click.

And now we know - symbol
pin numbers must match
footprint pad numbers.
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To resolve the pin/pad
mixup, we need to know
what the symbol pins are

named.

We know from the last
slide, but let’s pretend
we don’t.

00 00 00 B0

Head back to the
o O i schematic and edit the

<t gt battery symbol (Select it,
@ then CTRL+E).
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Layout

Go to “File” >
“Symbol Properties”
and check “Show pin
number”. Click “OK”.

KiCAD matches pin
numbers, not names.
Names are only for
people.

10



Okay, great, now we know
that the positive terminal
is pin 1and the negative
terminalis pin 2.

Close this (saving is a
goodidea) and go back to
the layout editor.

Note the symbolin the
schematic will update
automatically if you saved.
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Open the properties of the
“P” pad.

(Right-click > Properties, or
select the pad and hit “E”.)

Make sure you’re just
selecting the pad alone, not
the part or something else.




)

Re-number this terminal to
“1” rather than “P”.

Click OK.

If you notice “Net name” is
“<no net>” and are worried,

| don’t be - we’ll force that to

update in a second here.
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Repeat this for pad N
(rename to pad 2).

Then press F8 to
update the schematic-
layout link again.

g0 00 D0 00

o ©°
0 0 - o
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What’s
“ratsnested”?

The ratsnestisan
importantterm
that refers to all
the connections

that still need to

Tada! be made.

. , .
No warnings or errors. It’s all those thin

white lines called
airwires -those
are what need to

We know things are working because
the battery pads are now ratsnested.

_| still be connected.

15
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Now comes the first
half of the fun:

placement. Good placement will make

routing your traces much

ﬂ (much) easier.

Bad placement may make
routing impossible.

Placement refers to,
well, the actually
placement of all the
components.

An old saying is that PCB

0 IO DO IO L
o design is 90% placement and

W o ‘o £ i 10% routing.
0 —0 == ; ‘
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Layout - Shortcuts

» Go ahead and try placing the components now.

Move by click-and-drag or select-and-“M”

Rotate with “R”

Flip to the other side of the board with “F”.

If your component turns red, it means it’s illegally positioned
Hold CTRL to get ultra-fine positioning grid

* It may be helpfulto hide the fab layers
» It’s alot of distracting text.
* Thelittle “eye” icons on the right under “Layers”

* Next slide has a few more pointers...

17
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RASPACE

» One thing you may notice is why the net names are so useful. What is
“Net-(D1-A)” anyway?

+ IC datasheets often have layout recommendations. These can be very
helpful because they’re known working arrangements!

* Again, two screens is helpful here.
* Watch the ratsnest as you move parts around.

+ Conceptualize how to circuit flows together and cluster related
componens.

» Good placement takes time! No need to rush.

* Your layout will very likely not look anything like your schematic, and
that’s okay.
* Remember: the schematic is for people, and the layout is for electrons

18



The inductor should be placed as close as
possible to the switch pin to minimize the
noise coupling into other circuits.

The Cout should be connected
directly from the output schottky
diode 1o ground rather than

L LX node copper area should be minimized
HM!‘HE for reducing EMI. across the WLEDs
GND 000
600 ufe ¢
000 oUT
o T
Vin 1 - P
Ci should be placed =
as close as possible _L X 1 6 uj VIN ”-
to VIN pin for good —’o Cin s
fittering 8 eno[]2 5[] vour ’
2-2n s
=2 +¥ WLEDs
Bz 4 D EN =
¥
¥

To save you the trouble
of finding the
datasheet, here is the

recommended layout & | o e
node copper area shou
for the RT4526. minimized and keep far away o

from noise sources (LX pin) and
RS should be as close as
possible to FB pin

| suggest that you paused the video here and take some time to arrange your
components. As | mentioned already, placement is most of the work. With good
placement comes easy routing. Arranging the IC based on the datasheet’s suggestion
here is good practice, if possible.
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This is MY layout.

It may not be YOUR layout.

And that’s okay.

There are many ways to
layout a board.

For simple boards, as long
as all the connections are
made, the rest probably
doesn’t matter.

20
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Next is defining the board
outline.

If thisis a primary design

constraint, this should be

done first. But it’s not, so
we’ll do it now.

On theright, select the
“Edge-Cuts”layer. Then
use the drawing tools to
make an outline for your
board.

TR LI o
0040 0 50 U 1) @0 0

21
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| made a box.

You can be fancy if
you want, with circles
and rounded corners

or weird polygons,

but a box is totally
acceptable.

w8 snasosennecn | @
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Next we want to ; sall RaiBRme "
define any large
planes (or polygons
or pours).

These are copper
areas that are
completely filled
(flooded), and can be
connected to a net.

w8 snasosennecn | @
0040 0 G0 U B 1) ) O

Used widely for
ground planes or
power planes.

It’s safe to think of planes as arbitrarily-shaped traces. Larger traces have lower
impedance, so full-board planes have the lowest possible impedance of any possible
trace.

23
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We’re going to make a ground

plane. These should cover a full

layer of your board to minimize
impedance.

We’ll use the bottom layer, so
select the bottom copperlayer
(B.Cu) on the right.

Then click the “Add Filled
Zone” icon (or CTRL+Shift+2),
and click the top-left corner of
your board outline (in yellow).

TIILLIIITLE
)OS 1) a8 D

Fun fact: if you’ve selected a
non-copper layer, the polygon
tool will still work, but it will
just fill on the selected layer.

24
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The “Copper Zone Properties”
window defines our zone.

Make sure the layer is right (B.Cu),
and set the netto GND (it’s a
ground plane).

“Zone priority” (left) will define the
interactions between multiple
overlapping zones.

“Clearance” (center) is critical if
you’re not getting soldermask, like
if you fab this at The Hive.

Click OK when you’re done,
and then draw the rest ofthe
zone around the board outline.

25
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Excellent.

Press “B” to fill the zone and
re-draw the ratsnest.

¥
e sssscemuin |
HEHIE0SHaH00, :
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Great!

None of the ratsnest
disappeared though.

That’s because the
ground pads aren’t
actually touching the
plane yet because they’re
onthe top side of the
board, whereas the piane
is on the bottom side.

It’s also because | made a mistake when generating the zone and set it to “no net”
rather than “GND”, so the GND pin on the battery should be connected but isn’t.

27



Select the top copper
layer (F.Cu) because
that’s where we want
LayOUt to run our traces
since the surface
mounted devices are
onthetop

THE.

HOKERSPACE

No worries. Next we’re
going to start routing.

Start by clicking this
button here to unfill the
zone. Makes it easier to

e ssescepene |
0 00 S 1) 04 068

Then press this :
button (or tap “X”) to
enter routing mode.

”

Hitting “X” will start a route where you mouse is on the canvas. Hitting the “route
icon will allow you to left-click somewhere to start the route.

28
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I’m going to start with the
LEDs because they’re the
simplest.

Just click (don’t hold) a
pad to start the route,
then drag your mouse to
the end of the route, and
click again to end it.

You don’t need to follow
the ratsnest exactly. That
just shows what needs
connecting, not always
howto connect it.

¥
“e sssscepene |
HEb DS 000N
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One route done!

Try to route the other
LEDs together.




As an aside,
technically the
LEDs are running
power through
them, so they
should probably
bein the “Power”
netclass. But it’s
not critical; TOmA

is very little. |

31



Now let’s connect a GND
terminal with a via.

Pick one of the capacitors;
bypass caps always want a
direct via to a ground plane,
if possible, because it’s the
shortest distance.

C

Start the route at the GND
terminal, then hit “V” to
c make a via, and then
double-click (or hit “Esc”)
to place the via and end the
trace.

Not necessary to

32
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* So now it’s you’re turn to complete the
layout.

* Hopefully it’s not too much like
drawing a horse, but the following
slides have a few tips.

* Plan to start with the IC, since that
arrangement is the most specific.

How TO:
DRAW A HORSE

34



The inductor should be placed as close as
possible to the switch pin to minimize the
noise coupling into other circuits.

L LX node copper area should be minimized

The Cout should be connected
directly from the output schottky
diode 1o ground rather than

across the WLEDs
HOEERSPACE ’0( 'Oduclng E"‘I
You don’t need multiple
. cCo00O
vias here because our 6000
designisn’t that precise. D -
Vin Y Notice that
C)\ should be ptaced a=f\"L¥=e VOUT’s trace is
as close as possible 2= Xp s via-connected
to VIN pin for good —* ==Cin underneath VIN.
fitering g oNp[ ] 2 ’
Try routing the IC to Rset : WLEDs
match the suggested FBE]] 3 4 EN P
layout from the P
datasheet. I
Note the square traces | wppler T
. . node L . .
are just an affectation. minimized and keep far away (' keep this imageip
Just make the same from noise sources (LX pin) and later too)
connections. RS should be as close as
possible to FB pin

35



If you runinto this error
(about routing starts or |-
ends violating DRC), it |
likely means that your

trade width is too wide. |

Confirmed with the
green highlights says
where the DRC is
violated.
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The trace width is set to the netclass
default right now.

Pressing “Q” brings
up a small window to

&

Adjust it to the next-smallest (16 mil)
with “W?” (or Shift + W) and try again.

Don’t forget to
change it back to
“netclass” after!

set sizing directly.

Repeat until the trace works.

You can always adjust a trace’s width
later through it’s properties panel.
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! F O rr e f e r e N C e Press “/” to flip the trace’s bend angle.

“D” will drag a trace (better than “M?)

lgND 1 000
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Okay, pause the video here and try to route the IC and its associated components,
shown in my layout on the left, like the recommended layout on the right.




Not the prettiest routing job
ever, butit’ll probably work.

_Ll 000

L
6 [[]VIN

5[] vout 8
4[] enN

Part of the issue with matching the recommended layout is that our parts are much
larger than the layout expectation, so they don’t quite fit where the layout expects

them.
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If you haven’t routed the
switch (or anything else),
now’s the time.

-
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Holy moly. We’re close to the

end of the
tutorial, but if you
were designing
this, it might be a
bitlonger before
it was really
finished due to
iterations and
DRC checking.

What a process.
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One additional thing would =
be to add silkscreen where
necessary or desired.

Things like orientation info,
usage info, sizings, pin
functions, and more.

42



A small finishing step:
The designer’s signature

Add your name and the
project name in silkscreen
to identify the board.

Click the text icon (or
CTRL+Shift+T).
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iIvEe Layout

Select the layer (typically
silkscreen).

Adjust the font and size if
you’d like.

Text Propernes

Text

Ben Burwitz, 2024
switchedl®D w0
[Jiecked

Layer: B FSikscreen

Fone KiCad Font
Width 3937007874

Height: 39.37007874

“Knockout” means
that the text polygons
are subtractedfrom a
rectangle on the layer.

- oo
B/ |[= » q

Thickness:| 5905511811

Mirror the text ifit’s s mess
goingtobeonthe | [its
backside of the board. "
oK Cancel
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End of Part 5B

And with that, we end part 5B of our PCB design with KiCAD series with a nearly
completed layout! All that’s left is to check the mechanical dimensions of the various
components, the DRC, and plot the gerbers. We'll talk about all that and more in part
5C. A PDF of this video is available as well, linked in the description and hosted on
The Hive’s Wiki.

See you there.
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Part 5C: Layout Finalization

Ben Hurwitz, Spring 2024

Hi all, welcome to The Hive’s series on PCB Design with KiCAD. My name is Ben, and
in this series, we’ve been walking through the PCB design process using KiCAD as our
electronics design software.

Part 5 has been focused on the layout portion of the design.

In the last video, part 5B, we placed all the components and routed them together
into a single cohesive layout.

In part 5C, we’ll finish up the design process by confirming the board visually and
through DRC, and then plotting our gerber files for fabrication and assembly.

Let’s get started.
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My final layout looks like this. Yours may well look different, and that’s okay. As long

as everything is connected and there are no more air wires, those thin white ratsnest
lines, then we can continue.

If you still have air wires in your design, pause the video here and finish routing first.



MOk

Okay, before
running our first
DRC check, we
should check the
physical placement
of everything.

There are two
separate and

AR ARERIERERS
sBUSNaBLANASND

do this: 2D printand
a 3D view.

The 2D printed copy will give you a 1:1 view of the
size, and whether the footprints are right (you
should literally place the parts onto the page)

The 3D view is more holistic, and makes sure that,
like, the button can be pressed.
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RASPACE

Printing a 2D copy is easy.

“File” > “Print”

Usually the default set of layers is

good for mechanical scale.

Leave the drill marks as “Real drill”

or the size will be wrong.

And keep the scale to 1:1.

Do a print preview first!

Print a copy/3D view

noude Lypen Ocson
Dutpat mode: Hlace asd while
Provt drawing sheet

P according 30 alyech tab

Fghd <ich for bawer swwetaas commurh

Prgwe Swtigs Peent

of ACpONtarEN AN

Clne

Pard Dewiew |
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Print a copy/3D view

HOKERSPACE

Here’s the preview.

The routing isn’t relevant
because what we’relooking at is
the physical size and shape of

the board and parts. - : g:#«'?}“i'

| "F DD
Physically place components on i\ e
the board to confirm footprints. . S i

Very helpful to avoid
accidentally using the wrong
footprint or a super tiny
package.




The 3D viewer is readily
accessible through the
“View” menu (or ALT + 3).




e Printacopy/3D view

Do 30 e bt tyw

BRQCEAR XN EENPF A et i @ lai® vmonin

Whoaaaaaaaa
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we Printacopy/3Dview

HOKERSPACE

L Y QICREAR XX 2E XD st d & e o

Left-click-and-drag to orbit
Scroll-wheel-click-and-drag to pan
Scroll-wheel-roll to zoom

How to add 3D models
of the battery and the
diode?

o




THE.

we Printacopy/3D view

HOKERSPACE

0

Openthe “3D
Models” tab.

From the layout view, open the
properties window of the footprintin
question (right-click, “Properties”).

Open and locate an acceptable .
file type (STEP or IGES, mostly) 4

Adjust the position as : - ks lick OK
necessary to sit flush on the < 4 3 \ N
board. :

.

A well-designed 3D CAD model should have the origin aligned properly such that one
or two rotations should have the part sitting flush, if that.




we Printacopy/3D view

BRQCEAR ¥*N E2ENF T ears e lai® wmonin

(I have noidea why the
battery holder is green,
| couldn’t deselect it.)
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Now that all the elements
of the board are on there,
we’ve confirmed the
footprints, and we’re good
with the physical
placements, we can run
the DRC.

Click thisicon or “Inspect”
> “Design Rule Checker”,
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to highlight the marker.

What happened?

Click on the violations

BOCRR AR RN
sBUSNaBLANASND
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Clicking an errorin the

| DRC window will center

and highlight the marker.




o N =N N . L] E
Other errors are
el — — marked with red

arrows.
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Right-clicking on the error
in the DRC window brings
up a context menu from
which you can either
ignore/exclude the issue, or
run the “clearance
resolution tool”.

| haven’t been able to use
that effectively, butit’s
there if you want it.
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NEEASPACE

What are the errors?

The first four are
“clearance violations”
with things on the
“Power” netclass, i.e. the
clearance minimum was
broken.

This means that
something on a net
within that netclass is
too close to something
notin that netclass.

Design Rules Oheoeey

[ Rutil Wl 2oves hefne perioemng DRG [ 1Tt 10t pasity Latmesn PCB and schwermas

] Report all emoes for sach track

Violatens (@3] Unconmected Itams @0 Schemanc Pary tnot nurd  Ignonea Teses (8)

v Error: O b Power’ 16.00 mily sctwal 11.81 mils)
P 1 N0 ALl of UY en FCu
B9d 2 [GNDf ot Ut on F Ly
Error: O Power 16,00 mils: acteaal 11.81 mis)
Error Q) darti Power ¢k 16.00 mils: actual 11.81 mils)
Error: O i Power’ ¢k 16.00 mils; actual 11.81 mis)

Warning: Footprint ‘MPD_BC2032-£2' does not match copy in lbirary ‘swiiched ED vO
Waming: Sikscreon clipped by solder mask

Waming: Sikscreen overlap

Warming: Sikscreen overlap

Srew: [Z1 Al Fimos @  FWwningn 4 = Becdanicrn Save

Dedere Marker Defete A1 Maikens Fun DRC Cose
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We see the issue by using
the measure tool
(CTRL+Shift+M, or the icon
at the bottom on the right).

;

—
Q@
<<
O
-

r—'—

Hold CTRLto ignore the grid.

The space between the pads

I “Net-(D1-A)” and “GND” is
Net ( about 12 mil (11.81) when the
rules we set previously in the
# Board Setup said a minimum

| of 16.
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Nothing — we can safely
ignore this error.

Why?

The clearance number we
set was arbitrary and above
i the minimum (8 mil), so I'm
not worried about this.

to gointo the footprint
editor and adjust the
spacings.

But not today, Satan.




Clicking through the four
errors shows us that they’re
all the same.

I’ just right-click them all
and exclude them.

I don’t want to ignore all
these errors or adjust their
severity because | might
miss something important
later.
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The first warning says that
the battery footprint
doesn’t match what’s in our
library.

Well, of course it doesn’t.
We edited it.

Excluded.

Design Rules Oreoeey

[ Retil W) 2o hefone perioemng DRG

] Report all emoes for sach track

Violateons (@3] Unconmected Itams @ Schemanc Pary tnot nurd  Ignonea Teses (8)

v

Warning: Footprint ‘MIPD_BC2032-£2° does not match copy In lthrary ‘switched ED vO
Waming: Sikscreon clipped by solder mask

Waming: Sikscreen overlap

Warming: Sikscreen overlap

L1 et 101 pasity Bataesn PO snd schwermas

S
Srew: (2 AN Fimos @ [FAWwninn 4  Escdivicors & Save
Dedete Marker Defete A1 Marken ﬁ\;:& Cose
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The second warning says
the silkscreen is clipped by
the mask.

Soldermask is removed
over pads (and sometimes
vias, if they’re not tented).

The silkscreen here is over
that openingin the
soldermask and would thus
partially be erased.

N
<T
]
i
(=]
o
]
4
L)
=

| don’t really care about this,
so excluded.
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Thelast warnings are
silkscreen overlap, which
looks like this.

If | was concerned about
this, the labels can be
manually moved (with “M”)
to a better place.

Asitis, | don’t care.
Excluded.
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And that resolves all-our
DRC issues!

Tadal!




The designis donel

Congratulations!

We have a fully designed
and checked board.

One final thing to do - plot the gerber files

26



! Gerbers

Gerber files are special text files that define the polygons on each
layer of your design.

You typically need to sent them to the fab house for fabrication.
Some take KiCAD projects or board files directly these days.
Read the fab house’s instructions for plotting these carefully!

It’s easy to do something wrong and get a bad board.

27



Gerbers

Open the gerber plotter
either with thisicon or from
“File” > “Plot”.

28
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Layout

Set an output directory
for where to save the
gerber files to.

Read through your fab
house’s instructions
carefully.

They will have details
of what needs to be
set in the middle.

‘ This is the plotting window. ‘

Hit “Plot” when

n O Dawre O

you’re ready.

Cewrew Dot
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Hopefully there
are no errors.

Click “Generate Drill
Files...” when it’s done

Dlastse aaerran vusrss (3t ranan:
v
Ast o= Cewrew vt v
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HOKERSPACE

Excellon is usually okay,
but again, read the fab
house instructions.

Layout

fab house.

The rest of this will also
be determined by your

The drill file will plot the
position and size of all
drill hits.

The drill file or files will
output to the same

.....

directory by default.

The map file is for

...| automated assembly. Only

make it if you need it.
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v Gerber Viewer

RASPACE

Tl 52t Ve ook Preresom el
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Schematic Edtor

FIR7 0 YRR JeTemins

Symbol Editor R
240 35al v rope | using the Gerber

Gerbers can be viewer

Viewer

PCH Editor

B W i FUS esge

Footgeint Edntor

T ploba! andior propet PLE faoipeay (Breem

Garber Viewsr
Ponvww (vt Sows

Image Converter

Convert bormzz ITOPW 13 CAMDELT YOt o AT Aotauen
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Gerbers can be And excellon
opened with this drills with this

icon

one.
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The files are
automatically
detected (usually)
and show up here.
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HIVE Gerber Viewer

Always a good idea to
check your gerbers
directly before sending

them for fab!!

Deselect gerbers
to make them
invisible ‘
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You made it!

Congratulations! You have a fully designed board that is ready to be sent for
fabrication!

At this point, you could stop the video, but the net few slides I'll provide you with
some additional rescourse and information for you to keep in your back pocket (or as
a bookmark, if people still use those).
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! Next steps

HOKERSPACE

* If you’re interested in actually making this PCB:
* You can fabricate the board here at The Hive yourself, or you can send
the gerber files off to have it done for you
« Email the Hive PCB group (hive-pcb@ece.gatech.edu) for the BOM,
and we’ll see if the Hive can purchase the components.

» Future revisions:

» Consider re-selecting some parts for SMD only design, and then redo
the layout using the backside for parts too.

* The LEDs could be on a separate board that plugs in for a more point-
and-shoot flashlight
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H Further Resources - KiCAD

HOKERSPACE

« KiCAD documentation (https://docs.kicad.org/)
+ Everything about KiCAD and more, including “Getting Started”

« KiCAD library conventions (https://kic.kicad.org/)

* The “Symbol” and “Footprint” subsections can help demystify the
naming standards

» KiCAD forums (https://forum.kicad.info/) and resources
« KiCAD DRC templates (unofficial - GitHub)

* Plugin and Content Manager
+ Some are made by fab houses for official integration
* Plenty of useful add-ons to the software
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https://docs.kicad.org/
https://klc.kicad.org/
https://forum.kicad.info/
https://www.kicad.org/help/learning-resources/
https://github.com/sethhillbrand/kicad_templates

THE.

! Further Resources - Design

HOKERSPACE

» Design guidelines by David L. Jones (PDF) <- The real OG.

« Via guidelines (Cadence) and trace width requirements
(Advanced Circuits)

* Phil’s Lab (YouTube)

* SnapMagic has a desktop app with KiCAD integration
* | justlearned about this, but might be useful?

* Random, but The Hive’s standard resistors are 7mm long

with a body diameter of 2.5mm and a 0.6mm diameterleads.

* Forwhen you use those and need to select one of the many
footprint options.
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https://www.scs.stanford.edu/~zyedidia/docs/pcb/pcb_tutorial.pdf
https://resources.pcb.cadence.com/blog/2021-the-best-pcb-via-size-guidelines-for-your-design
https://www.4pcb.com/trace-width-calculator.html
https://www.youtube.com/@PhilsLab
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! Further Resources - Fab

HOKERSPACE

» Part sourcing: Digikey, Mouser, Octopart, Sparkfun,
Adafruit, DFRobot, Amazon (YMMV), eBay (rare/hard to
find)

» Fabrication houses: PCBShopper (price comparison),
The Hive (local), OshPark (US, low cost), Advanced
Circuits (US, mid-range), Epec (US, very fancy),
Sunstone (US, mid-range), JLC PCB (CN), All PCB (CN)

* Many have EDA-specific instructions

The Hive doesn’t officially endorse any of these suppliers or fab houses; they all have

plusses and minuses.
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! Further Resources - Misc

HOKERSPACE

» Google.
 Seriously, thisis the thing you should get proficient with.

» Guides on design, KiCAD, and other EDA software are
available on YouTube, Adafruit, Sparkfun, and many
(many) more.

* Feel free to stop by The Hive to ask questions, as well.
We’re here to help with your design and fab!

41



End of Part 5C

And with that, we’re done with part 5C and with the design! Congratulations. A PDF
of this video is available as well, linked in the description and hosted on The Hive’s
Wiki.

The remaining four videos cover library management and model creation. It’s less
exciting, but if you’re thinking about doing more design, it’s really valuable to
understand how to keep your parts organized and ordered for later use and reuse.
Part 6, which is next will look at symbol libraries, with some duplicate material from
part 4. Part 7, which is split into three videos, will cover footprint libraries, and
custom footprint generation.

Hope to see you there!
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Part 6: Symbol Library

Ben Hurwitz, Spring 2024

Hi all, welcome to The Hive’s series on PCB Design with KiCAD. My name is Ben, and
in this series, we’ve been walking through the PCB design process using KiCAD as our
electronics design software.

The previous videos went through the design process all the way through, resulting in
a complete PCB ready for fabrication. One thing that | mentioned during that process,
and was featured in the original “EDA Design Flow” in part 2, was library
management, and the idea of using only project-scope libraries, but when we actually
did the design, | ignored this for simplicity and time-constraints.

In this video, | will walk you through library selection and generating a single project-
scoped symbol library to package with the rest of your project, and keep your work
insulated from external changes.

This material is of course not required for a functional design, but it is good design
practice, for KiCAD at least, to keep all your parts in a project-level library.

Because this is not related directly to the design flow of the previous videos, I'll make
no assumptions about the state of your system or knowledge. So | apologize if some



of this is repetition for some of you.

Let’s get started.



HI Creating the model libraries
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After creating the project, typically the first thing you’d want to do is create a single
library where all of your components will live. This will be a living library, as in,
components will be added to this library throughout the design iterations. Try not to
remove any components since you never know what you’ll need again. *




Symbol Library

RASPACE

This is the “Symbol
Editor” window.

If you’re familiar with this window, the next few slides will be a review.
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Symbol Library

Here are all the currently available libraries.

Library availability will be discussed a bit later.
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Symbol Library

MOk
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RASPACE

Let’s make a new symbollibrary.

=

“File” > “New Library”.

€

If you’ve already gone through the design process in the previous videos, don’t make
a new library, since we’ll just be using the flashlight circuit we developed there.




Symbol Library

RASPACE

Select “Project” for the scope here.

Again, we want to minimize useage of
globallibraries within our projects.
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Symbol Library

X
=]
=

B

I like to name the project-
specific libraries with the
same name as the project.




Symbol Library

RASPACE

Great! An empty new library.

Again, if you’ve previously made a library for the flashlight circuit developed in videos
1-5C, move forward here with that library.




Symbol Library

RASPACE

Next, we want to copy any
symbols that we’ll need that
are available from global
libraries into our new
project-specific library.

Which symbols do we need?
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ve The flashlight circuit

* LED driver IC AR G

« Battery + holder 3 D »

+ SPST-NO switch | —;‘ - your]

* Cin, Cout (caps) (2.2u/Tu) 4 51— ! ¢n Driver

« L (inductor) (22uH) il —{GND 8

- D(Schottky diode) | ,

 Rset (resistor) (30 Q)

* 4x LEDs il I

-
~
0
]
-
A
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Symbol Library

Always good practice to
start with the ones that have
standard symbols, i.e. not
generic boxes.

Many standard symbols can
be found in the “Device”
library.

Others, like switches, have
their own libraries.
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Symbol Library

_ | Locate the “Device” library first.

]

12



Symbol Library

RASPACE

Symbols in many libraries are
named relatively intuitively.

What do you think the symbol
for a capacitor might be called?
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HIVE Symbol Library

:::::::::

< | Do youseeit? |




Symbol Library

Double-click on
. |ittoopenthe
symbol.

Always good
practice to
double-check
that the symbol
is what you
expectitto be.

e = - P
3 O
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Symbol Library

(13

Looks good.

To copy the symbol,
right-click itin the
“Libraries” paneto
open the context
menu, and then
click copy.

Or just highlight it
and press CTRL+C.

n

et

T

Note: “Duplicate”
will make a copy in
the currently
selected library.
Since built-in
libraries are read-
only, this won’t
work for our
purpose right now.
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Symbol Library

n

Note that CTRL+V
doesn’t work to
paste symbols.

You have to right-
click on destination
library (in this case,

; i the one we just
8= created) and click
— “Paste Symbol”.

{

L=




Symbol Library

e
_F

Notice the asterisk (¥) next to the symboland
library? Those mean they aren’t saved. CTRL+S
to save. Save often!

—
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Symbol Library

Next, go back to
the “Device”
library and copy
the inductor
into your new
library.

What do you
think it’s called?

e =) P
L ofllo
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Next, the resistor.

= | If you scroll back
to the “Device”
library and locate
“R”, you’ll find it
looks like this.

Which might not
be what you
expected.

Fun fact:

There are two
standards for
electrical symbols, the
European IEC and the
American/US ANSI
(because of course).

This is the IEC symbol.

21



The ANSI
symbol (which
you may be
more familiar
with) is
actually named
“R_US”.

22



T

Either one is totally
okay and understood.

-« | Copy

whichever
one (or (Inthe US, the IEC
symbol is usually

R_US

forR.)

o
|
both!) you ad
preferinto used for an unknown
the new impedance, butit’s
e library. not wrong to use it
|
()
~—




Excellent.

Next, golookin
“Devices” for the
| diode.

Any idea what it
might be called?




Symbol Library

If you guessed “D”,
you’re partway
there!

“D”is just a regular
diode, but all diode-
type symbol names
start with “D” as
well.

Remember, we need
a Schottky diode.

N
T
K

\O

R —
[

=

= Passiv

.
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Symbol Library

RASPACE

" ' v

Cleverly, it’s called “D_Schottky”. There are multiple
varieties depending on pin count and if your diodeis |
special; ours is not. Copy it over.

f D

Passive: K --Passive b
D_Schottky_Filled

(I personally prefer the “filled” version because |
think it looks nicer, but they’re functionally identical.)




Symbol Library

Next, the battery.

Remember that the
= | battery holderis D
the actual part that

is attached to the ) i
PCB, but we want --Passive
to symbolize that

it’s a battery. ott k y F ' l l e d

(s Find the battery
symbolin “Device”.
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Symbol Library

m

Nope, not “Battery” -

"
a
E— that’s a multi-cell
= + battery symbol.
BT Functionally, it would
. s work, but it might give
W B al readers the wrong

impression.

We want
“Battery_Cell” fora
single-cell battery.

‘Ve _II--




HIvE Symbol Library

0
i 2 Q‘? That’s better.
E— _
. = ‘ Copy that into our
+ B T library.
BETTICEE === ==

i Isive &

=T Battery_Cell
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RASPACE

If you’re coming from
the design videos, you
might recall the pin
typeissue we had to
resolve.

It’s easy to resolve at
this point as well by
just editing the
project-scope library
version of the symbol
within this window.
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HIvE Symbol Library

0
T “ o Last one from
R P “Devices” - let’s
: . find the LED.
+

i Isive &

=T Battery_Cell
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HIVE Symbol Library

Again, | prefer the

“filled” option, but
D both work.

- 'assive —|<— Passiv

KD Filled
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Symbol Library

Great. You should

. | now have six (6) of D
the eight (8)
symbols we’ll
need for this
circuit.

v
The 7t will be the - l l d
switch. )_F I e




Symbol Library

Unlike the last

. | few, switches are D
not found in the
“Device” library,
' 1 but rather the
“Switch” library.

v
Which switch do x l l d
we need? )_F I e
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Symbol Library

X
=]
=

B

The SPST option. T

Add it to thelibrary.

3ssive —O/O— Passn

SW_SPST

If you don’t remember the terminology, SPST stands for single-pole, single-throw,

meaning it controls one circuit, or one pathway, with one output.
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HOKERSPACE

* The last component toadd isthe IC

* The IC is slightly different than the other components
we have put down, for two reasons:
1. The symbolis “unique”, or at least, a symbol with the same
pinout would be difficult to locate in the built-in libraries
2. The footprint may or may not be in the libraries (although it is
a standard package, so it likely is... but we’ll pretend.)

[With an empty slide] If you’ve already generated this symbol during the design
videos, congrats! Skip to basically the end of this video, where I'll show you how to
manage which libraries are available to the project. Sorry | can’t be more specific.

For the rest of you...* [and continue with slide]




Hl Symbol Library - Adding the IC

HOKERSPACE

* The first thing to check is whether it’s in one of the
built-in libraries.

* \We can use the filter to search for the RT4526.
* Nope.

» This is pretty normal for most ICs and non-standard parts
because, as | mentioned before, they’re pseudo-unique.

* The next optionis to see if someone else has already
done the work of generating a symbol and footprint
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RASPACE

S

Predust Alirtvates

Cut Tape 10T) & Do Pents

Sometimes, the supplier will
link to the models (i.e. the
symbol/footprints).

o

Tape & Aul (11

Sometimes, the suppliers will link to models.
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Sometimes not.
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Locating a model for the IC

« There are plenty of places online who can generate (or may
already have) these files.

* Thetwo | use are Ultralibrarian and SaapEBA SnapMagic.

* UL does not require an account to download models, but
does require one to request new models.

* SnapMagic SnrapEBA requires an account to download or
request, but you can also generate symbolsin-browser.

* Both accounts are free to open.

If the supplier doesn’t link, we can go look for them manually.

*The two places | have had good results with are Ultra Librarian and SnapMagic,
which used to be called SnapEDA.

*Both require free accounts to request new models, but Ultra Librarian allows you to
download pre-made ones without one.

*SnapMagic has a few additional tools that are available for registered accounts as
well, like in-browser symbol and footprint generation.

* ¥
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HOKERSPACE

@ . T—

UltraLibrarian’s homepage. |

BUILD BETTER PRODUCTS FASTER

Access FREE spmboks. foompriets, and 30 models hom the Wodd's Lasgest CAD Library

| Nl et e+ by

Featured Products From Our Partners

We'll start arbitrarily with Ultra Librarian. Search for the symbol you’d like a model for.
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<

Unfortunately, the partis

e & m
LAra
Lib¥anan ]

greyed out, so none of the
models exist.

Sometimes, they’ll have
just the symbol or
footprint, and that will
bein red over here.

Unfortunately, the part is grayed, so no models exist.

*Sometimes, the icons on the right will be filled in, indicating that they have a
footprint or a symbol, but not today.
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L, o] -

No 3D Model Available

Clicking on the part allows
us torequest the models.

Request either symbol or
asanea e | fOOtprintand get both.

=y P » = itra

Clicking the part gets us to the part page, where we can ask them to create a model
for us. Request either to get both.




IME Locating a model for the IC

Part Request

Afterloggingin, we can request the part.

Looks like this




IME Locating a model for the IC

Reguest Received

et i
o e e P FTR0M

48 hour standard (free) turnaround ::.. ke
time might be too long for you...

Standard turnaround guarantee is 48 hours, which may or may not be too long for
you.
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IME Locating a model for the IC

ISnapMagic

Let’s check SnapMagic next.

@9 o @

Let's make your d nasnap

InstaBuild is there symbol
and standard footprint
generator. The symbol
portionis only available for
certain footprints, but the
footprint generatoris
pretty nice.

Let’s check our other source, SnapMagic.

*SnapMagic’s in-browser model generator is linked on their homepage, but while
most standard IC footprints can be generated, the symbols are limited to select
footprints only.
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B

5 Seaphtagic =S - &

P Ao

asadl

RCEER —— But still nope - unfilled
icons mean the model
- isn’tavailable.
Careful! The first partisn’t
the right one. The filled icon here is for
the datasheet.

Searching for our part brings us to this page, *but be careful! Sometimes they
recommend a part at the top that isn’t right.

*Still, no models available — we can see this with the empty icons on the right.
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r— . -

Similar to UL, we can
request the part from the
’ part’s page.

Sometimes, they have a browser-
based symbol maker called

InstaBuild. The link would be here.

I R O

We can request the models from the parts page. *There would also be a link here if
the in-brower symbol generator was available for this part, but it’s not. Sad.




HOKERSPACE

No guarantee on

turnaround time,
however.

Unfortunately, SnapMagic doesn’t have a guarantee on turnaround time.
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Locating a model for the IC

5 SnapMagic
e
‘e

L

Requested!

-

But you get a cool ghost when you request the part.
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» Struck out thrice. What to do?

» Can keep searching (someone musthave made this
before, right?), but returns may be diminishing.

MOk

» Because KiCAD stores symbols and footprintsin
separate libraries, we’ll just go ahead and create our
own symbol directly in KiCAD.

* No need to create our own footprint (yet)

So three strikes. Are we out?

*We can keep searching randomly on the internet, but the returns will likely be
diminishing, and the quality might be degraded.

*Instead, we can just go ahead and make the symbol in KiCAD directly.
Symbols are relatively easy to make, and are less prone to errors than a custom

footprint, though they can be tedious with many pins, so it’s totally doable to make
them without waiting for Ultra Librarian or Snap Magic to be done.
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Aside: Importing a model

" . te

If you find the model online,
downloadit. Then, in the
Symbol Editor, right-click the
library and click “Import
Symbol”. Navigate to and
open the kicad_symfile.
Confirmthe pins, and then
save it. Super easy.

But since we haven’t found it,
back to makingit...




B

Creating a symbol for the IC

HOEERSPAD

" : P alw .

™~
To create a new symbol:

1. Select thelibrary tousein
— the “Libraries” pane, .

' d2. Click the “New symbol”icon [ 1
| ' BGq% Jlick the e Passiv
- a) Ortap “N”.
I— b) Or “File” > “New Symbol”

W0 TV E

Next, we can create a new symbol just hitting the “N” key, the icon in the upper-left,
or under the “File” menu.
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:::::::::

| Fill in the pop-up window here. |

== | ~
| 'ASSIVECEEE '—‘Passiv

= El_u_l“illEd

Let’s fill in the window here.
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Creating a symbol for the IC

Fill in the pop-up window here.

For ICs, | used the full part
number for the name.

™

]

| 'ASSIVEGEEE I—“Passiv

— Feo-rilled

Generally, good policy is to name the symbol with the part number, which in this case
would be RT4526. You can leave off the GJ6 in this case because, if you read the
datasheet, those are the only options for the final three digits.
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il Creating a symbol for the IC

HOKERSPACE

Fill in the pop-up window here.

* ForICs, | used the full part
number for the name. :
+ “Derive” if you’re just adjusting I
a known symbol.

'‘assive ¢ == I—“Passiv

= Eco-rilled

“Derive” refers to if you’re adjusting a known symbol, like creating a polarized
capacitor by copying the basic capacitor.
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HOKERSPACE

Fill in the pop-up window here.

* ForICs, | used the full part
number for the name.

+ “Derive” if you’re just adjusting I
a known symbol.

« Eachinstance of this symbolin '
a schematic will be identified )
by <Reference e P ass | V

Designator><Number>, e.9. R5

for the fifth resistor. “U” is /
typical for ICs, but you can e ST l e d
choose something else. - = v

The reference designator is the letter that KiCAD uses to identify all instances of this
symbol. Each instance will also get a number, so a resistor might be designated R5 for
the fifth resistor of the schematic. “U” is very common for ICs, though you could
choose something else if you'd like. It’s fine for multiple symbols to have the same
designator character, like U or R; it just means they’re of the same type, so to speak.
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HOKERSPACE

Fill in the pop-up window here.

* ForICs, | used the full part
number for the name.

+ “Derive” if you’re just adjusting I
a known symbol.

« Eachinstance of this symbolin e
a schematic will be identified ) , o 17
by <Reference ‘ P assiv

Designator><Number>, e.9. R5

for the fifth resistor. “U”is " o l l d

typical for ICs, but you can T —
choose something else. b L7 I

The rest is not relevant now. Click
OKto continue.

The rest doesn’t matter to us, so click “OK”.
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Creating a symbol for the IC

n . : AW . e

Uhhh.... Zoom out.
(Scroll wheel) o

Since there’s nothing on the editor now, it will zoom automatically in to the reference
designator.




Creating a symbol for the IC

B

HOEERSPAD

That’s better. :

o - |

(Apologies for

the stight The “U” here will be the reference

discontinuity

nere i made designator you defined previously. Un-

this bit of slides
prior to copying i1 i4H%e 3 3

D e oo numbered until it’s in a schematic.
symbols, so the
library in these
slides is empty.
Oops!)

Something like this is better. The “U” is currently placed at the anchor point, which is
the point at which the symbol will be attached to the mouse. We’ll move those both
later.
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HOEERSPAD

n L B

2 Grid spacing units are defined here.
_ Right-click on the canvas to see the grid
spacing itself - it mustbe 50 mil/1.27mm

. or else KiCAD will be sad later.
I usually select

“mil”, whichis
pretty common

in PCB designin 2
the US.
Note! “mil” I= “mm?. “mil”, or “thou”, are 0.001 inches.

“mm?” are the metric millimeter, 0.001 meters. 1 mil =
0.0254 mm (or 1 mm = 39.37 mil = 40 mil).

As usual, grid spacing and units are defined on the left. Check the grid by right-
clicking. It should read 50 mil or 1.27 mm, or else KiCAD will not be able to attach
wires to it and you’ll be sad later.

| usually select mils for my units because I’'m used to thinking of hole sizes and trace
widths in mils, and because I’'m used to imperial units. But you can readily use metric
units as well. KiCAD is based on metric values, after all.

Note that mils and millimeters are not the same. Mils, which are also known as
thous, are a thousandth of an inch, or 0.001 inches. Millimeters are, of course, a
thousandth of a meter. One millimeter is about forty mils.
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B

o - |

First thing | like to dois
make all my pins.

How many pins do we
o need, and what are they
called?

To the datasheet!



https://www.richtek.com/SaveDownload.aspx?specid=RT4526

THE.

HOKERSPACE

Datasheet, page 1.

We’re looking for
anything that ties the
pin numberto a
function. Usually it’s a
table.

So not here.

RICHTEK

iwe Creating asymbol forthelC

RT4526

Small Package, High Performance, Asynchronous Boost

LED Driver
General Dascription

Tive RTEEN 18 & Mgh heevercy. oo lvonos Boost
comerter. T e MOSEEY s seppot o b 10 whis
LR Dw o towcaigreng and DURT powe spplcatone, and
he intemial et ATChon Cey IR T Fous
cuttet The denct dparides wth WIHE fod swiciwy
Pageercy &z sdow el aeecrel coTponeh ad &
Wity ool ENI (rotheris For T prodesson. T
WAL perdon STV OWF 1 slow Fesporrvive el sl
g capactan Wit bwer volage ceirgs Tha LED
UM 8 Ry el W) I £a00Y Tl BT 0e ISP Ry
The HT250 & wedave £

b it #1a Rast wod #en

Features

« VIN Opasating Raage : 2.5V to 5.5

o bt Power NMOEFET Swich

« Wigie Rangs for MM Direreng (10002 52880 Me)
« Mrveeire the Ceswrnal Camponant Counms
o Wtnrnet SolStan

« Irterrad Cormpentaston

« UndarVoitage Protection

o Over Vakage Protection

« Over-Turrpatatere Protecton

« RoMS Cormpiiant and Malogen Free

Annlicationa
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HOKERSPACE

Conveniently, it’s right
at the top of page 2.

The physical location

isn’t relevant yet. We

only want the number
and name.

RT4526

Hive Creating asymbolforthelC

RICHTEK

Marking Information

WoOeh
U

Functional Pin Description

e Pt G
DAY Dite Cote

i N P Woeve | o Farmtsen

- = T Badzh Noce Cpencram ouges of fm stamd N-WOSFET. Comesc ths
48 1 Al OCRY B0 S0

3 GND Goane

5 ) St Vilage VoL Conrddl O sessioe 10 OND 00 s ouns Curvend

4 EN Erutie Contast yesd (ALl Mfo

3 VOuT Outas Vol (For ¥ 0oneet hewan)

" N 1‘5‘“‘1,!‘7-:'

_Function Block Diagram
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o - |

Back to KiCAD, add a
new pin (the icon on the
right, or hit “A”).

Bunch of optionsin
here.

Start with the name and
number.

What were those again?

Creating a symbol for the IC

Having two screens is
quite helpful at this
stage, or being a wizard
with Alt+Tab.
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HOKERSPACE

Start with pin 1.

By default, it’s set
as an “input”. But
isit?

Back to the pinout
tablel

e pare X
P rwuselor 1
fhecines fype 4 pie

Graght sty

X postion

siate
H Passive

¥ positon

Crientaton Free

¥ Unigeciing

i engtht “» Powe ingut
P Posver cutpet

Ng=e fext 522 * Open coliector

Number test sige | 4. Open emitter
# Liconnected

Altemnate pn detnitons

iwe Creating asymbol forthelC

] Commaon to 8l body gtytes (De Morgan)
i Ywbie

Frovew

A x

-

Functional Pin Descripti

PiaNo. | Pin N

1 X

GND

FB

)
4 EN
§ YouT

€ VIN
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If you’re not sure
what itis, you can
either setitto
“Bidirectional” or
“Unspecified” or
“Passive”.

The type won’t
cause the design
to fail, but it might
cause you
headaches later
with the ERC.

An Progeies

e sare LX
P ruste o 1
Eecines fype 4 mpue

Graght sty

X postion

1 positon | Passine

Crientaton free

¥ Unigeciing
“& Powey ingut
P Posver cutpet

i wngtn

Na™e et ve

Number test s

Allemate pn detnions

Creating a symbol for the IC

Functlo_nal Pin Dl_ncnntum

o Na P Name |

Pin Funssen

Ly T Pnty Dpaerdims Seyas of the rawvil NMOGEET Conrec the |
- .o kTl v v e
G0 vl
3 " ¥ aacteck Volage Inpel Correc 3 remmne 4o GND &0 st 10250t SrTend
. [ Erntn Comol gt | Action Mgt
VOUI | 0e ga (Far DA detmet Aassan |
o w lemkwet -
1 Technically, each pin
— | typeis “allowed”
connected to only a
subset of other pin-
types; otherwise, the ;
ERC will throw an error. |
ox A
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The rest of these
are graphical
choices, so we’ll
adjust them as
needed later.

Click OK.

An Properties
e pare X
P rwuselor 1

Lecines fype

Graght sty = Lise

X postion 0o mids
¥ positon 400 mels
COvientaton o Rught

I wngth 100 mh
Nometextsze | %) mely
Number teat 52 | %0 mels

Altemate pn detnions

iwe Creating asymbol forthelC

Functional Pin Description

s N Pin Name P Funssen

5 ™ Bk Pk Cpee-dins Seyad ol ihe rawtil NMDGET Conred ihe

o AS exdin vl FAAe ew) dute
) Ownavl

3 u ¥ aactecs Vokage Inpel CLYPec) & e 15 GAL) © s 184t SETRAL

. e Ernotn Conyol gt [ Action Mty

n vour Dxad Vakage (For TAP dwme Arssan|

L K Zaguty Teud

— LX

ax Cance
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B

- | A . i»
o Left-click to place this
: anywhere on the sheet.

We can (and will) move
itaround later.

U

Bidirectional L LX

The pin type is in blue there.
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L 3

i

Bidirectional =— X

| Now add the other five.

Functional Pin D

s N P Name i Funcsen
™ Bk Mods Dpeo-dams seyad of the ranvil NNOGERT Correc tha

Ao ek Tl F e nw) e

2 GHD | Oha 1

3 u ¥ aactec Vokage Inpel CLTrec 3 e i GAL B s (8456t SETRAL

. 1= Ernotny Conyol Fgut | Action Wity

B VOouT | Oexas vatags (Fer AP dwmes Aasaan]

) Vi B

-4 -
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Bidirectional LX

. Power inpu't-;-GND
FB

Input

EN )| Your’s hopefully look
something like this.

input:

Power output 2D VOUT

Power inpute—— V[N If you left the types
“Unspecified” or
“Bidirectional”, totally
okay.
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Creating a symbol for the IC

L X

= Power input -Z—-GND
FB
EN-U
Power output iVOUT

Power inpute—— V[N

Bidirectional

Input

inputs

Next, we’re
going to make a
box to identify
the symbol’s
outline.
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H Creating a symbol for the IC

L\ x
. Power inpu't-;-GND

Input

Bidirectional

FB Make it big enough that
all six pins can sit nicely
EN |jaroundit.

inputs

Use the “rectangle” tool.

Power output 2D VOUT

Power inpute—— V[N
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HOKERSPACE

Mine looks like this.

For height, | conceptually split
the pinsin half and make the box
tall enough for half the pins
spaced two grids apart plus two
grids above and below. In this
case, that’s 3 pins x 2 grids per
pin + 2 extra top grids + 2 extra
bottom grids =10 grids.

x

a2 18 72 M
o

G & W=

oo
==

[ Jon = [t oo ]

< <m
=

For width, | count the grides for Not always the best way!
the widest label, double it, and But it’s a good start.

add two. “VOUT” is the widest at
4 grids, so that’s 10 grids wide.

This is the algorithm by which | spec’d my box’s size, but | abandoned that size
basically in the next few slides, so you’re safe to ignore that.
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o - |

. -

If you don’tlike how
your’s looks, hit the “Esc”
key, and then click-and-
drag on the sides or
corners of the box to
adjust.

But seriously, aslong as
all the pins fit, it’ll be fine.

Creating a symbol for the IC
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Creating a symbol for the IC

o - | P A @

1 [
Bidi| One key fact here is that while the
Py 9raphics can be aligned to any
grid spacing you’d like (or no
grid), the pins MUST be on a 50
mil/0.127 mm grid or they will not

be able to connect to wires.
Powg
B If you make this mistake, you can
Ey always come back into the
Symbol Editor to fix it.
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Creating a symbol for the IC

LX
. Power input -A GND
1 FB

Bidirectional

Input

Next, we’re going to B
move all the pins around
the outline such that the
line touches the edge of
the box with the pin
name inside the box and
the little circle outside.

— |
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HOEERSPAD

B

o - |

A1y Like this.

Now move all the other pins
around the box.

VIR Another method to move
objects is just click and drag.

While selected, hit “R” to rotate.

This can all be adjusted later!

You might consider pausing the video here while you place your pins before seeing
what | did.
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Creating a symbol for the IC

[
. fal = LX EN -
. VINEE. ¢
u

Like so, perhaps.

Totally fine and
nothing wrong
with this.

79



HI Creating a symbol for the IC

HOKERSPACE

GND Or this.

LN[ d Also okay.
VIN

loe bl
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Totally changeditup there. |« »=

Looked at the circuit - T
drawing and visualized it [ c

better this way. KEY POINT:

Functionally identical to the
previous two, but perhaps
will look a bit cleaner later.

Whichever way you have it
is fine aslong as all six pins
are along the edges of the

This can all be adjusted ,‘?”ft“”?'.‘ - —
once the symbolin the =1 < ;
schematic as well by just o

going back into the Symbol
Editor window!

Additionally, when we learn about nets in the next video, you might understand why
it doesn’t matter how the symbol is laid out so much — pins can connect anywhere
without a direct line.
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o - |

Next, move the reference
designator (the “U”) to
somewhere that makes
sense and won’t be
obstructed.

Often, this is outside one of
the four corners of the box,
but it doesn’t have to be.

The reference number will
later appear to the right of
the “U”.

ol

il Creating a symbol for the IC
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Creating a symbol for the IC

Great.

Next, change the anchor

point.

This will be where the ‘ v vouT [ . <

symbolis “attached” to

your mouse pointer at. W

Usually the corner or the —
middle is a good choice.
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Creating a symbol for the IC

PECE

=

Lastly, double click in the
canvas (anywhere) or go to
“File” > “Symbol Properties”.
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MOk

These windows often have
alot more options than we
need right now, but they
do offer a lot of flexibility.

For now, just add the part
number (RT4526GJ6) to
the “Value” field’s value.

Adding a footprint here
can be doneif there’sa
single footprint for this
part. We don’t have a
footprint yet, so we won’t
add it, but later maybe.

ve CreatingasymbolforthelC
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Click OK once your done. EHET ®

........

iwe Creating asymbol forthelC

Bhow DowNars 1 Algn

a2t Smautem Nodw

VASse halc  Rod

o Lol
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o - |

Now move the part’s value
(the part number, in this case)
to somewhere else that it can
be read.

Typically this is the middie or
outside a corner again.

87



THE.

MOk

ve CreatingasymbolforthelC

Congrats! That’s the
completed symbol.

If it turns out not to fit or you
want to change it for
whatever reason later, just
come back to the “Symbol
Editor”, and edit away.

3

.

Don’t forget to save!

Then add the symbol
directly to the schematic
with thisicon.

(Or just close the window
to not do that.)
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RASPACE

Congrats! That’s the
completed symbol.

If it turns out not to fit or you
want to change it for
whatever reason later, just
come back to the “Symbol
Editor”, and edit away.

If the symbol is in a schematic,
open its properties within
that schematic and click
“Update Symbol” after
adjustments.

1 vouT =
i g > 13 3

Symbol Library - Creating Models

| Don’t forget tc; save! |

Now that all the
symbols have been
copied over, close this
window and head back
to the main project
window.

Now that all the symbols have been added to the library, we can close this window.

When adding symbols to your schematic, now just use the symbols in this library

inste

ad of in the built-in libraries.
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Symbol Library - Creating Models

_2: Schematic Editor

N Vw ramt o Seesd

? 3283 Orees pryRct 1o W [TeA (rvETe

B ece editee
Back at the project window,
under the “Prefences” menu at
the top, go to “Manage
Symbol Libraries™.

There is a very similar option
for managing footprint
libraries. The widows are
nearly identical.

Aropact CUuereic sa Dropnes faatac wernediill P swicredd i) yEocaa
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The window that opens is
where you can manage
which libraries are active
and visible.

I’m not sure if a library can
be deactivated but still
visible, but it can be active
and invisible.

At the top, the two tabslet
you switch between
library scopes. Let’s
switch to “Project
Specific Libraries”.

Symbol Library - Creating Models
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Conveniently, the library
we just made is
automatically added as
both active and visible.
Excellent - we can now
use the symbols from
within it.

Job well done.

Symbol Library - Creating Models

@ AEFTAEL ity

If you wanted to add
additionallibraries that
would just maintain the
“project”-level scope
only, click the “+” icon
here to find them.

92



THE.

SnapMagic’'s InstaBuild

HOKERSPACE

* I’m going to spend the last few minutes demonstrating
SnapMagic’s InstaBuild symbol-generator.

* This is a browser-based “computer-vision-based”
symbol generator.

* It’s only available for symbols that specifically offer it on
their parts page on the SnapMagic website.
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Ive Symbol Library - Creating Models

RASPACE

[ SnapMagic ron 1ONben wny verer 5 8

If the InstaBuild feature
is available, the link
from the part page will
lead you here.

iHInstaBuild It’s pretty easy to use, but
. I figure a walkthrough
isn’t a bad idea.
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Ive Symbol Library - Creating Models

RASPACE

“ISnapMagic

It will bring up the
datasheet on the left.
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iSnapMagic

Once you’ve highlighted,
the pin numbers and

! names, click the “Extract

| Pin Map From Table”

; button.

= - |

Ive Symbol Library - Creating Models

Locate the pin table in the
datasheet, and then left-
click-and-drag within the
datasheet to highlight it.

You want to highlight the
pin number and name.
You don’t need to
highlight the function or
the column headers (like |
did here, oops).

[ T
. -

tegeEy 2 iatE et 4

0.
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HseapMagic .-

The pin table will then be
generated on the right.

EreLe 31339 2a3 e ua part

Pie Mavies end Murmbers P Types
M Nae Al v

viC A
b | your Asow
i @ Ao v

ve Symbol Library - Creating Models

Notice that | highlighted
the column headers,
which then showed up in
the table. Just click the
“X”to remove them.
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Voila!

Now just click “Generate
Part” and the symbol will
be generated.

Don’t expect anything
fancy.
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RASPACE

SnapMagic

Now the symbolis ready to
download and importinto
KiCAD.

[ 4

]

Symbol Library - Creating Models

=3 9.8

(o]

As you can probably tell,
this is much more useful
for devices with many pins,
rather than just three.
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RASPACE

Symbol Library - Creating Models

You import the symbolin
the “Symbol Editor” by
right-clicking on the
library to importitinto (i.e.
your new custom project
library), and locating the
“kicad_sym? file.
Adjust/edit as needed.

| explained this process earlier, but to import a downloaded symbol, right-click the
library from within the Symbol Editor, and select “Import Symbol”. Then navigate to,
and open, the “kicad_sym” symbol model file you downloaded. Edit and adjust as

needed or wanted, and then save.
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End of Part 6

And that ends part 6 of this video series, in which we covered creating and filling our
own project-specific library. A PDF of this video is available as well, linked in the
description and hosted on The Hive’s Wiki.

In the next video in the series, part 7A, we’ll cover creating a footprint library and
populating it with globally-available models from KiCAD’s built-in libraries.

See you then!
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KiCAD

Part 7A: Footprint Library Creation

Ben Hurwitz, Spring 2024

Hi all, welcome to The Hive’s series on PCB Design with KiCAD. My name is Ben, and
in this series, we’ve been walking through the PCB design process using KiCAD as our
electronics design software.

The previous videos went through the design process all the way through, resulting in
a complete PCB ready for fabrication. One thing that | mentioned during that process,
and was featured in the original “EDA Design Flow” in part 2, was library
management, and the idea of using only project-scope libraries, but when we actually
did the design, | ignored this for simplicity and time-constraints.

The last video, part 6, went through a project-specific symbol library.
In this video, | will walk you through generating a single project-scoped footprint
library to package with the rest of your project, and keep your work insulated from

external changes, and then populating it with some of KiCAD’s built-in models.

This material is of course not required for a functional design, but it is good design
practice, for KiCAD at least, to keep all your parts in a project-level library.



Because this is not related directly to the design flow of the previous videos, I'll make
no assumptions about the state of your system or knowledge. So | apologize if some
of this is repetition for some of you.

Let’s get started.
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We’ll start from the project
window.
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Open the “Footprint Editor”.
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Footprint Library

This is the Footprint Editor.

Note: a lot of this will be
similar to the Symbol Editor.
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Footprint Library

ormEremmERw
0000500006060

Same as the Symbol Editor, the currently
available footprintlibraries are all on the left.

We’ll continue to but off the discussion about
library availability until later.




Let’s make a new footprint library. :
“File” > “New Library”.

We’ll be using the flashlight circuit that was developed in videos part 1-5 as our parts
list to add, so if you’ve already made a footprint library during those videos, don’t
bother to make another one.




Footprint Library

Select “Project” for the scope here.

Again, we want to minimize useage of
globallibraries within our projects.




Footprint Library

Similar to the symbol
library, save with the
project name.




Hive Footprint Library

:::::::

Great! An empty new library.
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Footprint Library

Similar to the Symbol Library,
we’ll be copying in the global
footprints that we need into our
new library for use with this
project.

We’re going to add the flashlight
circuit parts.

What were those again?




HIVE Parts List

HOKERSPACE

LED drive IC RT4526GJ6 TSOT-23-6 (= 3.1x 1.8 x 1 mm)
Battery holder BC2032-E2 TH Custom

Switch TS02-66-70-BK-160-LCR-D TH 4-TH 6mm x 6mm

Cin, 2.2uF C3216X5R1C225KT SMD 1206/3116 (3.1x 1.6 x 0.55 mm)
Cout, 1uF C3216X7R1C105KT SMD 1206/3116 (3.1x 1.6 x 0.55 mm)
L, 22uH LBR2518T220M (22uH) SMD 1008/2518 (2.5 x 1.8 x 1.8 mm)
D PMEG6030ELPX SMD SOD-128 (4 x 2.7 x 1.1 mm)
Rset, 30 Q Unknown (from kit) SMD 1206/3116 (3.1x 1.6 x 0.55 mitn}
LED C512A-WNN-CZ0B0151 TH 5mm diam, 0.6mm lead holes

Don’t worry, you don’t have to memorize this.

10


https://www.digikey.com/en/products/detail/richtek-usa-inc/RT4526GJ6/16376615
https://www.digikey.com/en/products/detail/mpd-memory-protection-devices/bc2032-e2/2077836
https://www.digikey.com/en/products/detail/cui-devices/TS02-66-70-BK-160-LCR-D/15634243
https://www.digikey.com/en/products/detail/tdk-corporation/C3216X5R1C225K-1-60/1965637?s=N4IgTCBcDaIMIGYwEYBsANArAJWXMYmA0gCogC6AvkA
https://www.digikey.com/en/products/detail/tdk-corporation/C3216X7R1C105K-1-30/513953
https://www.digikey.com/en/products/detail/taiyo-yuden/lbr2518t220m/1170881
https://www.digikey.com/en/products/detail/nexperia-usa-inc/PMEG6030ELPX/5436265
https://www.analogtechnologies.com/document/Resistor_Kits.pdf
https://www.digikey.com/en/products/detail/creeled-inc/C512A-WNN-CZ0B0151/2809629

T Note! Blindly using global footprints can
HWYE 1eave you exposed to potential issues if the

parts aren’t actually standard.

It’s up to you as the designer to confirm the
dimensions of your parts and footprints.

Failure to do so is at your own risk.

Assume, and make an ass out of you and me.

(I'Mleave that for an exercise for the reader.)

11
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Footprint Library

Okay, let’s start with the 1206
surface-mount devices (SMDs).
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Footprint Library

OEEASRAL

Filtering by 1206 will be
useful here.

Notice that there are
specific ones for Cand R
(the R cannot be seen here)

13



This is a standard size! Why
the different footprints
between C, R, L, etc?

The difference is only in the
labeling (pin numbers,
orientation identifiers, etc.)

14
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~ann

Footprint Library

You might also notice the
“HandSolder” version
below.

What’s up with that?

e © St

(Answer on next slides)

15



Footprint Library

Open the footprint and
highlight one of the pads.

16



At the bottom, the software
_| displays the size of the pad (or
whatever you selected.

The “Hand Solder” component
pads are slightly wider (i.e. X-dim),
1.325 mm to 1.15 mm.

_ Slightly easier to hand solder.
&Nl Siightly.
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Footprint Library

OEEASRAL

Similar to the symbols,
right-click on the footprint
name (either is fine) and
select “Copy Footprint”.

18



Footprint Library

Then right-click on the new
library (clear the filter box
to seeit!) and hit “Paste
Footprint”.
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Hive Footprint Library

:::::::::
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Footprint Library

- Now copy the 1206 R
e footpr

21



J
wh
1

“J Now the 1008-L footprint.
(Use the filter feature.) il

22
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OEEASRAL

nEme

gi

The LED can be filtered for, but
it doesn’t really help narrow

anything down because we
don’t know the naming
standards for TH footprints.

23
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OEEASRAL

nEme

Instead, we go straight to the
library itself.

There are two LED libraries, one M.

for SMD (LED_SMD) and one for
through-hole (LED_THT).

—

) Y | ) |

Open the through-hole one.

24
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Footprint Library

Still alot of options, but the
naming structure is easier to
decipher.

The “D” is for “diameter”.
The “W?” is.... What?

25



So no “W”, got it. P
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Footprint Library

% . Y TR ™A > hm
e need Smm diameter and |
a vertical orientation.
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Footprint Library

HOKERSPACE

Here we go.
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Footprint Library

Horizontal orlentatlon to
identify where space is
required on the PCB.

29



Copy your preferred
5mm LED (vertical)
footprintinto the

library.
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HIVvE What's left?

HOKERSPACE

LED drive IC RT4526GJ6 TSOT-23-6 (= 3.1x 1.8 x 1T mm)

Battery holder BC2032-E2 TH Custom

Switch TS02-66-70-BK-160-LCR-D TH 4-TH 6mm x 6mm

D PMEG6030ELPX SMD SOD-128 (4 x 2.7 x 1.1 mm)

Rset 309 YUnknrown-{fromkit) SMB 1206/316-(31x1-6-x0-55-mm)
v LED CE5R2A-WNN-CZ0BO151 TH Emm-ciam;-0-6mmleac-holes

31


https://www.digikey.com/en/products/detail/richtek-usa-inc/RT4526GJ6/16376615
https://www.digikey.com/en/products/detail/mpd-memory-protection-devices/bc2032-e2/2077836
https://www.digikey.com/en/products/detail/cui-devices/TS02-66-70-BK-160-LCR-D/15634243
https://www.digikey.com/en/products/detail/tdk-corporation/C3216X5R1C225K-1-60/1965637?s=N4IgTCBcDaIMIGYwEYBsANArAJWXMYmA0gCogC6AvkA
https://www.digikey.com/en/products/detail/tdk-corporation/C3216X7R1C105K-1-30/513953
https://www.digikey.com/en/products/detail/taiyo-yuden/lbr2518t220m/1170881
https://www.digikey.com/en/products/detail/nexperia-usa-inc/PMEG6030ELPX/5436265
https://www.analogtechnologies.com/document/Resistor_Kits.pdf
https://www.digikey.com/en/products/detail/creeled-inc/C512A-WNN-CZ0B0151/2809629

Footprint Library

k= Filtering for SOD128 (or SOD-128)
(== | | getsthe standard SOD-128 diode §

footprint automatically.

Add it to the new library.

32
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Filtering for “switch” gives us too
] many options again -
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Footprint Library

OEEASRAL

Instead, locate the
“Button_Switch_THT” library.

{ It has many different footprints for
switches of many types, not just
buttons.

34
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Footprint Library

But while this mightlook generally right, the
name doesn’t have the information I’'m
looking for, and | don’t want to measure it.

35
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HOEERSPAD

We can scroll through the library to
locate the 6mm options, or filter on
“emm” and locate thelibrary.

Silly that you can’t filter within a
single library alone.

36
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Footprint Library

OEEASRAL

Great.

Now just the battery and the IC.

We’'ll tackle thse in the next two
videos.

JI1 b
V2

38



End of Part 7A

And that ends part 7A, in which we covered creating a new footprint library and
copying in global components. A PDF of this video is available as well, linked in the
description and hosted on The Hive’s Wiki.

In the next video, I'll walk through the process of creating non-standard footprints,
like the battery holder, from scratch in KiCAD, and then importing the footprint from

the internet instead.

See you then!

39



PCB
"““HIVE Design
h

MAKERSPACE  \p\/ -I

KiCAD

Part 7B: New Footprint From Scratch

Ben Hurwitz, Spring 2024

Hi all, welcome to The Hive’s series on PCB Design with KiCAD. My name is Ben, and
in this series, we’ve been walking through the PCB design process using KiCAD as our
electronics design software.

The previous videos went through the design process all the way through, resulting in
a complete PCB ready for fabrication. One thing that | mentioned during that process,
and was featured in the original “EDA Design Flow” in part 2, was library
management, and the idea of using only project-scope libraries, but when we actually
did the design, | ignored this for simplicity and time-constraints.

The last video, part 7A, we made a new project-specific footprint library, and
populated it with a bunch of globally-available footprints that we needed.

In this video, we'll look at generating a custom footprint from scratch, why you should
never do it again, and then how to import an online model.

This material is of course not required for a functional design, but it is good design
practice, for KiCAD at least, to keep all your parts in a project-level library.



Because this is not related directly to the design flow of the previous videos, I'll make
no assumptions about the state of your system or knowledge other than that you
watched part 7A. So | apologize if some of this is repetition for some of you.

Let’s get started.
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Footprint Library

So we ended the last video with 6
of the 8 footprints in our new
library, and only the battery holder

and the IC left.
DINCIrCIXKCINALLC I} :
You should first try filtering for the
part, like we did with all the other
footprints. You never know!

Alas, no. Guess we’re making it.
Let’s find the datasheet!
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Footprint Library

| had to hunt down the technical drawing for
the battery holder on the manufacturer’s
website because the datasheet link on Digikey
gave me their catalogue.

Not helpful.
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Footprint Library

| Here’s the technical drawing (the top half, at least). |

HOKERSPACE
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| And here’s the suggested footprint (“PCB Layout”). |
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Let’s go draw this!




Completely from
scratch, a blank sheet
of paper.

Good for distinctly
non-standard parts.
Like this battery holder.

Muuuuuch better, § - -

assuming your
footprintis standard
(or near-standard).

SDW__I |

Create a new, empty
footprint (the left icon)

W 1}




THE.

MOk

ve Footprint Library

Give your footprint a name (l used . : .
the standard <MFG>_<part ey

number> for MPD_BC2032-42) and 1
set it to a through-hole component
(rather than SMD).
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Footprint Library

OEEASRAL

Always make sure to set your units
first! The units should match the

datasheet or drawing.
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Footprint Library

HOKERSPACE

Thereis no set order to do this, but
I like placing all my pads first.

Click the “Add a pad”icon here (or
under the “Place” menu).

We'll only place
oneto start, then
set its properties

Left click to drop the first pad

wherever, and then drop the

second pad wherever as well. Hit
“ESC” to exit.

and copy it.
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Footprint Library

OEEASRAL

Select the pad and hit “E” (or right-
click and “Properties”) to open the
“Pad Properties” window.




Footprint Libra

Thetaaps Aok

w1

ry

There are five options for “type”,
but ours is a through-hole.

Leave the pad numberas.

As we saw during the design, you
want to match the pad numbers
and the symbol’s pin numbers. And
the battery symbol uses 1for the
positive terminal and 2 for
negative.

Pad generation
is very flexible.

10



)

B

k|

Let’slook back at the drawing

andlook at the holes.

POSITWE CONTACT
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Footprint Library

These are slots, so not circular.

And they’re not the same!

The left one (the positive
terminal) is 0.80 mm in X and
410 mmin.

The right one (the negative
terminal) is 0.08 x 2.30 mm.

-l e 000 [0.23)
! 0.80 [0.05)wiie

410 [0.18] - —3 258 't‘unl

- 2720 [1.07]—=t
(+) (=

POE LAYOUT
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Footprint Library

AF COXLCr lope

Adjust fhe “hole shape” to “oval”
and set the Xand Y sizes to 0.08
mm and 4.10 mm respectively.
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How big should the pad be?

J

Let’s adjust the pad shape and size ”
now. Set the shape to “Rectangular?. ..

Footprint Library

Huh, the
preview looks a
bit funny now.

Pad #1 should always get some sort
of marker. For ICs, that’s often a
+ silkscreen dot or other indicator. For
through-holes, that’s usually'3a
different-shaped pad, and often
rectangular.
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OEEASRAL
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e Sadly, the drawing doesn’t seem to be useful here.
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Footprint Library

Let’s set that here.

Remembering that the pad
diameter for a circular pad is
twice the hole, we will make the X
diameterof the pad twice the
width of the hole, and the use the
same thicknessto addtothe Y
dimension.

The angle rotates the pad
and hole. We'll leave it at O.

Sosince the holeis 0.8 x 4.1 mm,
the pad’s X dimension will be 1.6
mm, which meansthe Y
dimension will be 0.8 mm larger

than the hole, or 4.9 mr,
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Footprint Library

RASPACE

The “copper layers” box says
which copper layers the pad will

A model of the hole
connections is here.

interact with. You can set this to:
« All copperlayers

* Top, bottom, and only the
internal layers that are
connected to the same net as
the hole

* Only connected layers (i.e.
either the top or bottom, plus
any connected internal layers)

* Noneg, if it’s non-electrical.

We'll leave it as “all copper layers”.

-~
7

Much
better.
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Footprint Library

The “Technical layers”
options determine if the
hole will interact with
these other layers.

Usually just the mask
layers are good.

17
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Footprint Library

Lastly, we need to set the position.

We could do this by setting the grid
and moving manually, but usually
the pads are particularly place so

giving it an exact position is better.

To the drawing!
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HOKERSPACE

| It’s always a good idea to center the part at the origin.

Seie | ¥W | WEVDOSN MRTURD | AUTH (M0

i Y| == Because the pads are along they =0, and are
“&1/) i spaced 27.20 mm apart, we know that the left pad
2134 0.84) t = 1| will be placed at 27.2/2 =13.6 mm. But since it’s to
‘ ™ 7 the left of the origin, it will be -13.6mm.
I
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Footprint Library

Great!

With everything set, we can just |
click “OK” now.
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OEEASRAL

Duplicate (or copy/paste) the pad,
and then open the new pad’s
properties window again.

21
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Set the pad
number to 2.

If"},, — ]t

Because thisis a copy, the pad type,
hole shape and size, and the structure
on the right will be correct. But some

things need to change.

Footprint Library

Set the X position
t013.6 mm.

o

—— -1 %

The pad shape needs to change
too, since thisisn’t pad 1. Set it
to “Oval”. The size will transfer.

You could also use a “Rounded
.| rectangle”, but no need for fancy
here.

22
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OEEASRAL

Note! | actually botched
this - the negative
terminal slot should
actually be 2.3mminY, not
41mm! Don’t be me, go

I ¢ I change it here.

Click OK when you’re done.
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Footprint Library

24
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Next step is to draw the part outline.

KiCAD recommends three slightly-
v | Offset outlines: one on the fab layer for
BT

the fab house, one on the silkscreen
layer for the assembler, and one on the
courtyard layer to prevent part overlap.

Okay, let’s take alook
at the part outline.
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Footprint Library

How accurately you draw the outline is sortof up to you.
Do you need to get an exact rendering, or is a box okay?

OEEASRAL

- My - t
POGITIE CONTACT Rt [ | ==

i Ay !

-f e 000 [0.03)
R1284 (ROA0) ! 0.80 [0.05)ite ]
410 [0.18] + 44258 'an:

This footprint outline is going to be obnoxious to draw in
KiCAD due to the non-primitive shape. We can draw arcs, but
you’d basically specifying start and end coordinates and a
radius. And there’s not a wealth of info here.

EIGS
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| did not spend time on the outline,
opting instead for circles. —

That would’ve been quite the pain with
the real outline.

| didn’t bother with the exactly outline because, frankly, that
would’ve been a pain and | don’t care that much. So | made three
circles.

The fab-layer circle approximates the part outline with a circle of
diameter equal to the maximum X-dimension of 28.96 mm.

You don’t want to overlap graphics because it’s really hard to see
them, so KiCAD recommends placing the silkscreen outline, which
will be printed, immediately outside the fab outline. The circle is
sized to be larger than the fab circle by half the linewidth of the fab
layer plus half the linewidth of the silkscreen layer because the sizing
is measured from the middle of aline. The linewidth can be found by
looking at the properties of the circles drawn on those layers.

Lastly, the courtyard outline should be sized to have a 0.25mm

clearance around the silkscreen outline, which is added to the radius.

These sizes are written in the image in purple on the User.Comments

27



layer, so they won’t show up anywhere that actually gets made.
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We want to also move [
the reference
designator, REF**,
outside the outline so
that the assembler can
see it after the partis
populated.

My grid was a bit too
large, so while moving
the REF** text, | right-
clicked to open the
context menu and
adjust the grid through
the Grid submenu.
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| also added a “+” and “-” symbol on the

indicate polarity of the part since a
circle doesn’t have orientation.

| didn’t talk about it, but if you wanted to
add filled zones (polygons) for some
reason, you can do that for footprints too.
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Footprint Library

Tadal!

Don’t forget to double
check with the
measure tool, and then
save your work!

The measure toolicon is highlighted by the arrow.
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Holy moly.

So that wasn’t so bad, but mostly because |
opted to draw circles for the outline.

That won’t always be possible, nor will
datasheets always be any good, potentially
making custom footprint generation
nightmarish.

Thankfully, most of the time we don’t have to
do this because we can either locate or request
the models from UltraLibrarian or SnapMagic.
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:::::::::

| erl | e D

Or from your subbliér!-
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$SI0902 Foampvon nd bnseh Clicking thatlink brings us to the
s “Footprints and Models” page.

i Manufacturer models are first.
Narafacterw [OA s3d CAD Modeis

e Q| oD STEP file at the top for

this one.

Scrolling down.... |

Syrrbad Fortored 30 Neodel
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... There’s a set of models from Ultralibrarian...
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| ...and then some from SnapMagic.

Srapdage:

fevos Tarrer 1D Mode

Which to use?
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There is no right or wrong answer here
generally. Both models are extremely likely to
be sufficient.

It’s on you to confirm that though!

I’m going to use SnapMagic here because | like
the footprint better (and there’s a 3D model).
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Ive Footprint Library

Click “Select Download Format”
and select “KiCAD (V6 or later)”.

(Obviously select a different format

if you’re using different software.)

| also selected the 3D CAD model
because a 3D view of the desiq@d

PCB is useful.
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Unzip the download somewhere accessible.

There will be five five files:

* a.kicad_symsymbollibrary

* a.kicad_modfootprint model library

* a.step 3D model

* a.htmlinkto a “How to import” webpage
+ alicense textfile
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Footprint Library

= Back in the Footprint Editor,
) right-click the library and
N select “Import Footprint...”.

Navigate to the unzipped ;
.kicad_modfile and openit. !
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See how much nicer their looks? And notice the three outlines. Nice. They also
intelligently put the positive indicator outside the part outline, meaning the user can
see it after assembly.
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Footprint Library

Re-name it if you’d like (the
default <MFG>_<PartNo>is
pretty effective, though).
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End of Part 7B

And that ends part 7B and our discussion of making footprints from scratch. As you’ve
seen, that’s not the best process, and it’s really (really) error-prone if you’re not super
(super) careful, so it’s highly advised to find the model online, or request it to be
made by UltraLibrarian or SnapMagic. A PDF of this video is available as well, linked in
the description and hosted on The Hive’s Wiki.

In the next video, we’ll cover using the footprint wizard, which can make generating
standard or pseudo-standard footprints easier. Or more difficult. Guess we’ll find out!

See you there!
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KiCAD

Part 7C: Footprints with The Wizard

Ben Hurwitz, Spring 2024

Hi all, welcome to The Hive’s series on PCB Design with KiCAD. My name is Ben, and
in this series, we’ve been walking through the PCB design process using KiCAD as our
electronics design software.

The previous videos went through the design process all the way through, resulting in
a complete PCB ready for fabrication. One thing that | mentioned during that process,
and was featured in the original “EDA Design Flow” in part 2, was library
management, and the idea of using only project-scope libraries, but when we actually
did the design, | ignored this for simplicity and time-constraints.

Part 6 went through a project-specific symbol library.

In parts 7A and B, we’ve made a custom library and a custom footprint using the
“blank slate” method.

In this video, we'll use the wizard to make a footprint for our IC, then decide never to
repeat that if possible.

This material is of course not required for a functional design, but it is good design



practice, for KiCAD at least, to keep all your parts in a project-level library.
Because this is not related directly to the design flow of the previous videos, I'll make
no assumptions about the state of your system or knowledge. So | apologize if some

of this is repetition for some of you.

Let’s get started.
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As a review, this is where we left the last video, with seven of the required eight
footprints in our project-specific library. Obviously, this battery holder was
downloaded, not made by me, so if you saved your personal copy rather than the
downloaded one, first, kudos to you, but second, it’ll obviously look different unless
you spent your precious time making this, in which case, your employer will not be
happy. But | digress.




Footprint Library

Finally, onto the IC.

ICs are usually either a standard package with a known
footprint, or based off a standard package, but always
confirm the supplier-provided package with the
datasheet!

KiCAD has alarge selection of standard footprints that
*should* work. So the first place to check for the
footprintisin KiCAD itself with the filter box in the
Footprint Editor. Filter for the part number and the
package name.




If you filtered for the TSOT-23-6,
o congratulations! You found the part.

‘ - 4 ] _| Butthat would

You could copy this into your library sort of defeat

and be done, after confirming the the purpose of
sizes and spacings, of course. this video.
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If we didn’t find the correctpackage, we would next
search online, either from your supplier, the
manufacture, Ultra Librarian, or SnapMagic. Then it could
be imported like we demonstrated with the battery
holder.

If not, we can request it and wait.

The last recourse is to make it, as we saw with the battery
holder.

But because this is a tutorial about KiCAD, we’ll do that.




Completely from
scratch, a blank sheet | «
of paper. .

Using the wizard.

Muuuuuch better,
assuming your
footprintis standard
(or near-standard).

Since our ICis
theoretically a

standard, open the

wizard.

Good for distinctly
non-standard parts.
Like this battery holder.
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‘Select the footprint that’s the |
closest to what you need. i

The ICisa TSOT-23-6, the six-pin variant
of the TSOT-23 package, which is the
thinvariant of an SOT-23 package.
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Ybu might scroll and realize, “Hey,
Ben, there’s no one for SOT!”

And P’ll say, “Well, there certainly isn’t

one that’s called “SOT”.”

e — l And you’ll look at me funny.

And Il tell you that SOT is a subset of SO-class packages (“small outline”),
which are defined by a rectangular body and legs.

And you’ll stilllook at me funny.

| So 'l tell you to just select the SOIC generator, number 11.

Because SOIC stands for “Small Outline Integrated Circuit” and is the overarching
family that includes SOT package types, among others.
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Aside: Package nomenclature

IC Package - Surface Mount Types

- Package nomenclature is the = s
worst, and it’s something you’ll P ’, .
get familiar with as you design * ’
boards. oost o
» There are so many standards, and .
the variation between some are M’ "(
so tiny. It can be really painful. M .

* The datasheet’s mechanical (@ rrnme

drawings are the one and only ?
truth for package sizes. " .D 5

e Use caution!

This is a very (very) small subset of package families.
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We need a bunch
of parameters
here to generate
our footprint.
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| Datasheet, p14 | i

rRan .‘. [ u

| L Notice the
3 physical
T, similarities?
e U — T I T This tells us we’re
= T 2 17 probably using
| 1 the right wizard.
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| Datasheet, p14 |

(ROLD, =7 - s | Now we can fill out
our parameters. |-

‘... I = = e Again, super useful [
[es T T " to have a second
P monitor here.
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So what the heck are all those parameters, anyway?

THE.
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A - Package height

Al - Seating plane height
B - Body width

b - Leg/pin width

C - Package width

D - Package length

e - Leg/pin pitch

H - Leg/pin thickness

L - Leg/pinlength

.

D
ron o
- C
| O H

P

) H

<

fo— 0 ]

b

Not all datasheets

b <
.. will following this
: A} m naming schema!
1 , ;‘: Al <
) ¢
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A few of thes requested
“"EI parameters are readily available -
ERSRACE pad count (6), row count (2), pad
pitch (e), and pad width (b).

MOk

| But there are a few tricky bits.

"Dﬁ;J‘ [-f?f
i s o =

O Fouipeint Wiza 50IC]

w o BB CRa®|l

Parameiers

Should we be using min, max, or

something else?

‘ Dimensions In Mallmetors Dimansions in Inchos

What should the pad length be, S Min W | M e
given that there’s so much n 8700 1.000 o028 0m8
Va r.iabi'lity here’p Al 0000 0 00 0oco 004

— . n 130 1803 00sa oo

pad width [ mm +

b 030 058 LI M om?

pad length 22 i = T T

1w sDaury s| Where is “row spacing” measured from? Em BT S

« QRS 1041 [INIAN) o0

M 0080 0254 003 0.0%0

The part needs to fit in the
worst case scenario!

the legs themselves?

How much bigger should the pads be than

14



| Pad Length
EASAACE ——p

Row Spacing

A

(Pad center-to-center)

P Min Body Width (B) \ -

(Larger than minimum pad edge-to-edge)

JE— Min pad edge-to-edge

Max pad edge-to-edge

Max Package Lenagth (D)

< >
<

(Should be smaller than the max pad edge-lo-edge)

This is a mockup of what the footprint parameters are. The row-spacing is measured
center-to-center, but the pad interior edge-to-edge is smaller than the minimum body

width, and the maximum package length is shorter than the pad exterior edge-to-
edge.

Still doesn’t answer the key question of what the pad length should be.

15



mmie o SOme datasheets are better about giving useful
dimensions, or even better, a recommended footprint
(like the battery holder did).

» Standard packages that are notin KiCAD still have a
standard footprint that you can search for and use.

» Otherwise, you’ll have to make your best judgement.

* You might be getting a sense for why companies
should do this for you.

» Given all this, we’re not actually going to make this
part. It’s not worth our time.

16
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I’ll just end the wizard
portion by pointing out

The “Body” tab has a few
additional settings that
are useful visually.

Do not forget to use the “Measure” tool
(CTRL+Shift+M) to confirm the sizes and
spacings after sending it back to the Editor!

This icon will send your
completed footprint to
the Footprint Editor for

two things.

saving.

17
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SnapMagic Footprint Generator

» Okay, so now we know multiple methods to make a
footprint:
« Make it (from scratch or through wizard)
« Request/locate it (Ultra Librarian, SnapMagic, manufacture, or
supplier) and import it
* Use the built-in version, if available
* The last method I’'ll show you as an option is the
SnapMagic InstaBuild footprint generator

18



ESnapMagie oot 1 @9 W

From the SnapMagic  REEIEEEIEEEEEEEES
homepage, thereis an =
InstaBuild drop down.

Select whichever family
you’re used.

We'll use the SOP
calculator because Hi, bharwitz

SOIC fixes pin pitch at ¥ = E l
1.27 mm. .
- s = ‘l

e W * o o

19



THE.

HOKERSPACE

“SnapMagic

ln::.\w h‘f?’-"ﬁ.‘j -

The datasheet paneisa
nice touch.

Each of these
calculators is very
similar, at least
conceptually, to the
KiCAD wizards.

SnapMagic Footprint Generator

=3 ©9 .0

Sy

G

20
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Here, I’'ve uploaded a datasheet
and gone to the drawing page.

RT4526 RICHTEK

Cuttne Divansion

SOP Factprint Bulder

SnapMagic Footprint Generator

@9 .|

I’'ve filled out a
few values here
too. The pin
pitchis the
average from the
drawing. The
footprint name
is auto-
generated. The
“min pad to pad”
is pre-set.

o

21
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RT4526 RICHTEK

Outinn Devwnsion

HI SnapMagic Footprint

S

Q- =

Generator

Be careful though -the
letter identifiers may
not match by default!

Scrolling
down, thereis
a complete
table to fill out
directly from
the drawing,
reducing the
amount of
guessing and
math you have
to do.

This adds alot
more flexibility
overithe
KiCAD wizards.
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SnapMagic Footprint Generator

The “Generate
footprint” button
appears once you’ve
successfully filled out
the table.

Do this to the best of

your ability. e B




IME SnapMagic Footprint Generator

SiSnapMagic | " = ~ @9 o @
m Footpr int Buikder
Download away! NSO
It will warn you that they r t B M-
haven’t gotten a change S s IS

to verify it yet. = l .

I’m not clear on whether
this footprint goes on

their queue to be i
verified, though. O
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SnapMagic Footprint Generator

| And this is what it looks like |

The pink is the mask layer, which is used for defining when soldermask openings are
on the board. The other parts have those polygons too, but they’re just the same size
as the copper pad, which takes visual priority.

25



Model Width Pad Width Int. Gap Pad-Col Height
SnapMagic | 3.71 1.42 0.87 2.519
KiCAD 3.6 1.325 0.95 2.5

Here’s a comparison between some dimensions between the SnapMagic model, on
top, and the KiCAD model, on the bottom. It’s close, but they’re not not quite the

same. Will one not work? We’d have to put them on a board and print a 1-to-1 copy
of the board to find out. But the differences are small, so hopefully.

Either way, this is a great example of how error-prone and variable the footprint
generation process can be! Especially given the variation between datasheets. It’s

critical to confirm your parts fit before sending your designs off for fab.
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End of Part 7C

And with that, we conclude part 7C, and, as of spring 2024, the end of the PCB Design
with KiCAD tutorial series.

If you have further design questions and you’re on the Georgia Tech campus, feel free
to stop by The Hive during open hours, normally during the semester from 11-6.
There is usually a Pl, MPI, or staff member available to help you, even if they don’t
know KiCAD. Design questions transcend software choices.

If you’re not on campus, the internet is your friend here. For KICAD-specific
guestions, there are probably hundred of tutorials on KiCAD, especially the basics
we’ve covered in this series, the forums are quite active, and the documentation is
pretty good (though not complete). For design-specific questions, well, you'll
probably be doing a lot of trial and error. Make some small boards to demo the
concepts you’re working on, read a lot, and decide how much error is tolerable to
your system.

Design is a never-ending topic, and there is always more to learn.

Thanks for watching, and good luck!
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